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Introduction

License Agreement
HIGHWAY SAFETY SOFTWARE™ (HSS™)

HSS2024™ END USER LICENSE AGREEMENT
Copyright © 2023 University of Florida. All rights reserved.

This is an agreement between you and the University of Florida Board of Trustees for the benefit of the McTrans
Center.

BY USING THE SOFTWARE PROGRAMS WITHIN THE ELECTRONIC TRANSMITTED PACKAGE OR DIRECT
DOWNLOAD (“SOFTWARE”), YOU AGREE TO BE BOUND BY THE TERMS OF THIS LICENSE AGREEMENT.
DO NOT USE THE SOFTWARE WITHOUT FIRST READING AND UNDERSTANDING THE TERMS OF THIS
LICENSE AGREEMENT.

If you do not agree with the terms of this license, discontinue use, delete, and/or return the unused Software
immediately to the distributor from which it was obtained.

1. LICENSE: In consideration of the required license fee, the University of Florida McTrans Center (hereinafter
called “McTrans”) hereby grants you (hereinafter called “End User”) a nonexclusive license to use the enclosed
HIGHWAY SAFETY SOFTWARE (HSS2024) (hereinafter called “Software”) as described in the applicable portion
of section 3 for a period in which the End User pays the subscription fee established by McTrans.

2. OWNERSHIP: This license is not a sale of the Software; it is a license to use the Software under the terms of
this License Agreement.

3. USE: The Software is licensed to End Users for a particular use, depending on the particular license that is
designated on order and described in this Section.

a. Single Office License. The End User may use the Software on any number of computers within the End User’s
immediate office, defined as a single organizational unit with a unique function, comprising one or more contiguous
rooms in a single location. All persons using the Software are also End Users. End Users may also use the Software
on portable computers, such as laptops, while on official travel and on home computers, AS LONG AS ALL SUCH
USE IS ON BEHALF OF THE OFFICE FOR WHICH THIS SOFTWARE LICENSE WAS PURCHASED. This
Software License does not authorize the use of the Software at any offices related to that single organizational unit
but not located at the same geographic location, even if the Software is stored on a portable computer. If you have
any questions as to the validity of your End User License, contact McTrans. The End User may use the Software
directly on the computer that has been installed. The end User may not use the Software remotely via any
technology, such as a remote desktop (see section 4). The End User should consult with section 13 of this EULA
on other restrictions for the Software's use.

b. Academic License. The End User may use the Software only within a laboratory within the End User’s immediate
school, which is defined as a single school unit having a unique function, comprising one or more contiguous rooms
in a single location, up to the permitted (purchased) number of copies, provided the use is supervised in a classroom
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setting for teaching or research purposes, and appropriate protection is in place against students copying the
Software and taking it out of the lab. The responsibility for ensuring this protection of the Software rests with the
End User. Multiple laboratories require multiple licenses. The Software may not be installed or used on any
computer outside of the licensed laboratory under the Academic License, including (but not limited to) any office,
home, networked, or portable computer. If you have any questions as to the type or validity of your End User
License, contact McTrans. The End User may use the Software directly on the computer that has been installed.
The End User may not use the Software remotely via any technology, such as a remote desktop (see also section
4). The End User should consult with section 13 of this EULA on other restrictions for the Software's use.

c. Single Computer License. The End User may use the Software on a single computer, a desktop, a PC, or a
portable laptop. All persons using the Software are also End Users. The End User may use the Software anywhere,
such as a business office, home office, travel, etc. The End User should consult with section 13 of this EULA on
other restrictions for the Software's use. End User is only allowed to use the Software directly on the computer that
has been installed. End User may not use the Software remotely via any technology (see also Section 4), such as
remote desktop.

WARNING! If this license is a Single Office or Single Computer License for use in traffic and transportation
applications, the Software may not be used for classroom or workshop instruction without the express, written
consent of McTrans. (Contact McTrans for an Academic License.) If this license is an Academic License for use in
training or educational applications, the Software may not be used for traffic and transportation applications or other
similar purposes without the express, written consent of McTrans. (Contact McTrans for an Applications License.)

4. VIRTUALIZATION AND REMOTE ACCESS: The End User may not use this Software in a virtualized
environment. All installations under any available license types discussed in section 3 should be performed on a
physical computer such as a desktop, PC, or laptop. The End User may use the Software directly on the computer
that has been installed. End User may not use the Software remotely via any technology, such as remote desktop.

VIRTUALIZATION FOR VIRTUAL CLASSROOMS: Under academic license, the End User may ask permission to
utilize a virtual environment to install and use the Software only with written consent from McTrans.

5. NETWORK USE: No network use is permitted, including but not limited to using the Software either directly or
through commands, data, or instructions from or to a computer not already licensed and part of the internal network
for Internet or web hosting services or by any user not licensed to use this copy of the Software through a valid
license from McTrans. The Software is not designed for network use, and such use is not supported. McTrans is
not able to provide technical support for issues resulting from network incompatibilities.

6. COPY RESTRICTIONS: Unauthorized copying, distribution, or dissemination of the Software is expressly
prohibited. End User may be held legally responsible for any copyright infringement that is caused, encouraged, or
enabled by failure to abide by the terms of this license. Subject to these restrictions, the End User may make copies
of the Software for backup purposes and for use of the Software on any computers located within its office complex,
as described in paragraph 3. Under no circumstances may the Software or associated printed documentation be
copied for sale, distribution, or dissemination, except as provided in paragraph 3, without the express, written
consent of McTrans. End User may reproduce the associated documentation as necessary to use within the
geographic location for which the license is granted. End User may not modify, adapt, translate, reverse engineer,
decompile, disassemble, or create derivative work from the Software or any associated written materials without
the prior written consent of McTrans. ANY SUCH ACTIVITY OR PRODUCT BECOMES THE PROPERTY OF
McTRANS.

7. TRANSFER RESTRICTIONS: The Software is licensed only to the End User, and this License Agreement may
not be assigned or transferred to anyone without the prior written consent of McTrans. Any authorized transferee
of this License Agreement shall be bound by the terms of this License Agreement. End User may not transfer,
assign, rent, lease, sell, or otherwise dispose of the Software except as expressly provided in this License
Agreement.
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8. REGISTRATION AND SUPPORT: This license is automatically registered to the person or entity that purchased
it. If the End User wishes to change the registration, he or she must provide in writing the registration information.
McTrans may, from time to time, revise or update the Software to correct bugs or add minor improvements. McTrans
will supply, at its discretion, minor updates to the End User without additional charge and will provide reasonable
telephone or email support to the End User during the normal business hours of McTrans for the period for which
the End User pays the subscription fee established by McTrans. McTrans reserves the right to determine the extent
of the support. McTrans reserves the right to make substantial revisions and enhancements to the Software and to
market such substantially revised versions as separate products. End User shall not be entitled to receive such
separate products without additional charge. Upon release of any such revised version of the Software, the
obligation to provide the above-described technical support services to the End User shall cease unless the End
User chooses to pay to license the enhanced version of the Software, whether or not the End User has previously
requested or received support on the prior version.

9. LIMITED WARRANTY AND LIMITATIONS OF REMEDIES: End User agrees that it is the responsibility of End
User to understand fully the limitations of and assumptions underlying the Software and not to make use of the
Software without the assistance of personnel with appropriate expertise. The End User accepts all responsibility for
the program output's review, interpretation, application, and use and accepts all responsibility for ensuring that the
output meets any applicable design code, standard, or project specification provisions.

Except as provided above, the product is provided “AS IS” without warranty of any kind, either expressed or implied,
including, but not limited to, implied warranties of merchantability and fitness for a particular purpose. McTrans does
not warrant that the functions contained in the Software will meet the End User’s requirements or that the operation
of the Software will be uninterrupted or error-free. The entire risk as to the quality and performance of the product
is with the End User. In no event will McTrans be liable to the End User for any damages, including any lost profits,
lost savings, or other incidental or consequential damages arising out of the use of or inability to use the Software,
even if McTrans has been advised of the possibility of such damages, or for any claim by any other party. The
above warranty gives the End User specific legal rights, and the End User may also have other rights in the United
States, which vary from state to state. Use of the Software where the End User believes or has reason to believe
that damage may occur is a violation of any and all warranties. McTrans has no knowledge of the hardware or
Software configurations of the End User and assumes no liability for their damage.

10. TERMINATION: This license is effective from the date the End User receives the Software until this License
Agreement is terminated. End User may terminate it by returning or destroying all copies of the Software and
associated documentation in End User’s possession or control. If the End User breaches any terms of this license,
the license shall terminate immediately.

11. GOVERNING LAW: This License Agreement shall be governed by the laws of the State of Florida, U.S.A. Venue
for all disputes related to this License Agreement shall be in the United States District Court of the Northern District
of Florida, Gainesville Division, or in the Circuit Court of the Eighth Judicial Circuit for Alachua County, Florida.

12. U.S. GOVERNMENT RESTRICTED RIGHTS: The Software and associated documentation are provided with
RESTRICTED RIGHTS. Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set
forth in subdivision (c)(1)(ii) of The Rights in Technical Data and Computer Software clause at 52.227-7013 or
subparagraphs (c)(1) and (2) of the Commercial Computer Software - Restricted Rights at 48CFR52.227-19. The
contractor is McTrans, University of Florida, PO Box 116585, Gainesville, FL 32611-6585.

13. EXPORT REGULATION: The Software may be subject to U.S. export control laws, including the U.S. Export
Control Reform Act and its associated regulations. End User will not directly or indirectly export, re-export, or release
the Software to, or make the Software accessible from, any country, jurisdiction, or person to which export, re-
export, or release is prohibited by applicable law. End User will comply with all applicable laws and complete all
required undertakings (including obtaining any necessary export license or other governmental approval) prior to
exporting, re-exporting, releasing, or otherwise making the Software available outside the U.S.

14. INTEGRATION: This License Agreement is the complete and exclusive statement of the agreement between
End User and McTrans and supersedes any proposal or prior agreement, oral or written, and any other
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communications between End User and McTrans relating to the subject matter of this License Agreement. This
License Agreement may only be modified by a written agreement made subsequent to the date hereof and signed
by both parties.

15. SEVERABILITY: If any portion of this License Agreement shall be declared void or a nullity by a court of
competent jurisdiction, then the remainder shall survive and remain in full force. Should you have any questions
concerning this license, you may contact the McTrans Center, University of Florida, PO Box 116585, Gainesville,
FL 32611-6585, U.S.A., [1] (800) 226-1013.
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Getting Started

Getting Started

To begin, click on File then New (or the "New File..." button on the Start page).

Normal Windows keyboard and mouse functions are available. Tabbing, clicking to a new field, or pressing the
Enter key will trigger a recalculation and update the report.
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General Controls

Menu Items

New — Creates a new HSS file (*.xhz) and starts a new analysis project based on one of the selections below;
shortcut is Ctrl+N

Segment — Creates a new HSS file (*.xhz) and starts a new Segment analysis project

Intersection/Speed Change Lanes — Creates a new HSS file (*.xhz) and starts a new Intersection/Speed
Change Lanes analysis project

Rural Facility — Creates a new HSS file (*.xhz) and starts a new Rural Facility analysis project

Urban Facility — Creates a new HSS file (*.xhz) and starts a new Urban Facility analysis project

Freeway and Ramp Facility — Creates a new HSS file (*.xhz) and starts a new Freeway and Ramp Facility
analysis project

Open — Opens an existing HSS file (*xhz) or HCS Freeways/Highways file (*.xuf); shortcut is Ctrl+O
Example Folder — Opens folder with HSS examples in File Explorer
Save — Saves an open HSS file (*.xhz) using the current file name; shortcut is Ctrl+S
Save As... — Saves an open HSS file (*.xhz) using a specified file name; shortcut is F12
Close — Closes an existing HSS file (*.xhz); shortcut is Ctrl+W
Units
USC Units — Changes the units of the current file to U.S. Customary
Metric Units — Changes the units of the current file to Metric
Print — Brings up printer selection and prints an HSS report to the printer or specified file type; shortcut is Ctrl+P

Print Preview — Displays preview of current report before printing; shortcut is Ctrl+F2

View
Page View — Changes the view to display inputs and report by pages; shortcut is F9
Full View
Report -> Right — Changes the view to display both the input screen and report simultaneously;
the report is displayed on the right portion of the screen; shortcut is F10
Report

Formatted Report — Displays formatted report including the most important values; shortcut is F4

Text Report — Displays text report with input, intermediary, and final results; shortcut is F6
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Parameter Template

View/Edit Template — Displays all Segment and Intersection Common Parameters for every Facility Type
on the General page, including the Economic Analysis Common Parameters, for editing; all other pages
and navigation buttons will be disabled until editing is finished; during editing, ‘View/Edit Template’ changes
to “To Normal Mode’, which can be selected after editing is finished

Export Template — Opens a Save As dialog box for user to save the exported template as an HSS
Template File (*.xhzt)

Import Template — Displays a popup indicating the template was successfully imported; all parameters for
the file will update according to values saved in the imported template

Export to CSV — Opens a Save As dialog box for the user to save exported results as an HSS CSV file (*.csv);
results saved in exported file are dependent on the Analysis Type of the dataset

Default Settings — Opens a dialog box for the user to input defaults for Analyst, Agency, Jurisdiction, and Default
Template (which allows the user to add a default path to a saved template), which will be applied to all new files;
also allows selection of USC or Sl units, which will be applied to all new files; shortcut is Alt+F

Help

Contents — Provides access to glossary, acknowledgements, copyrights, and information on the HSS
procedures; shortcut is Ctrl+F1

Index — Allows user to search keywords within the glossary
Search — Allows user to search for any word within the glossary
User Guide — Opens a comprehensive user guide in PDF format; shortcut is Ctrl+G

HSS Updates — Sends the HSS version number anonymously without any personally identifiable
information to McTrans to check for a newer version

HSM/HSS Training — Opens the McTrans Training Page in the default web browser to view the latest
training opportunities

Support

Frequently Asked Questions — Opens the McTrans support page for HSS in the default web
browser

HSS Overview — Opens the McTrans HSS Overview page in the default web browser
McTrans Website — Opens the McTrans home page in the default web browser

E-mail McTrans — Composes a new e-mail addressed to McTrans in the default e-mail client with
registration number, serial key, module, and version number already populated in the Subject field

About HSS - Opens an about window with software version information, EULA, general
acknowledgements, contact information, and other relevant links

Exit — Exits the Highway Safety Software; shortcut is Alt+F
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Highway Safety

Highway Safety Manual

The Highway Safety Software (HSS) is designed to determine the predicted number of crashes for segments and
intersections following the Predictive Method found in the AASHTO Highway Safety Manual (HSM) and NCHRP
reports. The basis of the Predictive Method is calculating a Safety Performance Function (SPF) and applying Crash
Modification Factors (CMFs) based on certain geometric and safety feature data in the intersection/segment. The
Predictive Method is explained in the HSM Part C and the HSM Supplement in the following chapters:

Chapter 10 — Rural Two-Lane, Two-Way Roads
Chapter 11 — Rural Multilane Highways
Chapter 12 — Urban and Suburban Arterials
Chapter 18 — Freeways

Chapter 19 — Ramps

The Highway Safety Software also includes new methods developed as a product of research projects. These
methods were implemented as published in the reports listed below, and may be adjusted when formally
incorporated in a future release of the Highway Safety Manual:

Roundabouts — NCHRP Report 888: Development of Roundabout Crash Prediction Models and Methods /
NCHRP Project 17-70

Intersections with All-Way Stop Control — NCHRP Web-Only Document 297: Intersection Crash Prediction
Methods for the Highway Safety Manual | NCHRP Project 17-68, Chapter 3

Three-Leg Intersections with Signal Control on Rural Highways — NCHRP Web-Only Document 297:
Intersection Crash Prediction Methods for the Highway Safety Manual | NCHRP Project 17-68, Chapter 4
Urban and Suburban Segments with Six or More Lanes — NCHRP Web-Only Document 318: Safety
Prediction Models for Six-Lane and One-Way Urban and Suburban Arterials | NCHRP Project 17-58,
Chapter 5

Intersections of Urban and Suburban Arterials with Six or More Lanes — NCHRP Web-Only Document 318:
Safety Prediction Models for Six-Lane and One-Way Urban and Suburban Arterials | NCHRP Project 17-
58, Chapter 6

Urban and Suburban One-Way Arterial Roadway Segments — NCHRP Web-Only Document 318: Safety
Prediction Models for Six-Lane and One-Way Urban and Suburban Arterials | NCHRP Project 17-58,
Chapter 7

Intersections of Urban and Suburban One-Way Arterials — NCHRP Web-Only Document 318: Safety
Prediction Models for Six-Lane and One-Way Urban and Suburban Arterials | NCHRP Project 17-58,
Chapter 8
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Initial Steps

When creating a new file in HSS from the Start page, a prompt appears asking for the Analysis Type, as shown
below:

% Select Analysis Type X
Start Help
New File... ® Segment Topics
: Ol ion/Speed Change La
Open File... i i i i HSS Updates
() Rural Facility
Example Folder... O Urban Facilty HSS Overview
Recent () Freeway and Ramp Facility McTrans Website
HSM/HSS Training
E-mail McTrans
About HSS
. & HSS2024
|
| Transportation Institute
UF| UNIVERSITY of FLORIDA | MCI rans

Copyright © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024

The process for user inputs is very similar between all five available Analysis Types. Once Analysis Type is selected,
it cannot be changed. A new file must be created if the user wishes to change the Analysis Type.

Segment Analysis

Once Segment is selected as the Analysis Type, the user will be brought to the General page, which includes a
section for Project Properties. The Project Properties section includes general information about the project, which
include: Analyst, Agency, Date, Jurisdiction, Analysis Year, Project Description, Empirical Bayes Analysis, Number
of Years of Observed Crashes, Facility Type, and Area Type. The user can switch between different Facility Types.
The five choices of Facility Type include: Rural Two-Lane Segment, Rural Multilane Segment, Urban Segment,
Freeway Segment, and Ramp Segment. If the Facility Type selected is Rural Two-Lane Segment or Rural Multilane
Segment, the Area Type will automatically be set to Rural. If the Facility Type selected is Urban Segment, the Area
Type will automatically be set to Urban. If the Facility Type selected is Freeway Segment or Ramp Segment, a drop-
down menu will be enabled for Area Type, allowing a selection between Rural and Urban. An Empirical Bayes (EB)
Analysis checkbox is provided for the user to indicate whether or not to use the EB analysis, which is a method
used to combine observed crash frequency data for a given site with predicted crash frequency data from many
similar sites to estimate its expected crash frequency. Checking this will also enable the Number of Years of
Observed Crashes input on the General page and the Observed Crashes inputs on the Details page.

If economic results are enabled through the Default Settings, then Economic Analysis Common Parameters will
also show on the General page. Other parameters are included on the Details page under the Parameters section.
The Facility Type selected on the General page will determine which segment parameters to show. The parameters
listed vary based on the Model Type under analysis.
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Rural Two-Lane Segment Common Parameters include:

e Calibration Factor, C
e Proportion of Related Crashes, Pra
e Proportion of Nighttime Crashes that Involve a Fatality or Injury, Pinr
e Proportion of Nighttime Crashes that Involve Property Damage, Ppnr
e Proportion of Crashes that Occur at Night, Pnr
e Proportion of Fatal
e Proportion of Incapacitating Injury
e Proportion of Nonincapacitating Injury
e Proportion of Possible Injury
e Crash distribution proportions for Total, Fatal-and-Injury, and Property-Damage-Only crashes:
o Single-Vehicle Crashes
= Collision with Animal
= Collision with Bicycle
= Collision with Pedestrian
=  Overturned
= Ran Off Road
= Other Single-Vehicle Collision
o Multiple-Vehicle Crashes
= Angle Collision
= Head-On Collision
= Rear-End Collision
= Sideswipe Collision
= Other Multiple-Vehicle Collision

Rural Multilane Segment Common Parameters include:

e Calibration Factor, C
e Proportion of Related Crashes, Pra
e Proportion of Nighttime Crashes that Involve a Fatality or Injury, Pinr
e Proportion of Nighttime Crashes that Involve Property Damage, Ppnr
e Proportion of Crashes that Occur at Night, Pnr
e Crash distribution proportions for Total, Fatal-and-Injury, Fatal-and-Injury KAB, and Property-Damage-Only
crashes:
o Head-On Collision
Sideswipe Collision
Rear-End Collision
Angle Collision
Single-Vehicle Crashes
Other Multiple-Vehicle Crashes

O O O O O

Urban Segment Common Parameters include:

e Calibration Factor, C (Speed <=30)

e Calibration Factor, C (Speed >30)

e Proportion of Nighttime Crashes that Involve a Fatality or Injury, Pinr
e Proportion of Nighttime Crashes that Involve Property Damage, Ppnr
e Proportion of Crashes that Occur at Night, Pnr

e Pedestrian Crash Adjustment Factor, fpedr (Speed <=30)

e Pedestrian Crash Adjustment Factor, fpedr (Speed >30)

e Bicycle Crash Adjustment Factor, foiker (Speed <=30)

e Bicycle Crash Adjustment Factor, foiker (Speed >30)
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e Crash distribution proportions for Fatal-and-Injury and Property-Damage-Only crashes:

o Single-Vehicle Crashes

= Collision with Animal

= Collision with Fixed Object

= Collision with Fixed Object-Left

= Collision with Fixed Object-Right

= Collision with Other Object

= Other Single-Vehicle Collisions
o Multiple-Vehicle Crashes

= Rear-End Collisions

= Head-On Collisions

= Angle Collisions

= Sideswipe, Same Direction

= Sideswipe, Opposite Direction

= Other Multiple-Vehicle Collision

Freeway Segment Common Parameters include:

e Calibration Factor for Multiple-Vehicle Fatal-and-Injury Crashes, Cmviii

e Calibration Factor for Multiple-Vehicle Property-Damage-Only Crashes, Cmv,pdo
e Calibration Factor for Single-Vehicle Fatal-and-Injury Crashes, Csy;i

e Calibration Factor for Single-Vehicle Property-Damage-Only Crashes, Csv,pdo

Ramp Segment Common Parameters include:

Calibration Factor for Multiple-Vehicle Fatal-and-Injury Crashes, Cmvifi
Calibration Factor for Multiple-Vehicle Property-Damage-Only Crashes, Cmv,pdo
Calibration Factor for Single-Vehicle Fatal-and-Injury Crashes, Csv i
Calibration Factor for Single-Vehicle Property-Damage-Only Crashes, Csv,pdo

The Economic Analysis Common Parameters include Societal Crash Costs by Crash Severity:

e Fatal/lnjury, $
e Property Damage Only, $

Below is an example of the General page:

Project Description

Analyst Jurisdiction

Agency Analysis Year 2023
Date 9/27/2023 Project Description
Empirical Bayes Analysis O MNumber of Years of Observed Crashes
Facility Type Ramp Segment A Area Type Urban
@ Economic Analysis Common Parameters

Societal Crash Costs by Crash Severity

Fatal/Injury. $ 158200

Property Damage Only, § 7400

On the Details page, four sections are provided: Segment, Input, Parameters, and Output. Depending on if Empirical
Bayes Analysis is selected on the General page, there could also be an additional Observed Crashes section. The
Segment section states the Facility Type selected on the General page and provides a drop-down menu for
selecting the Model Type based on the Facility Type selected. Inputs and Parameters available are based on the
Facility Type and Model Type selected. Outputs include the Safety Performance Functions (SPFs), the various

Crash Modification Factors (CMFs), and the Predicted Crash Frequencies.

Highway Safety Software User Guide
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Below is an example of the Details page for a Rural Two-Lane Facility Type and an Undivided Roadway Segment
(2U) Model Type, with Empirical Bayes Analysis checked on the General page:

Segment

Facility Type Rural Twe-Lane Model Type Two-Lane Undivided Segment (2U)
Input
AADT, veh/day 1000 Length, mi 1.000
Lane Width, ft 12.0 Shoulder Width, ft 16.0
Shoulder Type Paved v Horizontal Curve O
Horizontal Curve Length, mi - Horizontal Curve Radius, ft
Spiral Transition Superelevation Variance, ft/ft
Grade, % 0.0 Number of Driveways 0
Centerline Rumble Strips O Passing Lanes No Passing or Climbing Lanes -
Two-Way Left-Turn Lanes O Roadside Hazard Rating !
Lighting O Automated Speed Enforcement O
Observed Crashes 0
Parameters
©
Output
Safety Performance Function (SPF) 0.267 Predicted Crash Frequency (Npredicted) 0.267
CMF1 (Lane Width) 1.000 CMF2 (Shoulders) 1.000
CMF3 {Horizontal Curves) 1.000 CMF4 (Horizontal Curves: Superelevation) 1.000
CMF5 (Grades) 1.000 CMF6 (Driveway Density, CMF6 = 1 when <=5) 1.000
CMF7 (Centerline Rumble Strips) 1.000 CMF& (Passing Lanes) 1.000
CMFS (Two-Way Left-Tumn Lanes) 1.000 CMF10 {Roadside Design) 1.000
CMF11 (Lighting) 1.000 CMF12 (Automated Speed Enforcement) 1.000

Intersection Analysis

Once Intersection/Speed Change Lanes is selected as the Analysis Type, the user will be brought to the General
page, which includes a section for Project Properties. The Project Properties section includes general information
about the project, which include: Analyst, Agency, Date, Jurisdiction, Analysis Year, Project Description, Empirical
Bayes Analysis, Number of Years of Observed Crashes, Facility Type, and Area Type. The user can switch between
different Facility Types. The five choices of Facility Type include: Rural Two-Lane Intersection, Rural Multilane
Intersection, Urban Intersection, Speed Change Lanes, and Ramp Terminal. If the Facility Type selected is Rural
Two-Lane Intersection or Rural Multilane Intersection, the Area Type will automatically be set to Rural. If the Facility
Type selected is Urban Intersection, the Area Type will automatically be set to Urban. If the Facility Type selected
is Speed Changes Lanes or Ramp Terminal, a drop-down menu will be enabled for Area Type, allowing a selection
between Rural and Urban. An Empirical Bayes (EB) Analysis checkbox is provided for the user to indicate whether
or not to use the EB analysis, which is a method used to combine observed crash frequency data for a given site
with predicted crash frequency data from many similar sites to estimate its expected crash frequency. Checking this
will also enable the Number of Years of Observed Crashes input on the General page and the Observed Crashes
inputs on the Details page.

If economic results are enabled through the Default Settings, then Economic Analysis Common Parameters will
also show on the General page. Other parameters are included on the Details page under the Parameters section.
The Facility Type selected on the General page will determine which intersection parameters to show. The
parameters listed vary based on the Model Type under analysis.

Rural Two-Lane Intersection Common Parameters include:

e Calibration Factor, C

e Proportion of Total Crashes for Unlighted Intersections that Occur at Night, Phni
e Proportion of Fatal

e Proportion of Incapacitating Injury

e Proportion of Nonincapacitating Injury
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e Proportion of Possible Injury

e Crash distribution proportions for Total, Fatal-and-Injury, and Property-Damage-Only crashes:

o Single-Vehicle Crashes

= Collision with Animal

= Collision with Bicycle

= Collision with Pedestrian

= Vehicle Overturned

= Ran Off Road

= Other Single-Vehicle Collision
o Multiple-Vehicle Crashes

= Angle Collision

= Head-On Collision

= Rear-End Collision

= Sideswipe Collision

= Other Multiple-Vehicle Collision

Rural Multilane Intersection Common Parameters include:

e Calibration Factor, C
e Proportion of Total Crashes for Unlighted Intersections that Occur at Night, Pni

e Crash distribution proportions for Total, Fatal-and-Injury, Fatal-and-Injury KAB, and Property-Damage-Only

crashes:
o Head-On Collision
Sideswipe Collision
Rear-End Collision
Angle Collision
Single-Vehicle Crashes
Other Multiple-Vehicle Crashes

O O O O O

Urban Intersection Common Parameters include:

Calibration Factor, C

Proportion of Total Crashes that Occur at Night, Pni

Pedestrian Crash Adjustment Factor, fpedi

Bicycle Crash Adjustment Factor, foikei

Proportion of MV Crashes by Right-Angle Collisions, Pramv (FI)
Proportion of MV Crashes by Right-Angle Collisions, Pramv (PDO)
Proportion of MV Crashes by Rear-End Collisions, Premv (FI)
Proportion of MV Crashes by Rear-End Collisions, Premv (PDO)
Proportion of Fatal-and-Injury Crashes for Combined Sites, foisv

o Single-Vehicle Crashes
= Collision with Parked Vehicle
= Collision with Animal
= Vehicle Overturned
= Collision with Fixed Object
= Collision with Other Object
= Other Single-Vehicle Collision
= Noncollision
o Multiple-Vehicle Crashes
= Rear-End Collision
= Head-On Collision
= Angle Collision
= Sideswipe
= Other Multiple-Vehicle Collision

Crash distribution proportions for Fatal-and-Injury and Property-Damage-Only crashes:
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Speed Change Lanes Intersection Common Parameters include:

e Calibration Factor for Fatal-and-Injury Crashes, Cr;
e Calibration Factor for Property-Damage-Only Crashes, Cpdo

Ramp Terminal Intersection Common Parameters include:

e Calibration Factor for Fatal-and-Injury Crashes, Cii
e Calibration Factor for Property-Damage-Only Crashes, Cpdo

The Economic Analysis Common Parameters include Societal Crash Costs by Crash Severity:

e Fatal/Injury, $

e Property Damage Only, $

Below is an example of the General page:

Analyst

Agency

Date

Empirical Bayes Analysis

Facility Type

@ Economic Analysis Common Parameters
Societal Crash Costs by Crash Severity

Fatal/Injury, §

Property Damage Only, $

9/27/2023

Urban Intersection

158200

7400

Project Description
Jurisdiction
Analysis Year
Project Description
Mumber of Years of Observed Crashes

Area Type

2023

Urban

On the Details page, four sections are provided: Intersection, Input, Parameters, and Output. Depending on if
Empirical Bayes Analysis is selected on the General page, there could also be an additional Observed Crashes
section. The Intersection section states the Facility Type selected on the General page and provides a drop-down
menu for selecting the Model Type based on the Facility Type selected. Inputs and Parameters available are based
on the Facility Type and Model Type selected. Additional input sections may also appear depending on the Facility
Type and/or Model Type selected. Outputs include the Safety Performance Functions (SPFs), the various Crash
Modification Factors (CMFs), and the Predicted Crash Frequencies.

Below is an example of the Details page for an Urban Facility Type and a Four Approach Stop (4ST) General Model
Type, with Empirical Bayes Analysis checked on the General page:

Facility Type
Is Major Street One-Way?
Is Minor Street One-Way?

Method Type

AADT (maj), veh/day
Approaches with Left-Turn Lanes

Lighting

®

Multiple Vehicle

Safety Performance Function (SPF)
CMF1 (Left-Turn Lanes)
CMF3 (Right-Turn Lanes)

CMF5 (Lighting)

Intersection

Urban Model Type
O MNumber of Through Lanes on Major Street
O Mumber of Through Lanes on Minor Street

General
Input

1000 AADT (min), veh/day

0 Approaches with Right-Turn Lanes
O
Parameters
Observed Crashes
0 Single Vehicle
Qutpu
0.330 Predicted Crash Frequency (Npredicted)
1.000 CMF2 (Left-Turn Phases)
1.000 CMF4 (Right-Turn on Red)
1.000 CMF& (Red Light Running Cameras)

Four-leg, Minor-Stop (45T) ~
4

2

1000

0.343
1.000
1.000

1.000
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Roundabout Analysis
Intersection-level inputs:

¢ Inscribed Circle Diameter (ICD)

o Number of legs: different crash prediction models are applied for 3-leg or 4-leg intersections

e Max. number of circulating lanes: different crash prediction models are applied to one or two circulating
lanes; hybrid roundabouts mixed circulating lanes (one or two) are always analyzed as two circulating lanes

Leg-level inputs:

Number of entering lanes
Number of circulating lanes
Number of exiting lanes
Entry width

Circulating width

Posted speed limit
Entering AADT

Circulating AADT

Exiting AADT

Note: The Highway Safety Software implements the “Design Level” crash prediction model for roundabouts. NCHRP
Report 888 also developed a planning-level method, which is not included in the software.

Method Type

For urban intersections, there are three method types available for calculations. The three method types include:
General, Six or More Lanes, and One-Way. The General methodology can be found in Chapter 12 of the Highway
Safety Manual. The Six or More Lanes methodology can be found in Chapter 6 of NCHRP 17-58. The One-Way
methodology can be found in Chapter 8 of NCHRP 17-58.

The following inputs help indicate which method type will be used:

e Number of Through Lanes on Major Street

o If the number of lanes is 5 or less, the method type used will be General. If the number of lanes is
6 or more, the method type used will be Six or More Lanes. If ‘Is Major Street One-Way?’ is
checked, the method type used will be One-Way and the number of through lanes on major street
will have no influence on the method type used.

e Is Major Street One-Way

o A checkbox is provided to indicate whether or not the major street is one-way. If checked, the
method used will be One-Way.

Rural Facility Analysis

Once Rural Facility is selected as the Analysis Type, the user will be brought to the General page, which includes
sections for Project Description, Facility Data, and Parameters. The Project Description section includes general
information about the project, which include: Analyst, Agency, Date, Jurisdiction, Analysis Year, Project Description,
Empirical Bayes Analysis, and Number of Years of Observed Crashes. An Empirical Bayes (EB) Analysis checkbox
is provided for the user to indicate whether or not to use the EB analysis, which is a method used to combine
observed crash frequency data for a given site with predicted crash frequency data from many similar sites to
estimate its expected crash frequency. Checking this will also enable the Number of Years of Observed Crashes
input on the General page and the Observed Crashes input on the Details page.

The Facility Data section includes a table that specifies details for individual sections within a rural facility. When a
new Rural Facility analysis is created, the table will have one row of section data already added to the table. The
user can choose to keep this section or delete it by selecting the row and clicking the button ‘Delete Section’. If
there are multiple rows of data the user wishes to delete, consecutive rows can be selected at a time and then
deleted together using the same button. To add a section, two buttons are provided: ‘Add Section’ and ‘Insert
Section’. ‘Add Section’ will add a new row of section data at the end of the table. ‘Insert Section’ will add a new row
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of section data before the selected row. Before adding or inserting a section, the user can specify the Facility Type
and Section Type of the new section being added. The New Section Facility Types include: Rural Two-Lane and
Rural Multilane. The New Section Types include: Segment and Intersection. The row of data added to the table
includes: Section Type; Facility Type; Name; Model Type; AADT, veh/day; Length; Details; N(spf); and N(predicted).
Observed Crashes and N(expected) are also included in the table if Empirical Bayes Analysis is checked. Clicking
on Details will bring the user to the corresponding Details page. N(spf), N(predicted), Observed Crashes, and
N(expected) are determined by the inputs found on the Details page. Under the table, the total number of predicted
crashes, which is the summation of N(predicted) for all sections, is specified.

The Parameters section gives the option of using Project-Level Parameters or Section-Level Parameters. A
checkbox is provided to indicate this. If Project-Level Parameters is checked, the Parameters section on the General
page will include Segment Common Parameters and Intersection Common Parameters for Rural Two-Lane and
Rural Multilane facilities, along with corresponding crash distribution proportions; and Economic Analysis Common
Parameters if enabled. If Project-Level Parameters is not checked, only Economic Analysis Common Parameters
will display on the General page if enabled. Corresponding section-level parameters will display on the Details page
of each of the sections. For the list of parameters, please see Segment Analysis and/or Intersection Analysis.

Below is an example of the General page:

Project Description

Analyst Jurisdiction

Agency Analysis Year 2023
Date G9/28/2023 Project Description

Empirical Bayes Analysis O Number of Years of Observed Crashes

Facility Data

MNew Section Facility Type | Rural Multilane ~ | New Section Type | Intersection -

Section Type Facility Type Name Model Type AADT, veh/day Length, mi Details Nspf} N(predicted)
1 Segment Rural Two-Lane Two-Lane Undivided Segment (2U) 1000 1.000 Details 0.267 0.267
2 Intersection Rural Two-Lane Four-leg, Minor-Stop (45T) = 0817 0817
3 Segment Rural Multilane Divided 1000 1.000 0.169 0.169
4 Intersection Rural Multilane Four-leg, Minor-Stop (45T) 0348 0.348

The total number of predicted crashesis: 1.601

*]

Param
Project-Level Parameters

@ Segment Common Parameters
(%) Rural Two-Lane
@ Rural Multilane

Undivided Divided

Calibration Factor, C 1.00 1.00
Proportion of Related Crashes, Pra 0.270 0.500
Proportion of Nighttime Crashes that Invelve a Fl, Pinr 0.361 0.323

On the Details page, three sections are provided: Section Data, Input, and Output. If Project-Level Parameters is
not checked on the General page, a fourth section (Parameters) will appear on the Details page after the Input
section. Section Data allows the user to select which section details to display. It also specifies the Facility Type,
Section Type, and Model Type of the section. Inputs available are based on the Facility Type, Section Type, and
Model Type selected. Section-level parameters display in the Parameters section according to the Facility, Section,
and Model Type of the section displayed. Outputs include the Safety Performance Function (SPF), the various
Crash Modification Factors (CMFs), and the Predicted Crash Frequency (Npredicted)-

16 - Highway Safety Highway Safety Software User Guide



Below is an example of the Details page for a Rural Multilane Facility Type, Segment Section Type, and Divided
Model Type combination, with Empirical Bayes Analysis checked and Project-Level Parameters not checked on the
General page:

Section Data
Section 3= ~ Facility Type Rural Multilane
Section Type Segment Model Type Divided

Input
AADT, veh/day 1000 Length. mi 1.000
Lane Width, ft 12.0 Paved Right Shoulder Width, ft 8.0
Automated Speed Enforcement O Median Barriers
Lighting D
OCbserved Crashes F 0 Observed Crashes PDO 0
Parameters
©
':'LH';':\I‘

Safety Performance Function (SPF) 0.169 Predicted Crash Frequency (Npredicted) 0.169
CMF1 (Lane Width) 1.000 CMF2 (Shoulders) 1.000
CMF3 (Median Width) 1.000 CMF4 (Lighting) 1.000
CMF5 {Automated Speed Enforcement) 1.000

Urban Facility Analysis

Once Urban Facility is selected as the Analysis Type, the user will be brought to the General page, which includes
sections for Project Description, Facility Data, and Parameters. The Project Description section includes general
information about the project, which include: Analyst, Agency, Date, Jurisdiction, Analysis Year, Project Description,
Empirical Bayes Analysis, and Number of Years of Observed Crashes. An Empirical Bayes (EB) Analysis checkbox
is provided for the user to indicate whether or not to use the EB analysis, which is a method used to combine
observed crash frequency data for a given site with predicted crash frequency data from many similar sites to
estimate its expected crash frequency. Checking this will also enable the Number of Years of Observed Crashes
input on the General page and the Observed Crashes input on the Details page.

The Facility Data section includes a table that specifies details for individual sections within an urban facility. When
a new Urban Facility analysis is created, the table will have one row of section data already added to the table. The
user can choose to keep this section or delete it by selecting the row and clicking the button ‘Delete Section’. If
there are multiple rows of data the user wishes to delete, consecutive rows can be selected at a time and then
deleted together using the same button. To add a section, two buttons are provided: ‘Add Section’ and ‘Insert
Section’. ‘Add Section’ will add a new row of section data at the end of the table. ‘Insert Section’ will add a new row
of section data before the selected row. Before adding or inserting a section, the user can specify the Section Type
of the new section being added. The New Section Types include: Segment and Intersection. The row of data added
to the table includes: Section Type; Facility Type; Name; Model Type; AADT, veh/day; Length; Details; N(spf); and
N(predicted). Observed Crashes and N(expected) are also included in the table if Empirical Bayes Analysis is
checked. Clicking on Details will bring the user to the corresponding Details page. N(spf), N(predicted), Observed
Crashes, and N(expected) are determined by the inputs found on the Details page. Under the table, the total number
of predicted crashes, which is the summation of N(predicted) for all sections, is specified.

The Parameters section gives the option of using Project-Level Parameters or Section-Level Parameters. A
checkbox is provided to indicate this. If Project-Level Parameters is checked, the Parameters section on the General
page will include Segment Common Parameters and Intersection Common Parameters for an Urban facility, along
with corresponding crash distribution proportions; and Economic Analysis Common Parameters. If Project-Level
Parameters is not checked, only Economic Analysis Common Parameters will display on the General page.
Corresponding section-level parameters will display on the Details page of each of the sections. For the list of
parameters, please see Segment Analysis and/or Intersection Analysis.
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Below is an example of the General page:

Analyst
Agency

Date

Empirical Bayes Analysis

Project Description

9/28/2023

O

Jurnisdiction

Analysis Year

Project Description

Number of Years of Observed Crashes

Facility Data

New Section Type [Segment ~
Section Type Facility Type Model Type AADT, veh/day Length, mi Details N{spf) M{predicted)

1 Segment Urban Two-Lane Undivided Segment (2U) 1000 1.000 Dies 0228 0.241
2 Intersection Urban Four-leg, Minor-Stop {45T) 0330 0343
3 Segment Urban Three-Lane Segment Including a Center TWI 1000 1.000 0.204 0218
4 Intersection Urban Four-leg, Signal (45G) - 0.160 0.162
5 Segment Urban Four-Lane Undivided Segment (4U) 1000 1.000 0178 0184
6 Intersection Urban Three-leg, Minor-Stop (35T) e 0170 0177
7 Segment Urban Four-Lane Divided Segment (4D) 1000 1.000 0217 0235
g Intersection Urban Three-leg, Signal (35G) - 0.104 0.105
g Segment Urban Five-Lane Segment Including a Center TWLT| 1000 1.000 03535 0577

Project-Level Parameters

C’D Segment Common Parameters

@ Urban

@ Intersection Common Parameters

On the Details page, three sections are provided: Section Data, Input, and Output. If Project-Level Parameters is
not checked on the General page, an extra section (Parameters) will appear on the Details page after the Input
section. If Empirical Bayes Analysis is checked on the General page, an extra section (Observed Crashes) will
appear on the Details page before the Output section. Section Data allows the user to select which section details
to display. It also specifies the Facility Type, Section Type, and Model Type of the section. Inputs available are
based on the Facility Type, Section Type, and Model Type selected on the General page. Section-level parameters
display in the Parameters section according to the Facility, Section, and Model Type of the section displayed.
Observed Crashes inputs are based on the Section Type selected. Outputs include the Safety Performance

Parameters

The total number of predicted crashes is :

Functions (SPFs), the various Crash Modification Factors (CMFs), and the Predicted Crash Frequencies.
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Below is an example of the Details page for an Urban Facility Type, Intersection Section Type, and Three Approach
Stop (3ST) General Model Type combination, with Empirical Bayes Analysis checked and Project-Level Parameters
not checked on the General page:

Section Data

Section 6> - Facility Type Urban
Section Type Intersection Model Type Three-leg, Minor-5top (35T)
Is Major Street One-Way? D Number of Through Lanes on Major Street 4

Is Miner Street One-Way? O Number of Through Lanes on Minor Street 2
Method Type General

Input
AADT (maj), veh/day 1000 AADT (min), veh/day 1000
Appreaches with Left-Turn Lanes 0 Approaches with Right-Turn Lanes Q
Lighting O
imeters
@
-------- ] ( nes

Multiple Vehicle 0 Single Vehicle Q
Safety Performance Function (SPF) 0.170 Predicted Crash Frequency (Mpredicted) 0177
CMF1 (Left-Turn Lanes) 1.000 CMF2 (Left-Turn Phases) 1.000
CMF3 (Right-Turn Lanes) 1.000 CMF4 (Right-Turn on Red) 1.000
CMF5 (Lighting} 1.000 CMF6 (Red Light Running Cameras) 1.000

Freeway and Ramp Facility Analysis

Once Freeway and Ramp Facility is selected as the Analysis Type, the user will be brought to the General page,
which includes sections for Project Description, Facility Data, and Parameters. The Project Description section
includes general information about the project, which include: Analyst, Agency, Date, Jurisdiction, Analysis Year,
Project Description, Area Type, Empirical Bayes Analysis, and Number of Years of Observed Crashes. An Empirical
Bayes (EB) Analysis checkbox is provided for the user to indicate whether or not to use the EB analysis, which is a
method used to combine observed crash frequency data for a given site with predicted crash frequency data from
many similar sites to estimate its expected crash frequency. Checking this will also enable the Number of Years of
Observed Crashes input on the General page and the Observed Crashes input on the Details page.

The Facility Data section includes a table that specifies details for individual sections within a freeway facility. When
a new Freeway and Ramp Facility analysis is created, the table will have one row of section data already added to
the table. The user can choose to keep this section or delete it by selecting the row and clicking the button ‘Delete
Section’. If there are multiple rows of data the user wishes to delete, consecutive rows can be selected at a time
and then deleted together using the same button. To add a section, two buttons are provided: ‘Add Section’ and
‘Insert Section’. ‘Add Section’ will add a new row of section data at the end of the table. ‘Insert Section’ will add a
new row of section data before the selected row. Before adding or inserting a section, the user can specify the
Section Type of the new section being added. The New Section Types include: Segment and Intersection. The row
of data added to the table includes: Section Type; Facility Type; Name; Model Type; AADT, veh/day; Length;
Details; N(spf); and N(predicted). Observed Crashes and N(expected) are also included in the table if Empirical
Bayes Analysis is checked. Clicking on Details will bring the user to the corresponding Details page. N(spf),
N(predicted), Observed Crashes, and N(expected) are determined by the inputs found on the Details page. Under
the table, the total number of predicted crashes, which is the summation of N(predicted) for all sections, is specified.
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The Parameters section gives the option of using Project-Level Parameters or Section-Level Parameters. A
checkbox is provided to indicate this. If Project-Level Parameters is checked, the Parameters section on the General
page will include Segment Common Parameters and Intersection Common Parameters for Freeway Segment and
Ramp Segment, and Speed Change Lanes and Ramp Terminal, respectively; and Economic Analysis Common
Parameters. If Project-Level Parameters is not checked, only Economic Analysis Common Parameters will display
on the General page. Corresponding section-level parameters will display on the Details page of each of the
sections. For the list of parameters, please see Segment Analysis and/or Intersection Analysis.

Below is an example of the General page:

Project Description

Analyst Jurisdiction

Agency Analysis Year 2023
Date 19/28/2023 Project Description

Empirical Bayes Analysis O Number of Years of Observed Crashes

Area Type Rural =

Facility Data

Ramp - | New SectionType | Ramp Terminal -

Section Type Facility Type Mame Model Type AADT, veh/day Length, mi Details N(spf} Nipredicted)
1 Freeway Segment Freeway Freeway Segment 1000 1.000 Details = 0.292
2 Speed Change Lanes |Freeway Speed Change Lanes 1000 1.000 0.026
3 Ramp Segment Ramp Ramp Segment 1000 1.000 0304
4 Ramp Terminal Ramp Signal-Controlled Det 0.765

The total number of predicted crashesis: 1.387

Param
Project-Level Parameters

P -
(#) Segment Common Parameters

@ Freeway Segment

Calibration Factor for Multiple-Vehicle Fatal-and-Injury Crashes, Cmv fi 1.00
Calibration Factor for Multiple-Vehicle Property-Damage-Only Crashes, Cmw.pdo 1.00
Calibration Factor for Single-Vehicle Fatal-and-Injury Crashes, Csv.fi 1.00

On the Details page, three sections are provided: Section Data, Input, and Output. If Project-Level Parameters is
not checked on the General page, an extra section (Parameters) will appear on the Details page after the Input
section. If Empirical Bayes Analysis is checked on the General page, an extra section (Observed Crashes) will
appear on the Details page before the Output section. Section Data allows the user to select which section details
to display. It also specifies the Facility Type, Section Type, and Model Type of the section. Inputs available are
based on the Facility Type, Section Type, and Model Type selected on the General page. Section-level parameters
display in the Parameters section according to the Facility, Section, and Model Type of the section displayed.
Observed Crashes inputs are based on the Section Type selected. Outputs include the Safety Performance
Functions (SPFs), the various Crash Modification Factors (CMFs), and the Predicted Crash Frequencies.
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Below is an example of the Details page for a Freeway Facility Type, Speed Changes Lanes Section Type, and
Speed Change Lanes Model Type combination, with Empirical Bayes Analysis checked and Project-Level

Parameters not checked on the General page:

Section

Section Type

AADT, veh/day

Length of Ramp Entrance, mi

Primary Direction Lanes

Include Horizontal Curves

Lane Width (W1), ft

Inzide Shoulder Width (Wis), ft
Proportion of Median Barrier Length (Pik)

®

Fatal/Injury

N (SPF, fi)
CMF Combined (fi)

Predicted Crashes (fi)

2>

Speed Change Lanes

1000

1.000

w

0.007

1.032

0.007

ion Data

Vsl
@

el
r

Facility Type
Model Typs
nout
AADT Volume of Ramp (AADTY), veh/day
Ramp Type
Secondary Direction Lanes
Is Left Side Ramp
Median Width (Wm), ft
Distance from Inside Shoulder to Barrier (Wich), ft

Proportion of AADT during High Volume Hours {Phv)

Property Damage Only
Qutput

N (SPF. pdo)

CMF Combined (pdo)

Predicted Crashes (pdo)

Freeway

Speed Change Lanes

1000
Entrance
3
O
60
10.00

0.000

0.019
1.026

0.019

Report

The report page shows a formatted version of the analysis in a dynamic form, reacting to changes in the General
and Details pages. All or a portion can be copied to the Windows clipboard for insertion into other files by right-
clicking into the report and selecting Copy.

Both formatted and text reports are available for viewing (through the Report tab or Print Preview) and printing. The
formatted report provides data and results that are most important to the user, and are displayed in a clean and
more presentable fashion. The text report provides more details to the user, rather than a summary. A drop-down
menu is provided for section selection for both formatted and text reports. Reports can be displayed based on the
specific individual section selected or all sections can be displayed together.
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How To

Create a New File

1. From the Start screen, there are three options for creating a new file:
4 Highway Safety Software - m} X

Start }/ Help
.
y

New File... — Topics

Open File... HSS HSS Updates
Example Folder... HSS Overview
Recent McTrans Website

HSM/HSS Training

E-mail McTrans

About HSS
&4 HSS2024
Transportation Institut:
oaveservarous: | VICTFGANS
Copyright © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024

Note: A new file can be created if an existing file is already open; you do not need to start from the Start
screen.

\

a. Selecting File > New from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen, hovering over “New”, and then selecting one of the analysis types.
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=]
X

%4 Highway Safety Software =i

Transportation lns(i!ule‘ M 7_
UF Gevieinamon: | McTrans
HSS™ Version 2024

Copyright © 2023 University of Florida. All Rights Reserved.

New Ctri+N_»|| | Segment
Open Ctri+0 Intersection/Speed Change Lanes
Example Folder RuraliEacilty
S Urban Facility
= Freeway and Ramp Facility
Save As... — -
Cl
s Help
e ' | Y -~ Topics
Print
/‘ HSS Updates
Print Preview L —d
HSS Overview
View » Ss
Report » H McTrans Website
Parameter Template v HSM/HSS Training
Export to CSV E-mail McTrans
Default Settings At | s e
Help »
Exit Alt+F4
4 HSS2024

4

4

b. Selecting “New File...” from the Start screen; this can be found below in the red box. A Select New
File Type dialog box will pop up after selecting “New File...” which allows you to choose the desired

analysis type.

% Highway Safety Software

Start
Open File...
Example Folder...

Recent

4 HSS2024

UF | Transportation Institute
UNIVERSITY of FLORIDA

Copyright © 2023 University of Florida. All Rights Reserved.

'‘McTrans

\

= [m] X

Help

Topics

HSS Updates

HSS Overview
McTrans Website
HSM/HSS Training
E-mail McTrans

About HSS

HSS™ Version 2024

c. Using the keyboard shortcut “Ctrl+N”, selecting one of the analysis types from the Select New File
Type dialog box, and clicking “OK”

% Select Analysis Type

® Segment

) Intersection/Speed
O Rural Facility

O Urban Facility

O Freeway and Ramp Facility

X

Change Lanes

CK
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2. Once a new file is created, you will be brought to the General page of the selected anaIyS|s type

4 HSS1.xhz* - Highway Safety Software

=  START GENERAL DETAILS REPORT

Project Description

Analyst Jurisdiction

Agency Analysis Year 2023
Date 9/27/2023 Project Description

Empirical Bayes Analysis O Number of Years of Observed Crashes 1

Facility Data
New Section Facility Type | Rural Two-Lane ~| New Section Type | Segment “

Section Type Facility Type Name Model Type AADT, veh/day Length, mi Details Nispf) N(predicted)

1 Segment lRuraI Two-Lane [ [Fwo-Lane Undivided Segment (2u) [ 1000 |1.000 lpe:aw‘s |o267 |0267
Z=E\ The total number of predicted crashes is: 0.267 /N
(&) (=)
\& 5/ Parameters \_ )
Back | project-Level Parameters O Next

Copyright © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024 (USC)

Open an Existing File

From the Start screen, there are six options for opening an existing file:

% Highway Safety Software = [m] X

Start }/ Help
e
A

New File... £— Topics

Open File... HSS HSS Updates
Example Folder... HSS Overview
Recent McTrans Website

HSM/HSS Trainin

E-mail McTrans

HSS2024 FhoutEss
Transportation lnstitute’ M 7_
UF UNIVERSITY of FLORIDA c rans
D
Copyright © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024

Note: A file can be opened even if another file is currently open; you do not need to start from the Start
screen.
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a. Selecting File > Open from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Open”

% Highway Safety Software - a8 X

New Ctrl+N »
[ Open c+o |
Example Folder
Save
Save As...
Cl Ctrl+W
s Help
t .
i s 4 -~ Topics
. o ‘ HSS Updat
HSS Updates
Print Preview Ctrl+F2 //— ates
HSS Overview
View »
Report » H SS McTrans Website
Parameter Template » HSM/HSS Training
Export to CSV/ E-mail McTrans
Default Settings Alt+F About HSS
Help 4
Exit Alt+F4
4 HSS2024

| Transportation Institute M 7_ /
UF.levmsmra/(-wmm ‘ C rans y
Copyright © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024

b. Selecting “Open File...” from the Start screen; this can be found below in the red box
% Highway Safety Software - a X

Start }/. Help
: A

New File... : = Topics

[Open File... | HSS HSS Updates
Example Folder... HSS Overview
Recent McTrans Website

HSM/HSS Training

E-mail McTrans

About HSS
4 HSS2024 .
UF [ | MCTrans

Copyright © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024

|

c. Using the keyboard shortcut “Ctrl+O”
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box

% Highway Safety Software

d. Selecting a file under the Recent files list from the Start screen; this can be found below in the red

= =} X

Start Help
New File... y -~ Topics
Open File.. /‘ HSS Updates
Example Folder... HSS Overview
Recent H SS McTrans Website
HSS10-1 RuralTwolan... HSM/HSS Training
HSS11-1 RuralMultila... E-mail McTrans
HSS12-1 UrbanThreel... About HSS
HSS18-1 TangentSixL...
HSS19-1 OnelaneUrb...

4 HSS2024

‘Transportation Institute M T—
UF‘DMVER&IIYO]H()NIM cirans
Copyright © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024 (USC)

e. Selecting File > Example Folder from the main menu; this can be found by selecting the three lines
in the top left-hand corner of the screen and then selecting “Example Folder”. Opening the example
folder will open the path of the HSS exampile files in File Explorer. The desired example file can be
double-clicked or right-clicked and selecting ‘Open’, which will open the example file in the Highway
Safety Software program.

% Highway Safety Software - X
New Ctrl+N »
Open Ctrl+O

[ Example Folder |
Save
Save As.
cl

— Help
J »
Units / > Toni
Print 2 ‘
Print Preview //_._ HSS Updates
— )
View » HSS Overview
Report » H SS McTrans Website
Parameter Template » HSM/HSS Training
Export to CSV E-mail McTrans
Default Settings Alt+F About HSS
Help »
Exit Alt+F4
4 HSS2024

Transportation Institute M 1_
UF evienamoun: | MCTrans
Copyright © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024

f. Selecting “Example Folder...” from the Start screen; this can be found below in the red box.
Opening the example folder will open the path of the HSS example files in File Explorer. The desired
example file can be double-clicked or right-clicked and selecting ‘Open’, which will open the
example file in the Highway Safety Software program.
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% Highway Safety Software = (m] X

Start }4 Help
e
A

New File... — Topics

Open File... HSS HSS Updates
Example Folder... HSS Overview
Recent McTrans Website

HSM/HSS Trainin

E-mail McTrans

About HSS
4 HSS2024
Transportation Institut
UF | vt omouns | MICTFGNS
p

2. Once an existing file is opened, you will be brought to the General page
% HSS12-9_UrbanFacilityWithCrashData.xhz - Highway Safety Software - X
= START GENERAL DETAILS REPORT o

Project Description

Analyst Jurisdiction
Agency Analysis Year 2023
Date 9/26/2023 Project Description HSM Chapter 12: Sample Problem 9
Empirical Bayes Analysis Number of Years of Observed Crashes 1
Facility Data
Add Section New Section Type | Segment -
| sectionType Facility Type Name Model Type AADT, veh/day  Length, mi Details Observed Crashe N(spf) N(predicted) N(expected)
|1 Segment Urban [Three-Lane Segment Including a Cer| 11000 1.500 Details 13 4274 7043 10759
~ |2 Segment Urban Four-Lane Divided Segment (4D) | 23000 0750 Details 10 3509 3430 6733 =
(&) |3intersection Urban [Three-leg, Minor-Stop (35T) L Details 5 2241 1557 2454 ( = \
\_/ |4 Intersection Urban Four-leg, Signal (45G) L Details 3 4.324 2.855 4091 \/
Back — Next
The total number of predicted crashesis: 14.886
Parameters
Project-Level Parameters
(2) Segment Common Parameters
(¥ Urban
() Intersection Common Parameters
(¥ Urban

Copyright © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024 (USC)

3. Note: HSS can open both HSS files (*.xhz) and HCS Freeways/Highways (*.xuf) files. By default, the Open
dialog will display HSS files (*.xhz). To open Freeways/Highways (*.xuf), please change the file type in the
Open dialog. If opening a Freeways/Highways file, HSS will convert any relevant Freeways/Highways inputs
to the corresponding HSS inputs. It is recommended to review inputs for accuracy.
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& Open X

& L « HCS » Example » v 0 D Search Example
Organize Mew folder ~ [N 0
MName Date modified L7 e
# Quick access
Alternative Intersections 7/28/2022 3:08 PM Fili
&% Dropbox (UFL) HsS Fill
@ OneDrive - University Streets Reliability Fili
f Basicl-FourLaneFreeway.xuf AU
&3 ThisPC f* Basic2-TargetLOSxuf (i)
& Network f Basic2-TargetLO5-Designaxuf xu
) f Basic3a-SixLaneFreewaysPresent.xuf XU
§ Basic3b-SixLaneFreewayFuturexuf xu
f° Basic3-MixedFlow.xuf XU
f Basich-SevereWeatherxuf XU
§ Basic7a-ManagedLanelxuf XU
# DacicTh-Mananerl ansd vif 12/1/7071 372 DAA wi| ¥
< - >
File name: | v| | HCS Freeways/Highways Files (*.xuf) h

HS5 Files (*xhz)

HCS Freeways/Highways Files (

Save a File

1. There are five options for saving an open file:

a. Selecting File > Save from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Save”

4 HSS1.xha" - Highway Safety Software - X
New Ctr+N » Project Description
Dem L) Jurisdiction
Example Folder
= e Analysis Year 2023
Save As... Fi2 9/27/2023 Project Description
Close Ctrl+W O Number of Years of Observed Crashes
ot ' Facility Data
S o New Section Facilty Type |Rural Two-Lane ~| New Section Type |Segment ~
View » Name Model Type AADT, veh/day Length, mi Details Nispf) Npredicted) |
e s e | ITwc~Lane Undivided Segment (2U) | 1000 ]1.000 |0,267 |o,ze7
Parareter Template g The total number of predicted crashes is : 0.267
Export to CSV Parameters
Default Settings Alt+F O
Help >
Exit Alt+F4

Copyright © 2023 University of Florida. All Rights Reserved HSS™ Version 2024 (USC)
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b. Selecting File > Save As... from the main menu; this can be found by selecting the three lines in
the top left-hand corner of the screen and then selecting “Save As...”

% HSS1.xhz" - Highway Safety Software = X
= START GENERAL DETAILS REPORT

New Ctri+N » Project Description
Uren 0 Jurisdiction
Example Folder
v S Analysis Year 2023
v Ctri+S
[ savehs. F12 9/27/2023 Project Description
Close Ctrl+W O Number of Years of Observed Crashes
Lt ' Facility Data
Print Ctrl+P
Print Preview Ctri+F New Section Facility Type | Rural Two-Lane v| New Section Type |Segment v
View » Name Mode! Type AADT, veh/day Length, mi Details Nispf) N(predicted) |
Tenor , e | iT\\‘crLane Undivided Segment (2U) | 1000 1,000 |Detaits o267 |0267
Parameter Template v The total number of predicted crashes is: 0.267 -
>
Export to CSV Parameters 4
Default Settings Alt+F O
Help »
Exit Alt+F4
Copyright © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024 (USC)

c. Using the keyboard shortcut “Ctrl+S” for Save
d. Using the keyboard shortcut “F12” for Save As

e. Exiting the program or closing the file without saving changes beforehand; this will prompt you to
save changes to the file before anything is closed

Highway Safety Software X

'.‘OJ' Save changes to HSS1.xhz?

Yes No Cancel

i. Selecting “Yes” will save the file if it is an existing file. If the file has not been previously
saved, the Save As dialog box will pop up allowing you to change the file name and save
it.

ii. Selecting “No” will exit the program or close the file without saving the file
iii. Selecting “Cancel” will prevent the file from closing

Note: Using Save with an existing file will save a file without prompting you to specify a file name. Using Save with
a new file will bring up the Save As dialog box for you to specify a file name for saving. Using Save As will always
bring up the Save As dialog box for you to specify a file name for saving.
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Close a File

1. There are three options for closing an open file:

a. Selecting File > Close from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Close”

4 HSS12-9_UrbanFacilityWithCrashData.xhz - Highway Safety Software - X
=  START GENERAL DETAILS REPORT (i ]
New Ctri+N » Project Description
Open Ctrl+O Jurisdiction
Example Folder
Analysis Year 2023

Save
Save As... 9/26/2023 Project Description HSM Chapter 12: Sample Problem 9
Close cul+w_| Number of Years of Observed Crashes 1
Uit " Facility Data
i sl New SecionType [
Print Preview Crriepp  MaEa e (Seaimient Deete Secticn
View » | Name Model Type AADT, veh/day  Length, mi Details Observed Crashe N(spf) Nipredicted)  N(expected)
o R [Three-Lane Segment Including a Cer] 11000 1500 Details 13 4274 7083 10759

2 Four-Lane Divided Segment (4D) | 23000 0750 Details 10 3500 3430 6733 .
Parameter Template % Three-leg, Minor-Stop (35T) - Details 5 2241 1557 2454 (>)
Export to CSV Four-leg, Signal (45G) - Details 6 1324 2855 2091 N

Alt+ xt

Default Settmgs AlzF The total number of predicted crashes is: 14.886
Help 4 Parameters
Exit Alt+F4

(2) Segment Common Parameters

(® urban
() Intersection Common Parameters
(¥ urban

Copyright © 2023 University of Florida. All Rights Reserved HSS™ Version 2024 (USC)

b. Using the keyboard shortcut “Ctrl+W”

c. Exiting the program itself; please see How To: Exit the Program

Exit the Program

1. From the Start screen, there are three options for exiting the program:

% Highway Safety Software - m} X

Start }4 Help
e
A

New File... rg— Topics

Open File... HSS HSS Updates
Example Folder... HSS Overview
Recent McTrans Website

HSM/HSS Training

E-mail McTrans

About HSS
4 HSS2024
Transportation Institute 7__
UF L'Nl\’szSl‘l’Yln/FL(;R:l;A ‘Mc rans
p

Note: The program can be exited even if a file is still open; you do not need to start from the Start screen.
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a. Selecting File > Exit from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Exit”

% Highway Safety Software - 8 X
New Ctrl+N »
Open
Example Folder
Save
Save As...
Cl +W
e Help
t: > .
Units y y - Topics
prne o ‘ HSS Updat
pdates
Print Preview Ctrl+F2 //—
View » HSS Overview
Report > H SS McTrans Website
Parameter Template » HSM/HSS Trainin
Export to CSV E-mail McTrans
Default Settings Alt+F About HSS
Help 4
Exit Alt+F4

& HSS2024
T rtation Institut 7_ /
UF.‘USF\'?:SUYT/"FLZ:(:J&‘ Mc rans

b. Using the keyboard shortcut “Alt+F4”

c. Selecting “X” in the top right-hand corner of the screen; this can be found below in the red box
% Highway Safety Software — [m] X

Start }/ Help
A

New File... ) Y — Topics

Open File... HSS HSS Updates
Example Folder... HSS Overview
Recent McTrans Website

HSM/HSS Trainin

E-mail McTrans

About HSS
4 HSS2024 e
T tati Institut
UF [Cevrememoa: | MICTFANS
P>
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Edit the Default Settings

1. From the Start screen, there are two options for editing the Default Settings:

% Highway Safety Software . [m] X

Start }/ Help
e
74

New File... — Topics

Open File... HSS HSS Updates
Example Folder... HSS Overview
Recent McTrans Website

HSM/HSS Trainin

E-mail McTrans
4 HSS2024 e
UF | ienamoun | MCTF@NS
Copyright © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024

Note: The Default Settings can be changed even if an existing file is already open; you do not need to start
from the Start screen.

|

a. Selecting File > Default Settings from the main menu; this can be found by selecting the three lines
in the top left-hand corner of the screen and then selecting “Default Settings”

% Highway Safety Software - 8 X
New Ctri+N »
Open Ctri+0

Example Folder

Save
Save As..

Close W Help
Units » :

< = Topics
Print Ctrl+ /‘

HSS Updates

Print Preview l—d
Vi HSS Overview
iew » HSS
Report » McTrans Website
Parameter Template » HSM/HSS Training
Bpoit wiCV E-mail McTrans
Default Settings Alt+F About HSS
Help »
Exit Alt+F4
& HSS2024
Transportation Institute 7——— /
UNIVERSITY of FLORIDA ‘ MC rans

Copyright © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024

b. Using the keyboard shortcut “Alt+F4”
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2. Opening the Default Settings will cause a Default Settings window to pop up:

% Default Settings X

Analyst
Agency
Jurisdiction

Default Template

Reports
[] Show Economic Results in Reports

Units
®) USC U Metric

o M cne

3. You can specify Analyst, Agency, and Jurisdiction by clicking in the corresponding text boxes and typing
the desired text.

4. You are also given the option to specify a default parameters template. You can either click the ‘Default
Template’ button which will allow you to browse through files in an Open dialog box and select an HSS
Template File (*.xhzt) or you can type out the path of the file in the provided text box. Selecting a file through
the dialog box will automatically fill out the text box with the path of the file. For more information on the
Default Template, please see How To: Change Parameters.

5. Under ‘Units’, you are given the option of running the analysis in either U.S. Customary (USC) or SI (Metric)
units.

6. Clicking “OK” will save the changes made and close the Default Settings window; clicking “Cancel” will
close the Default Settings window without saving any changes.

7. When a new file is created, the Analyst, Agency, and Jurisdiction fields will automatically be populated with
the text specified in the Default Settings.

8. When a new file is created or an existing file is opened, the parameters from the default template selected
will be applied to the analysis.

9. When starting a new file, the inputs and results will display according to the units specified in the Default
Settings

Change Parameters

1. Parameters within HSS can be changed by editing individual fields or with the use of a Parameters
Template.

2. Individual Fields

a. To edit individual fields, you can access parameters either on the General page with Project-Level
Parameters or the Details page with Section-Level Parameters.

i. Project-Level Parameters

1. On the General page, there is a ‘Project-Level Parameters’ checkbox. Checking
this box will add the parameters to the General page where you can edit any of the
enabled fields. Note: Parameter fields are enabled/disabled depending on the
analysis type.
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% HSS18-5 FreewayFacilityxhz - Highway Safety Software
= START GENERAL DETAILS REPORT

Freewy -

Facility Data

New Section Type | Freeway Segment

| Delete Section |

Section Type Facility Type Name Model Type AADT, veh/day  Length, mi Details Observed Crashe N(spf) N(predicted) N(expected)
1 Freeway Segment [Freeway | [Freeway Segment 120000 o750 [petais 0 5 20824 19916 |
2 Fresway Segment|[Feswy | [Freevay Segment [z [ors0 [petais I 5 22002 [z70s |
The total number of predicted crashes is: 44.646
Parameters
Project-Level Parameters |
(%) segment Common Parameters
() Freeway Segment
(& \, Calibration Factor for Multiple-Vehicle Fatal-and-Injury Crashes, Cmv.fi 1.00 ( ;) )
Back Calibration Factor for Multiple-Vehicle Property-Damage-Only Crashes, Cmv,pdo 1.00 Nod
Calibration Factor for Single-Vehicle Fatal-and-Injury Crashes, Csv.fi 1.00
Calibration Factor for Single-Vehicle Property-Damage-Only Crashes, Csv.pdo 1.00
(©) Ramp Segment.
(3) Intersection Common Perameters
() Speed Change Lanes
Calibration Factor for Fatal-and-Injury Crashes, Cfi 1.00
Calibration Factor for Property-Damage-Only Crashes, Cpdo 1.00
(¥) Ramp Terminal

2. Corresponding parameters are applied to all the sections within the facility.

3. The Parameters section on the Details page is hidden when ‘Project-Level
Parameters’ is checked.

ii. Section-Level Parameters

1. On the Details page, there is a Parameters section. This section is only available
when ‘Project-Level Parameters’ on the General page is unchecked. If it is
checked, then the Parameters section on the Details page will be hidden.

& HSSIES FreenayFsciltyanst

Highaay Sty Softunre

- a2 %

= START GENERAL DETAILS REPORT

Anaiyst

Agoncy

Empirical Bayes Analysis

Area Type

(Coppioht © 2023 Univessiy of Forda. A Rihts Reseeved.

850 Distance from Segment to Downstrear 0850
AADT Volume of Entrance Ramp 3t Xi.ent (ASDTo.ent) veh/day /2000 ARDT Volum Ramp at Xbea 7675
AADT Volume of Entrance Ramp 3t Xe.ent (AADTe ent) veh/csy GEY AADT Volume of Exit Ram at Xe ext (AADTe ext, veh/day 7150
T
Casibration Factor for Multiple-Vehicle Fatal-and-Injury Crashes. Cmvfi 100
vpdo 100
100
Calbration Factor for Single-Vehicie Property-Damage-Only Crashes. Csv.od0 100
arved Crashe:
Muhiple Venicle Fatal/Injury 10 Muliple Vehicle Property Damage Only 1
Single Venicle Fatalinjury a Single Vehicie Property Damage Only 2

2. The parameters available in the Parameters section is dependent on the Facility
Type, Section Type, and Model Type of the current section displayed. Note: You
can switch between sections by selecting a different section using the Section drop
down menu on the Details page.

3. Parameters Template

a. Default Template in Default Settings
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To specify a default parameters template to use, a valid path must be provided in the
Default Template textbox within the Default Settings. This can be done by either selecting
the HSS Template File (*.xhzt) or typing out the path of the file in the textbox.

1.

To select the template file, click the ‘Default Template’ button. An Open dialog box
will pop up allowing you to browse through files and select a template. Once
selected and opened, the Default Template textbox will automatically populate with

the path of the selected file.

% Default Settings

&% Dropbox (Personal)
&+ Dropbox (UFL)
@ OneDrive

% This PC

W Network

<

Analyst

Agency

Jurisdiction

Reports

[[] Show Economic Results in Reports

Units

® usC O Metric
o |
% Open X
« v 1 > ThisPC > Desktop > HSS v O Search HSS
Organize ¥ New folder - @ @
Name a Date modified Type Size
> Quick access
| Template1.xhzt 12/3/2021 10:08 AM XHZT File 97

File name: | Template1.xhzt

v |HSS Template Files (xhzt) v

4 Default Settings

Analyst
Agency
Jurisdiction
\HSS\Template1.xhzt
Reports
[[] Show Economic Results in Reports
Units
® ysC O Metric
o |
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2. When typing out the path itself, the full path must be specified, and it must be valid.
An example of a parameters template file path would be
C:\Users\UserName\Desktop\FileName.xhzt.

Once a default template file is specified in the Default Settings, the parameters within that
template will apply to all new files or to any changes made in existing files (e.g., adding
new sections).

b. View/Edit Template

To view or edit the parameters template, select File > Parameter Template > View/Edit
Template from the main menu; this can be found by selecting the three lines in the top left-
hand corner of the screen, hovering over “Parameter Template”, and then selecting
“View/Edit Template”.

% HSS1.xhz" - Highway Safety Software = X
=  START GENERAL DETAILS REPORT i)
New Ctri+N » Project Description
Open Ctri+0 Jurisdiction
Example Folder
Analysis Year 2023
Save
Save As... 9/27/2023 Project Description
Close Ctrl+W O Number of Years of Observed Crashes 1
pais 2 Facility Data
Print Ctri+P

New Section Facility Type | Rural Two-Lane | New Section Type |Segment ~

Print Preview Ctrl+F2

View » Name Model Type AADT, veh/day Length, mi Details Nispf) N(predicted) |
Report ) Ine | [Two-Lane Undivided Segment 2u) | 1000 1.000 Details |o267 |0267

[ Parameter Template v [ | View/Edit Template The total number of predicted crashes is: 0.267 3)
Export to CSV Export Template Parameters ]

Default Settings Alt+F Import Template

Help »

Exit Alt+F4

Copyright © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024 (USC)

When viewing or editing the parameters template, you are taken to the General page where
all existing parameters for all facility types, model types, and section types become
available to view and edit.

4 HSS1xhz" - Highway Safety Software = a X
GENERAL

Parameters
Project-Level Parameters O

() Segment Comman Parameters
(®) Rural Two-Lane

Calibration Factor, C 1.00
Proportion of Related Crashes, Pra 0574
Proportion of Nighttime Crashes that Involve a Fatality or Injury, Pinr ~ [0.382

Proportion of Nighttime Crashes that Involve Property Damage, Ppnr ~ [0.618

Proportion of Crashes that Occur at Night Pnr 0370
. Proportion of Fatal 0013
(¢ roportion of Fata >)
Proportion of Incapacitating Injury 0054
Proportion of Nonincapacitating Injury 0.109
Proportion of Possible Injury 0.145
Collision Type Total Fl PDO

Single-Vehicle Crashes

Collision with Animal 0.121 0.038 0.184
Collision with Bicycle 0.002 0.004 0.001
Collision with Pedestrian 0.003 0.007 0.001
Overturned n02s n037 nnis

Copyright © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024 (USC)

Other pages become disabled, and you can no longer navigate to other pages to make
edits to inputs. Viewing or editing of the parameters template must be completed before
editing other inputs.
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iv. To finish viewing or editing the parameters template, select File > Parameter Template >
To Normal Mode from the main menu; this can be found by selecting the three lines in the
top left-hand corner of the screen, hovering over “Parameter Template”, and then selecting
“To Normal Mode”. Note: This option only becomes available when in the middle of viewing

or editing the parameters te

% HSS1xhz® - Highway Safety Software

Ctri+N »

New
Open
Example Folder

mplate.

Project Description

Jurisdiction

Default Settings Import Template

Help »

Exit Alt+F4
Calibration Factor, C

Proportion of Related Crashes, Pra

Proportion of Nighttime Crashes that Involve a Fatality or Injury, Pinr

Proportion of Nighttime Crashes that Involve Property Damage, Ppnr

Proportion of Crashes that Occur at Night, Pnr

Proportion of Fatal

1.00

0.574

0.382

0.618

0.370

0.013

. Analysis Year 2023
ave
Save As... 9/27/2023 Project Description
Close O Number of Years of Observed Crashes
e Facility Data
Print r »
L . New Secton Fcity Type | RuralTwo-Lane +| New Section Type | Segment
View » Name Model Type AADT, veh/day Length, mi Details Nispf) Npredicted)
Renor | e [Two-Lane Undivided Segment (2u) 1000 |1.000 |petails |o267 |0267
[ Parameter Template »|[__[To Normal Mode | The total number of priil N
(=>)
Export to CSV Export Template Parameters &7

Copyright © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024 (USC)

c. Export Template

i. Editing the parameters template is necessary before exporting if you want to export
parameters other than the default HSM/HSS parameters.

ii. To export the parameters into a template, select File > Parameter Template > Export
Template from the main menu; this can be found by selecting the three lines in the top left-
hand corner of the screen, hovering over “Parameter Template”, and then selecting “Export

Template”.

% HSS1xhz" - Highway Safety Software

- =] X

= | START GENERAL DETAILS REPORT [4

New Ctri+N » Project Description
Open Jurisdiction
Example Folder
= Analysis Year 2023
ave
Save As... 9/27/2023 Project Description
Close Ctrl+W O Number of Years of Observed Crashes
ML ki Facility Data
Print
e s New Section Facility Type | Rural Two-Lane ~| New Section Type | Segment -
View » Neme Model Type AADT, veh/day Length, mi Details Nespf) Npredicted)
o vhe | |Four-teg. Minor-stop (4sT) - [ 0817 0817
= I 1= e Undivided Segment (2U) 1000 1.000 0267 0267
Parameter Template » View/Edit Template 5 Sl G56) - e s
Export to CSV [ [Export Template [ne Undivided Segment (2U) 1000 1.000 0267 0267
Default Settings Alt+F jmportiiemplate leg, Minor-Stop (35T) - 0361 0361
» Ine [Two-Lane Undivided Segment (2U) 1000 1000 0267 0267
Help 9
T [Three-leg, Signal (356) - 0571 0571
S e worcane [Two-Lane Undivided Segment (2U) 1000 1000 0267 0267
9 Intersection Rural Two-Lane [Roundabout (R) - 0848 0729
The total number of predicted crashesis: 5.034
Parameters
Project-Level Parameters O

Copyright © 2023 University of Florida. Al Rights Reserved. HSS™ Version 2024 (USC)
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ii. This will open a Save As dialog box allowing you to specify a name for saving the template

file (*.xhzt).
& SaveAs X
4+ > ThisPC > Desktop > HSS v O Search HSS
Organize ¥ New folder = 0

Name Date modified Type Size
# Quick access

3/2021 10:08 AM XHZT File

Template1.xhzt
& Dropbox (Personal)

&% Dropbox (UFL)
@ OneDrive
= This PC

@ Network

<

File name: | HSS1.xhzt

Save as type: 'HSS Template Files (*.xhzt)

~ Hide Folders Cancel

iv. Once a file name is specified, click the Save button. Note: The default template file name
is the name of the HSS file with the template file extension (*.xhzt) but can be overwritten.

v. The template file will be saved in the folder you specified when saving.

% = | HSS = o X
- °
« v 4 > ThisPC > Desktop > HSS v O S: HS!
Name ) Date modified Type size
s Quick access
HSS1.xhzt

& Dropbox (Personal) Template1.xhzt
33 Dropbox (UFL)
@ OneDrive

% This PC

&b Network

2items  1item selected 96.6 KB

d. Import Template
i. Importing a parameters template file requires access to an already saved template file
(*.xhzt).
ii. To import parameters from a template, select File > Parameter Template > Import

Template from the main menu; this can be found by selecting the three lines in the top left-
hand corner of the screen, hovering over “Parameter Template”, and then selecting “Import

Template”.
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4 HSS1xhz* - Highway Safety Software

= X

= START GENERAL DETAILS REPORT

Next

New Ctri+N > Project Description
Open Ctr+0 Jurisdiction
Example Folder
= Analysis Year 2023
Save Ctri+S
Save As... F12 9/27/2023 Project Description
Close Crl+W [m] Number of Years of Observed Crashes 1
nits L Facility Data
Print Ctri+P )
e i New Section Facility Type | Rural Two-Lane ~| New Section Type |Segment ~
View » Name Mode! Type AADT, veh/day Length, mi Details Nispf) Nipredicted)
Report vie | [Four-teg, Minor-Stop 5T - et 0817 0817
T = T=— ne Undivided Segment (20) 1000 1.000 0267 0267
Parameter Template »‘ View/Edit Template Ig. Signal (@56) - 1486 1486
Export to CSV /_,%‘ ne Undivided Segment (2U) 1000 1,000 0267 0267
Default Settings Alt+F Import Template lleg, Minor-Stop (35T) 0361 0361
Help » lne [Two-Lane Undivided Segment (2U) 1000 1000 0267 0267
Three-l; 1] .571 1
= T ree-leg, Signal (35G) 05 057
TsegmEe——————[nrer e [Two-Lane Undivided Segment (2U) 1000 1000 0267 0267
|9 Intersection Rural Two-Lane [Roundabout (R) 0843 0729
The total number of predicted crashes is: 5.034
Parameters
Project-Level Parameters [m]

Copyright © 2023 University of Florida. Al Rights Reserved. HSS™ Version 2024 (USC)

This will open an Open dialog box allowing you to select a template file (*.xhzt).

& Open X
1T > ThisPC > Desktop > HSS v O O Search HSS
Organize ~ New folder m @
Name Date modified Size
# Quick access
|| HSS1.xhzt 12/3/2021 2:07 PM 97
& Dropbox (Personal)
& Drop || Templatel.xhzt 12/3/2021 10:08 AM 97
&% Dropbox (UFL)
@ OneDrive
% This PC
W) Network
< >
File name: 6 | HSS Template Files (*xhzt) v
Once a file name is selected, click the Open button.
& Open X
1 > ThisPC > Desktop > HSS v O O Search HSS
Organize ¥ New folder = @M @
Name Date modified Type Size
s Quick access )
|_] HSS1.xhzt 12/3/2021 2:07 PM XHZT File 97
*e
& Dropbox (Personal) [] Template1.xhzt 12/3/2021 10:08 AM XHZT File 97
23 Dropbox (UFL)
@ OneDrive
% This PC
W Network
< >
File name: | Template1.xhzt v | |HSS Template Files (*xhzt) v
Cancel
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v. The template file will be imported, and a message will pop up saying if the template was
imported successfully.

X

Template is imported successfully.

vi. The ‘Project-Level Parameters’ checkbox on the General page should now be checked, if
it was not already, and the parameters from the imported template file should be reflected
in the project-level parameters.

Export to CSV

1. To export data to a CSV file, select File > Export to CSV from the main menu; this can be found by selecting
the three lines in the top left-hand corner of the screen, and then selecting “Export to CSV”.

% HSS1.xhz* - Highway Safety Software - =] X

= START GENERAL DETAILS REPORT )

New Project Description
Open Ctrl+O Jurisdiction
Example Folder
Sare Analysis Year 2023
Save As... 9/27/2023 Project Description
Close O Number of Years of Observed Crashes
Units ' Facility Data
Print Ctrl+P
Print Preview Ctrl+E2 New Section Facility Type | Rural Multilane | New Section Type |Segment
View e Name Model Type AADT, veh/day Length, mi Details Nispf) Npredicted)
Report , fane Four-leg, All-way Stop (425T) Details 0314 0314
ane [Two-Lane Undivided Segment (2U) 1000 1.000 0.267 0.267
Parameter Template 4 Jane Three-leg, Minor-Stop (35T) = Details 0361 0361
| Exportto CSV ] Two-Lane Undivided Segment (2U) 1000 1,000 E 0267 0267
Default Settings Alt+F ane Three-leg, Signal (35G) - Details 0571 0571
Help » lene Two-Lane Undivided Segment (2U) 1000 1.000 0.267 0267
Exit Alt+F4 ane Three-leg, All-way Stop (3aST) 0370 0370
& segmenc narar reomiane [Twwo-Lane Undivided Segment (2U) 1000 1.000 0267 0.267
9 Intersection Rural Two-Lane Roundabout (R) 0848 0729
10 Segment Rural Multilane Divided 1000 1.000 0.169 0.169
11 Intersection Rural Multilane Four-leg, Minor-Stop (45T) - 0343 0343
12 Segment Rural Multilane Divided 1000 1.000 0.169 0.169
13 Intersection Rural Multilane Four-leg, Signal (45G) 1.143 1143
14 Segment Rural Multilane Undivided 1000 1.000 0217 0217
15 Intersection Rural Multilane [Three-leg, Minor-Stop (35T) - 0076 0076
16 Segment Rural Multilane Undivided 1000 1.000 0217 0217
17 Intersection Rural Multilane Three-leg, Signal (35G) - Details 0579 0579
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2. When an analysis is exported to a CSV file, a Save As dialog box will pop up allowing you to specify a name
for saving the HCS CSV file (*.csv). Note: The default CSV file name is the name of the HSS file (*.xhz)
along with “-Results.csv” but can be overwritten.

40 - How To Highway Safety Software User Guide



A SaveAs
&« v A > ThisPC > Downloads > HSS v o O Search HSS
Organize v New folder S o
Name Date modified Type
> Quick access
No items match your search.
;: Dropbox (UFL)
@ OneDrive - University
3 This PC
¥ Network
< >
File name: | RuralWithRbt-Results.csv v
Save as type: | CSVfile (*.csv) v
A Hide Folders Cancel
3. Once afile name is specified, click the Save button.
A Savehs x
“ v » ThisPC » Downloads » HSS w [&] O Search H5S
Organize » New folder b (7]
Name Date modified Type
3 Quick access
= Mo items match your search,
&# Dropbox (UFL)
@ OneDrive - University
3 This PC
£F Network
£ >
File name: | RuralWithRbt-Results.csv 8P
Save as type: .. CSV file (*.csv) "’..
~ Hide Folders Cancel

4. The CSV file of the analysis results will be saved in the folder you specified when saving.

B @ = 1Hss - o X
m Home  Share  View (2]
« « 4 > ThisPC > Downloads > HSS v o Search HsS

Name - Date modified Type Size

»# Quick access
£ RuralWithRbt-Results.csv 8/23/2022 8:56 AM Microsoft Excel C... 2k8

82 Dropbox (UFL)

@ OneDrive - University

[ This PC

@ Network

Titem  1item selected 1.02K8 H =
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5.

If you open the exported CSV file, the default program for CSV files will open.

@ AuvtoSeve @ OFF) RuralWithRbt-Results.csv ~ £ Search (Alt+0) Vo a X
File Home Insert  Page Layout Formulas Data Review View Help 7 Comments
9. fli X e A A . n General ~ | [ Conditional Formatting~ | BH Insert ~ v Ay~ @ @
= i ™~ . % By ok $ ~ % 9 [FHFormatasTable~ BT Delete ~ - O~ Kot Nyl
L A - <0 50 [BZ Cell Styles~ [ Format~ | & Data NVivo
Undo  Clipboard 1S Font 5 Alighment 5 Number Styles Cells Editing Analysis  Sensitivity  Nvivo e
Al ~ fx| section ~
A B c E F G H J K L M N s} P a 5 T ua
1 |se IsPFFI SPFPDO CMF ComiP Predicted Predicted Predicted Total Predicted
2 1 008 0181 1 008 0003 0014 0029 0039 0181 0267
3 2 0352 0465 1 0352 0015 0035 0132 017 0465  0.817
4| 3 0086 0181 1 0086 0003 0014 0029 0039 0181  0.267
5 4 0505 0981 1 0505 0.013 0031 0I5 0305 0981 1486
6 5 008 0181 1 008 0003 0014 0029 0039 0181 0267
7| 6 015  0.211 1 015 0006  0.014 0.06 0069 0211 0361
8 7 0086 0181 1 0086 0003 0014 0029 0039 0181  0.267
9 g 0132  0.716- 0.132 - : 0716  0.848
10| 9 0109 0.06 1 0109- - 0.06  0.169
11 10 0166  0.182 1 0.166- - 0182  0.348
12 11 0109 0.06 1 0109- = 0.06  0.169
13| 12 0.682 0461 1 0.682- - 0461  1.143
14 13 0157 0.06 1 0157- - 0.06 0217
15 14 0.043 0.033 1 0.043- : 0032 0.076
16 15 0157 0.06 1 0157- - 0.06  0.217
17 16 0132  0.716- 0.132 - - 0716  0.848
12
19|
20
21
22 v
RuralWithRbt-Results (O] 4 >
Ready %% Accessibility: Unavailable il B -—a—+t 100%

from each analysis type.

Results from the HSS file (*.xhz) will be displayed in the CSV file. HSS currently only exports select outputs

Run an Empirical Bayes Analysis

1. Empirical Bayes Analysis, or EB Analysis, is a method used to combine observed crash frequency data for
a given site with predicted crash frequency data from many similar sites to estimate its expected crash

frequency.

% HSS12-9_UrbanFacilityWithCrashData.xhz - Highway Safety Software
= START GENERAL DETAILS REPORT

Project Description

23

HSM Chapter 12: Sample Problem 9

Analyst Jurisdiction
Agency Analysis Year 20,
Date 9/26/2023 Project Description
I Empirical Bayes Analysis I Number of Years of Observed Crashes 1
Facility Data

New Section Type | Segment -

Delete Section

To run an EB Analysis, the ‘Empirical Bayes Analysis’ checkbox on the General page must be checked.

= X

Project-Level Parameters

() Segment Common Parameters

() urban

() Intersection Common Parameters

(® urban

Section Type Facility Type Name Model Type AADT, veh/day  Length, mi Details Observed Crashe N(spf) N(predicted) N(expected)
1 Segment Urban Three-Lane Segment Including a Cen| 11000 1.500 Details 13 4274 7.043 10.759
2 Segment Urban Four-Lane Divided Segment (4D) 23000 0.750 Details 10 3.509 3430 6.733
3 Intersection Urban Three-leg, Minor-Stop (35T) Details 5 2241 1557 2454
4 Intersection Urban Four-leg, Signal (45G) - Details 6 4324 2855 4091
The total number of predicted crashesis: 14.886
Parameters
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3. Running an EB analysis will enable new fields:

a.

‘Observed Crashes’ in the table on the General page for facility analyses; Note: Depending on the
analysis type of the dataset, these field may be readable only.

% HSS12-9_UrbanFacilityWithCrashData:xhz - Highway Safety Software
= START GENERAL DETAILS REPORT o

Project Description

Analyst Jurisdiction
Agency Analysis Year 2023
Date 9/26/2023 Project Description HSM Chapter 12: Sample Problem 9
Empirical Bayes Analysis Number of Years of Observed Crashes 1
Facility Data
Add Section New Section Type | Segment ~
SectionType  Facility Type Name Model Type AADT, veh/day  Length, mi Details Observed Crashel| N(spf) Nipredicted)  N(expected)
1 Segment Urban [Three-Lane Segment Including a Cen| 11000 1.500 Details 13 4.274 7043 10759
|2 Segment Urban Four-Lane Divided Segment (4D) 23000 0750 Details 10 3.509 3430 6733 i~
l\e ) |3 Intersection Urban [Three-leg, Minor-Stop (35T) - Details 5 2241 1557 2454 ( %)
~” |4 Intersection Urban Four-leg, Signal (45G) - Details 3 4324 2855 4091 N
Back Next
The total number of predicted crashesis: 14.886
Parameters
Project-Level Parameters

() Segment Common Parameters
() urban

() Intersection Common Parameters

(® urban
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‘N(expected)’ in the table on the General page for facility analyses; Note: These fields are readable
only.

% HSS12-9_UrbanFacilityWithCrashData:xhz - Highway Safety Software
= START GENERAL DETAILS REPORT
Project Description

Analyst Jurisdiction
Agency Analysis Year 2023
Date 9/26/2023 Project Description HSM Chapter 12: Sample Problem 9
Empirical Bayes Analysis Number of Years of Observed Crashes 1
Facility Data
New Secton Type |Segment
SectionType  Facity Type  Name Model Type AADT, veh/day  Length, mi Details Observed Crashe N(spf) Nipredicted) [ N(expected)
1 Segment Urban [Three-Lane Segment Including a Cer| 11000 1500 Details 13 4274 7.043 10759
|2 Segment Urban Four-Lane Divided Segment (4D) | 23000 0750 10 3509 3430 6733 -
( &) |3 Tntersection Urban [Three-leg, Minor-Stop (35T) B 2241 1557 2454 (> )
r—; — | 4 Intersection Urban Four-leg, Signal (45G) 6 4324 2855 4.091 \_/
ack — Next
The total number of predicted crashes is : 14.886
Parameters
Project-Level Parameters

(3) Segment Common Parameters

() urban
() Intersection Common Parameters

() urban
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c. Observed Crashes on the Details page; Note: Depending on the analysis type of the dataset, there

may be an Observed Crashes section with multiple fields.

% HSS512-9_UrbanFacilityWithCrashDataxhz - Highway Safety Software

=  START GENERAL DETAILS REPORT

Input
AADT, veh/day 11000 Length, mi 1.500
Number of Major Commercial Driveways 0 Number of Minor Commercial Driveways 10
Number of Major Industrial/Institutional Driveways 0 Number of Minor Industrial/Institutional Driveways 3
Number of Major Residential Driveways 2 Number of Minor Residential Driveways 15
Number of Other Driveways 0 Parking Type Parallel Parking =
Curb Length of On-Street Parking for Both Sides of Road, mi  |2.00 Road Type C ial or i ional v
Roadside Fixed Objects Fixed-Object Offset, ft 6
- Fixed-Object Density, obj./mi 10 Median Barriers
<<— Lighting Median Width, ft 15
Back  Automated Speed Enforcement ] Posted Speed, mi/h 35 Next
Observed Crashes
Multiple Vehicle Non Driveway 7 Multiple Vehicle Driveway 2
Single Vehicle 4
Output
Safety Performance Function (SPF) 4274 Predicted Crash Frequency (Npredicted) 7.043
CMF1 (On-Street Parking) 1.716 CMF2 (Roadside Fixed Objects) 1.008
CMF3 (Median Width) 1.000 CMF4 (Lighting) 0.934
CMFS5 (Automated Speed Enforcement) 1.000

Copyright © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024 (USC)

4. Running an EB analysis will add new sections and results to the reports:

a. ‘Expected Roadway Section Crashes’ in the formatted report

% HS512-9_UrbanFacilityWithCrashData.xhz - Highway Safety Software
= START GENERAL DETAILS REPORT

# Other Driveways 0 Calibration Factor 1.00
Crash Modification Factors
On-Street Parking - CMF1 1.716 Lighting - CMF4 0.934
Roadside Fixed Objects - CMF2 1.008 Auto. Speed Enforcement - CMFS 1.000
Median Width - CMF3 1.000 Combined CMF 1616
Predicted Roadway Section Crashes
Crash Severity Predicted Crash Frequency Crash Rate (crashes/mi/year)
Fatal and Injury (FI) 1.854 1.236
Property Damage Only (PDO) 5.189 3.460
Total 7.043 4.695
(9 Expected Roadway Section Crashes
fack Crash Severity Expected Crash Frequency Expected Crash Rate (crashes/mi/year)
Fatal and Injury (FI) 2832 1.888
Property Damage Only (PDO) 7.927 5.285
Total 10.759 7473
E ic Analysis (Expected Crashes)
Crash Severity Per Crash Societal Crash Cost Expected Annual Crashes Total Societal Crash Cost
Fatal and Injury (FI) $158,200.00 2832 $448,018.69
Property Damage Only (PDO) $7.400.00 7.927 $58,659.97
Total - 10.759 $506,678.66
@ Switch to Text R Section | 1> v
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b. ‘Expected Crashes’ in the text report

% HS512-9_UrbanFacilityWithCrashData.xhz - Highway Safety Software - 8 X

= START GENERAL DETAILS REPORT

Collision with Animal .001 2.000 ©.001 0.001
Collision with Fixed Object 2.688 8.233 8.963 0.816
Collision with Other Object 9.001 0.000 0.001 9.001
Other Single-Vehicle Collision 8.310 8.105 8.035 8.030
Total Single-Vehicle Crashes 1.000 0.338 1.000 8.847
Multiple-Vehicle

Rear-End Collision 0.845 1.013 8.842 3.187
Head-On Collision 0.034 0.041 0.020 0.076
Angle Collision 8.069 0.083 8.020 8.076
Sideswipe Collision, Same Direction  ©.001 8.001 0.078 9.295
Sideswipe Collision, Opposite Dir. 8.017 2.020 0.020 8.076
Other Multiple-Vehicle Collision 2.034 8.041 8.020 8.076

Total Multiple-Vehicle Crashes 1.000  1.199 1.00  3.785
------------------------------------------------- EXpected Crashes =----=--=============-ssososoosoooooooooooooo
Total Observed Crashes (MV, Non-Driveway) 7 crashes
Total Observed Crashes (MV, Driveway) 2 crashes
Total Observed Crashes (SV) 4 crashes
Average Observed Crashes (MV, Non-Driveway) 7.000 crashes/year
“\ | Average Observed Crashes (M, Driveway) 2.000 crashes/year
Average Observed Crashes (SV) 4.000 crashes/year
Overdispersion Parameter (MV, Non-Driveway), k 0.660
Overdispersion Parameter (MV, Driveway), k 1.100
Overdispersion Parameter (SV), k 1.370
Weighted Adjustment (MV, Non-Driveway), w 8.233
Weighted Adjustment (MV, Driveway), w 0.553
Weighted Adjustment (SV), w 0.381
Expected Crashes (MV, Non-Driveway) 6.530 crashes/year
Expected Crashes (MV, Driveway) 1.301 crashes/year
Expected Crashes (SV) 2.928 crashes/year
Expected Crashes (FI) 2.832 crashes/year
Expected Crashes (PDO) 7.927 crashes/year
Total Expected Crashes 10.759 crashes/year
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ Economic Analysis
**Based on Expected Crash Frequency
Annual Societal Crash Cost (FI) $448,018.69
Annual Societal Crash Cost (PDO) $58,659.97
Total Annual Societal Crash Cost $506,678.66
] Switch to Formatted Report IS0 ARES v o — +
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5. Economic analysis will be based on Expected Crash Frequency instead of Predicted Crash Frequency
when an EB analysis is run. Please see How To: Run an Economic Analysis.

Run an Economic Analysis

1. The Federal Highway Administration (FHWA) has completed research that established a basis for
quantifying, in monetary terms, the human capital crash costs to society of fatalities and injuries from
highway crashes

2. State and local jurisdictions often have accepted societal crash costs by crash severity and collision type.
When available, their locally-developed societal crash cost data are used with procedures in the HSM.

3. Torun the economic analysis, it must first be enabled in the Default Settings. This can be done by checking
‘Show Economic Results in Reports’.
4 Default Settings X

Analyst
Agency
Jurisdiction

Default Template

Reports
Show Economic Results in Reports

Units
® ysc O Metric

o Il Coe
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4. On the General page of an analysis, Economic Analysis Common Parameters are provided. This includes
Societal Crash Costs by Crash Severity.

% HSS11-4_RuralMultilaneFacility.xhz - Highway Safety Software - X
= START GENERAL DETAILS REPORT (]
Date 9/26/20 Project Description HSM Chapter 11: Sample Problem 4
Empirical Bayes Analysis Number of Years of Observed Crashes 1
Facility Data
Add Section New Section Facility Type | Rural Two-Lane ¥| New Section Type | Segment v
SectionType  Facility Type Name Model Type AADT, veh/day  Length, mi Details Observed Crashe N(spf) N(predicted) N(expected)
1 Segment Rural Multilane Divided 10000 1500 Details 4 2835 3308 3.529
2 Segment Rural Multilane Undivided 8000 0.100 Details 2 0.250 0301 0914
3 Intersection Rural Multilane |Three-leg, Minor-Stop (3ST) - Details 3 0928 0927 1.547

The total number of predicted crashesis: 4.536

Parameters
= Project-Level Parameters .
((*/) (® segment Common Parameters Q_y
Back () Rural Two-Lane =

(® Rural Multilane

@ Intersection Common Parameters
(®) Rural Two-Lane
) Rural Multilane

(%) Economic Analysis Common Parameters
Societal Crash Costs by Crash Severity

Fatal/Injury, $ 158200

Property Damage Only, $ 7400
a. Default Values

i. Fatal/lnjury: $158,200

ii. Property Damage Only: $7,400

5. An Economic Analysis in HSS is automatically run. However, you have the option of adjusting the cost of
fatal and injury (FI) crashes and property damage only (PDO) crashes by editing the monetary value in the
corresponding text boxes.

6. On both the formatted and text reports, an Economic Analysis section is provided.

a. Formatted Report

4 HSS11-4_RuralMuttilaneFacility.xhz - Highway Safety Software - X
=  START GENERAL DETAILS REPORT (i ]

Lane Width - CMF1 1.000 Lighting - CMF4 1.000

Shoulder Type/Width - CMF2 1.040 Auto. Speed Enforcement - CMF5 1.000

Median Width - CMF3 1.020

Combined CMF 1.061

Predicted Roadway Section Crashes

Crash Severity Overdispersion Parameter | Nspfrs by Severity | Predicted Crash Frequency | Crash Rate (crashes/mi/year)

Fatal and Injury (FI) 0.123 1.480 1.727 1.151

Property Damage Only (PDO) |- 1.355 1.581 1.054

Total 0.142 2835 3308 2.206

Expected Roadway Section Crashes

Crash Severity Average Observed Weight Expected Crash Frequency | Crash Rate (crashes/mi/year)

Crashes

Fatal and Injury (FI) 4.000 0.825 2125 1417

Property Damage Only (PDO) | 0.000 - 1.404 0.936

Total 4.000 0.680 3.529 2353

E = Analvsis (E e tad Crashes)

Y P
Crash Severity Per Crash Societal Crash Cost Expected Annual Crashes Total Societal Crash Cost

Fatal and Injury (FI) $158,200.00 2.125 $336,175.00

Property Damage Only (PDO) $7,400.00 1.404 $10,389.60

Total - 3.529 $346,564.60

@ Switch to Text Report Section | 1> v - — &
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b. Text Report

% HSS11-4 RuralMuttilaneFacility.xhz - Highway Safety Software - X
START GENERAL DETAILS REPORT

e e e Crashes by Severity Level and Collision Type ----------c--cecmcmommommoaao

Total Crashes Fatal-and-Injury FI (KAB) Property-Damage-Only
Collision Type Prop. N Prop. N Prop. N Prop. N
Head-On 0.006 0.020 e.e13 0.022 .e18 0.e31 0.002 0.003
Sideswipe 0.043 0.142 8.027 0.e47 0.022 0.e38 0.e53 0.084
Rear-End 0.116 0.384 .163 0.281 .114 0.197 0.088 0.139
Angle 0.043 0.142 9.048 9.e83 98.e45 0.e78 0.e41 0.065
Single 0.768 2.541 8.727 1.255 8.778 1.343 .792 1.253
Other 0.024 0.879 0.822 0.038 0.023 0.e40 0.024 0.838
------------------------------------------------- Expected Crashes ----------cooommmm oo eeee
Total Observed Crashes 4 crashes
Total Observed Crashes (FI) 4 crashes
Total Observed Crashes (PDO) ° crashes
Average Observed Crashes 4.000 crashes/year
Average Observed Crashes (FI) 4.000 crashes/year
Average Observed Crashes (PDO) 0.000 crashes/year
Back  Overdispersion Parameter, k 0.142
Overdispersion Parameter (FI), k 0.123
Weighted Adjustment, w 0.680
Weighted Adjustment (FI), w 0.825
Expected Crashes (FI) 2.125 crashes/year
Expected Crashes (PDO) 1.404 crashes/year
Total Expected Crashes 3.529 crashes/year
7777777777777777777777777777777777777777777777777 ECONOMIC ANAlySi§ -----===--==mmmmm=mmmmmmomommmmmooommeooooo
**Based on Expected Crash Frequency
Annual Societal Crash Cost (FI) $336,175.00
Annual Societal Crash Cost (PDO) $10,389.60
Total Annual Societal Crash Cost $346,564.60
L ‘ Switch to Formatted Report Section | 1> v & —I &
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7. The societal crash costs are based on either predicted crashes or expected crashes. This is dependent on
whether an EB analysis is run.

a. If ‘Empirical Bayes Analysis’ is unchecked on the General page, then the societal crash costs are
based on predicted crashes.

4 HSS11-4 RuralMultilaneFacility:xha" - Highway Safety Software - 8 X
=  START GENERAL DETAILS REPORT (i )
Project Description
Analyst Jurisdiction
Agency Analysis Year 2023
Date 9/26/2023 Project Description HSM Chapter 11: Sample Problem 4
[Empirical Bayes Analysis ] | Number of Years of Observed Crashes
% HSS11-4_RuralMultilaneFacility.xhz” - Highway Safety Software = X
= START GENERAL DETAILS REPORT (i ]
Input Data
Length of Segment (mi) 1.500 AADT (veh/day) 10000
Lane Width (ft) 120 Roadway Type Divided
Right Shoulder Widih (ft) 60 Automated Speed Enforcement No
Calibration Factor 1.10
P Crash Modification Factors
@ Lane Width - CMF1 1.000 Lighting - CMF4 1.000
Shoulder Type/Width - CMF2 1.040 Auto. Speed Enforcement - CMFS | 1.000
Median Width - CMF3 1.020
Combined CMF 1.061

Predicted Roadway Section Crashes

Crash Severity Overdispersion Parameter | Nspirs by Severity | Predicted Crash Frequency | Crash Rate (crashes/mi/year)
Fatal and Injury (FI) 0123 1.480 1727 1151
Property Damage Only (PDO) | - 1355 1581 1,054
Total 0.142 2835 3308 2206
E ic Analysis (Predicted Crashes)l
Crash Severity Per Crash Societal Crash Cost Predicted Annual Crashes Total Societal Crash Cost
Fatal and Injury (Fl) $158,200.00 1727 $273,189.24
Property Damage Only (PDO) $7,400.00 1.581 $11,702.93
Total - 3308 $284,892.18
‘ﬂ ; o ST ‘ E _- = Sw\t Text Report Section | 1> B T "“““: o o —S +

ISS™ Version 2024 (USC)

Highway Safety Software User Guide How To - 47



b. If ‘Empirical Bayes Analysis’ is checked on the General page, then the societal crash costs are
based on expected crashes.

% HSS11-4 RuralMultilaneFacility.xhz - Highway Safety Software - X

= START GENERAL DETAILS REPORT (i}

Project Description

Analyst Jurisdiction
Agency Analysis Year 2023
Date 9/26/2023 Project Description HSM Chapter 11: Sample Problem 4
IEmpxricaI Bayes Analysis Number of Years of Observed Crashes 1
4 HSS11-4_RurelMultilaneFacility.xhz - Highway Safety Software - X
= START GENERAL DETAILS REPORT o
Lane Width - CMF1 1.000 Lighting - CMF4 1.000
Shoulder Type/Width - CMF2 1.040 Auto. Speed Enforcement - CMF5 | 1.000
Median Width - CMF3 1.020
Combined CMF 1.061
. Predicted Roadway Section Crashes
GI Crash Severity Overdispersion Parameter | Nspfrs by Severity | Predicted Crash Frequency | Crash Rate (crashes/mi/year)
Fatal and Injury (FI) 0123 1.480 1727 1.151
Property Damage Only (PDO) | - 1355 1581 1.054
G Total 0.142 2835 3.308 2206
(/é:\ Expected Roadway Section Crashes
o Crash Severity Average Observed Weight Expected Crash Frequency | Crash Rate (crashes/mi/year)
@ Crashes
Fatal and Injury (FI) 4000 0825 2125 1417
Property Damage Only (PDO) [ 0.000 - 1.404 0936
Total 4000 0680 3.529 2353
E ic Analysis (Exp d Crashes)l
Crash Severity Per Crash Societal Crash Cost Expected Annual Crashes Total Societal Crash Cost
Fatal and Injury (FI) $158,200.00 2125 $336,175.00
Property Damage Only (PDO) $7,400.00 1.404 $10,389.60
Total - 3529 $346,564.60
‘E: ; T oo ' N i Swslch Text Report Section 1> B o '"M: T ] N +
it © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024 (USC)

View Results of the Analysis

1. After editing all the necessary inputs, results of the analysis can be found in the form of pages and in the
form of reports.

2. There are two options for pages: Details and Report

a. Although the Details page includes inputs, there is an Output section at the bottom of the page that
includes a few results.

% HSS10-5_RuralTwoLaneFacility.xhz - Highway Safety Software = X
= START GENERAL DETAILS REPORT

Section Type Segment Model Type Two-Lane Undivided Segment (2U)
Input
AADT, veh/day 10000 Length, mi 1.500
Lane Width, ft 10.0 Shoulder Width, ft 40
Shoulder Type Gravel v Horizontal Curve O
Horizontal Curve Length, mi - Horizontal Curve Radius, ft
Spiral Transition Superelevation Variance, ft/ft
Grade, % 2.0 Number of Driveways 9
§ Centerline Rumble Strips ] Passing Lanes No Passing or Climbing Lanes 2
((_\) Two-Way Left-Turn Lanes [} Roadside Hazard Rating " ( _)>
Back  Lighting O Automated Speed Enforcement [m] it
Observed Crashes 10
Output
Safety Performance Function (SPF) 4.008 Predicted Crash Frequency (Npredicted) 6.624
CMF1 (Lane Width) 1.234 CMF2 (Shoulders) 1126
CMF3 (Horizontal Curves) 1.000 CMF4 (Horizontal Curves: Superelevation) 1.000
CMF5 (Grades) 1.000 CMF®6 (Driveway Density, CMF6 = 1 when <=5) 1.012
CMF7 (Centerline Rumble Strips) 1.000 CMF8 (Passing Lanes) 1.000
CMF9 (Two-Way Left-Turn Lanes) 1.000 CMF10 (Roadside Design) 1.069
CMF11 (Lighting) 1.000 CMF12 (Automated Speed Enforcement) 1.000

Copyright © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024 (USC)
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b. The Report page can display single section formatted reports and single section text reports.

% HSS10-5 RuralTwolaneFacility.xhz - Highway Safety Software
= START GENERAL DETAILS REPORT

g a a O are R a O Lane >eg Repo

Project Information

Analyst Date 9/26/2023

Jurisdiction Analysis Year 2023

Project Description HSM Chapter 10: Sample Section Number 1

Problem

Input Data

Length of Segment (mi) 1.500 AADT (veh/day) 10000

Lane Width (ft) 100 Grade (%) 20

Shoulder Type Gravel Shoulder Width (ft) 40

Driveway Density (driveway/mi) 6 Roadside Hazard Rating 4

Centerline Rumble Strips No Passing Lanes No Passing or Climbing Lanes
=5 Two-Way Left Tum Lane No Segment Lighting No

Automated Speed Enforcement No Calibration Factor 1.10

Crash Modification Factors

Lane Width - CMF1 1234 Centerline Rumble Strips - CMF7 1,000

Shoulder Type/Width - CMF2 1.126 Passing Lanes - CMF8 1,000

Horizontal Curve - CMF3 1.000 Two-Way Left Turn Lane - CMF9 1.000

Superelevation - CMF4 1.000 Roadside Design - CMF10 1.069

Grade - CMFS 1,000 Lighting - CMF11 1,000

Driveway Density - CMF6 1012 Auto. Speed Enforcement - CMF12 | 1.000

Combined CMF 1503

Predicted Roadway Section Crashes

@ Section | 1>

Copyright University of Florida. All Rights Reserved

3. There are two options for reports: Formatted and Text

a.

Formatted reports show the most important results in a presentable format

ghway Safe oftware Rura o Lane Segment Repo
Project Information
Analyst Date 9/26/2023
Jurisdiction Analysis Year 2023
Project Description HSM Chapter 10: Sample Section Number 1

Problem 5

Input Data
Length of Segment (mi) 1.500 AADT (veh/day) 10000
Lane Width (ft) 100 Grade (%) 20
Shoulder Type Gravel Shoulder Width (ft) 40
Driveway Density (driveway/mi) 6 Roadside Hazard Rating 4
Centerline Rumble Strips No Passing Lanes No Passing or Climbing Lanes
Two-Way Left Tum Lane No Segment Lighting No
Automated Speed Enforcement No Calibration Factor 1.10
Crash Modification Factors
Lane Width - CMF1 1234 Centerline Rumble Strips - CMF7 1.000
Shoulder Type/Width - CMF2 1126 Passing Lanes - CMF8 1.000
Horizontal Curve - CMF3 1.000 Two-Way Left Tum Lane - CMF9 1.000
Superelevation - CMF4 1.000 Roadside Design - CMF10 1.069
Grade - CMF5 1.000 Lighting - CMF11 1.000
Driveway Density - CMF6 1012 Auto. Speed Enforcement - CMF12 | 1.000
Combined CMF 1.503

Predicted Roadway Section Crashes

Crash Severity Overdispersion Parameter | Nsptrs by Severity | Predicted Crash Frequency | Crash Rate (crashes/mi/year)
Fatal and Injury (FI) - 1.286 2126 1417
Property Damage Only (PDO) |- 2721 4498 2999
Total 0.157 4.008 6.624 4416
Expected Roadway Section Crashes
Crash Severity Average Observed Weight Expected Crash Frequency | Crash Rate (crashes/mi/year)
Crashes
Fatal and Injury (FI) = = 2679 1.786
Property Damage Only (PDO) |- = 5.667 3778
Total 10,000 0490 8346 5564

Economic Analysis (Expected Crashes)

Crash Severity Per Crash Societal Crash Cost Expected Annual Crashes Total Societal Crash Cost
Fatal and Injury (FI) $158,200.00 2679 $423,769.31
Property Damage Only (PDO) $7.400.00 5.667 $41,938.07
Total B 8346 $465,707.37

= X
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b. Text reports show a more detailed analysis in plain text

Highway Safety Software Text Report

M Combined 1.503

Predicted Crashes

File Name: HS510-5_RuralTwoLaneFacility. xhz
Analyst: Predicted Crashes (FI) 2.126 crashes/year
Predicted Crashes (Fatal) 0.086 crashes/year

Jurisdiction: Predicted Crashes (Incapacitating Injury) 0.358 crashes/year
Date: 9/26/2023 Predicted Crashes (Nonincapacitating Injury) 0.722 crashes/year
Analysis Year: 2023 Predicted Crashes (Possible Injury) 0.950 crashes/year
Project Description: HSM Chapter 10: Sample Problem S Predicted Crashes (PDO) 4,498 crashes/year
its: U.5. Customary Total Predicted Crashes 6.624 crashes/year

Section 1: Total Crashes Fatal-and-Injury Property-Danage-Only
Collision Type Prop. N Prop. N Prop. N
- Single-Vehicle
fictiity Tyie RutaTioiane Collision with Animal 6121 o.802 e.038  o.081 6.188  0.828
Sectioh Type Seghent: en Collision with Bicycle 0.002  0.013 0.008  0.009 0.001  0.004
Model Type ua-Lane Undivided Sepment (2H) Collision with Pedestrian 0.003 0.020 0.007 0.015 0.001 0.004
Ares Type Ll overturned e.025  0.166 0.037  e.079 0.015  0.067
Ran OFf Road e.521  3.a51 e.sas 1159 6.505  2.271
Tnput Other Si icle Collision 0.021  0.139 0.007  o.015 0.020  0.130
Total Single-Vehicle Crashes 0.693  4.5% 0.638  1.357 0735 3.306
P 10000 veh/day Hultiple-Vehicle
Length 1.500 it Angle Collision o.08s  o.563 o100  0.213 c.o72  0.328
Lane wWidth 0.0 by Head-0n Collision e.016  6.106 6.0 e.072 0.003  6.013
Shoulder Width a0 P Rear-End Collision 0142  e.%41 0.164 0349 0122 e.549
Shoulder Type Gravel Sideswipe Collision 0.037  e.285 0038  o.081 e.038  0.171
Horizontal Curve o Other Multiple-Vehicle Collision 0.027  0.179 0.626  0.655 e.e30 .13
Grade 2.0 Total Multiple-Vehicle Crashes 0.307 2034 0362 0.770 6.265  1.192
Oriveway Density 6 driveway/mi
Centerline Rumble Strips o Expected Crashes
Passing Lanes NoPassinglane
Dy et * Total Observed Crashes 10 crashes
Average Observed Crashes 10.000 crashes/year
Automated Speed Enforcesent to Overdisperaion Parancter, k ois7 ’
Weighted Adjustment, w 0.4
ved Cr: Expected Crashes (FI) 2.679 crashes/year
Expected Crashes (PDO) 5.667 crashes/year
Number of Observed Crashes 10 Total Expected Crashes 8.345 crashes/year
output Economic Analysis
spr “*Based on Expected Crash Frequency
Annual Societal Crash Cost (FI) $423,769.31
Annual Societal Crash Cost (PDO) 341,938.07
N (SPF, FI) 1.286 ks
e ] Total Annual Societal Crash Cost $465,707.37
HFs di
This Highway Safety Software text report was created in HSS™ Version 2024 on 9/27/2023 20:24:20
CHF_WRA (for CHF2 Shoulders) 1.150
QHF_TRA (for CMF2 Shoulders) 1.010
s
OF1 (Lane Width) 1.238
GHF2 (shoulders) 1126
QHF3 (Horizontal Curves 1.000
QF4 (Horizontal Curves: Superelevation) 1.000
QS (Grades) 000
CHFS (Driveway Density, CHF6 = 1 when <=5) 1.012
QF7 (Centerline Rumble Strips) 1.000
QHF8 (Passing Lanes) 1.000
QHFS (Two-Way Left-Turn Lanes) 1.000
QHF10 (Roadside Design) 1069
CHF11 (Lighting) 1.000
QMF12 (Automated Speed Enforcement) 1.000

4. The type of report displayed can be changed by using the main menu items, keyboard shortcuts, or toggle
buttons found under the report

a.

Main Menu ltems

To switch to the Formatted Report, select File > Report > Formatted Report from the main
menu; this can be found by selecting the three lines in the top left-hand corner of the
screen, hovering over “Report”, and then selecting “Formatted Report”.

% HSS10-5 RuralTwolaneFacility.xhz - Highway Safety Software
= | START GENERAL DETAILS REPORT

New tri+N >
Open Ctrl+0 5 R n . Repo
Example Folder
Save Ctii+s
Save As... F12 Date 9/26/2023
Close W Analysis Year 2023
HSM Chapter 10: Sample | Section Number 1
Units 2 Problem
print Ctri+P
Print Preview
] 1,500 AADT (veh/day) 10000
View >
1 ETY 1 rade ) 70
S
Report [ :orm:ned Report i: WG w
Parameter Template |l Tent Repoct e e P
EAE No Passing Lanes No Passing or Climbing Lanes
Default Settings Alt+F No. Segment Lighting No
Help > No Calioration Factor 110
Exit At+F4  hors
Lane Width - CMF1 1234 Centerline Rumble Strips - CMF7 | 1.000
Shoulder Type/Width - CMF2 1126 Passing Lanes - CMF8 1000
Horizontal Curve - CMF3 1000 Two-Way Left Tum Lane - CMF9__ | 1000
Superelevation - CMF4 1000 Roadside Design - CMF10 1069
Grade - CMFS 1000 Lighting - CMF11 1000
Driveway Density - CMF6 1012 Auto, Speed Enforcement - CMF12_ | 1000
Combined CMF 1503
(9] Switch to Text Report Section | 1> v ® —t

Copyright © 2023 University of Florida. Al Rights Reserved. HSS™ Version 2024 (USC)

To switch to the Text Report, select File > Report > Text Report from the main menu; this
can be found by selecting the three lines in the top left-hand corner of the screen, hovering
over “Report”, and then selecting “Text Report”.
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% HSS10-5_RuralTwolaneFacil

hz - Highway Safety Software

= START GENERAL DETAILS REPORT

New Ctri+N »
Highway Safety Software Text Report
Open ctri+0
Example Folder
Save Ctri+S HS516-5_RuralTwolaneFacility.xhz
Save As... F12
Close Ctri+W
9/26/2023
Units » 2023
HSM Chapter 10: Sample Problem 5
Print Ctrl+P U.S. Customary
Print Preview Ctri+F2
View »
_Report i Formatted Report  F4  section 1:
Parameter Template » Text Report F6
RuralTwolane
Export to CSV. Segnent

Two-Lane Undivided Segment (2U)

Default Settings Alt+F e
Help S
Exit Alt+F4 o
ARDT 10000 veh/day
Length 1.500 mi
Lane Width 10.0 t
Shoulder Width 4.0 ft
Shoulder Type Gravel
Horizontal Curve No
Grade 2.0 %
Driveway Density 6 driveway/mi
Centerline Rumble Strips No
Passing Lanes NoPassingLane
Tuo-Way Left-Turn Lanes No
sl an
(2 tch to Formatted Report IS NN Y

Copyright © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024 (USC)

b. Keyboard Shortcuts

i. Formatted Report: keyboard shortcut is “F4”

ii. Text Report: keyboard shortcut is “F6”

c. Report Toggle Buttons

% HSS510-5_RuralTwolaneFacility.xhz - Highway Safety Software
= START GENERAL DETAILS REPORT

Highway Safety Software Rural Two Lane Segment Report

Project Information
Analyst Date 9/26/2023
Jurisdiction Analysis Year 2023
Project Description HSM Chapter 10: Sample Section Number 1
Problem 5
Input Data
Length of Segment (mi) 1500 AADT (veh/day) 10000
Lane Width (ft) 100 Grade (%) 20
Shoulder Type Gravel Shoulder Width (ft) 40
Driveway Density (driveway/mi) 6 Roadside Hazard Rating 4
Centerline Rumble Strips No Passing Lanes No Passing or Climbing Lanes
Two-Way Left Turn Lane No Segment Lighting No
Automated Speed Enforcement No Calibration Factor 110
Crash Modification Factors
Lane Width - CMF1 1234 Centerline Rumble Strips - CMF7 1.000
Shoulder Type/Width - CMF2 1126 Passing Lanes - CMFS 1.000
Horizontal Curve - CMF3 1.000 Two-Way Left Tur Lane - CMFO 1.000
Superelevation - CMF4 1.000 Roadside Design - CMF10 1.069
Grade - CMF5 1.000 Lighting - CMF11 1.000
Driveway Density - CMF6 1012 Auto. Speed Enforcement - CMF12 | 1.000
Combined CMF 1503

(9]

Copyright © 2023 University of Florida. All Rights Reserved.

Switch to Text Report Section | 1>

i. Ifthe formatted report is currently being displayed, the toggle button will say “Switch to Text
Report” which will allow you to display the text report if clicked.

HSS™ Version 2024 (USC)

Highway Safety Software User Guide

How To - 51



If the text report is currently being displayed, the toggle buttons will say “Switch to
Formatted Report” which will allow you to display the formatted report if clicked.

% HSS10-5 RuralTwolaneFacility.xhz - Highway Safety Software - a8 X
=  START GENERAL DETAILS REPORT

Highway Safety Software Text Report

File Name: HSS10-5_RuralTwolaneFacility.xhz
Analyst:
Agency:
Jurisdiction:
Date: 9/26/2023
Analysis Year: 2023
Project Description: HSM Chapter 10: Sample Problem 5
Units: U.S. Customary

Section 1:
Facility Type RuralTwoLane
Section Type Segment
Hodel Type Tuo-Lane Undivided Segment (2U)
Area Type Rural

Input

AADT 10000 veh/day
Length 1.500 mi
Lane Width 10.0 ft
Shoulder Width 4.0 £t
Shoulder Type Gravel
Horizontal Curve No
Grade 2.0 %
Driveway Density 6 driveway/mi
Centerline Rumble Strips No
Passing Lanes NoPassingLane

Left-Turn Lanes No

Section | 1>

HSS™ Version 2024 (USC)

Copyright © 2023 University of Florida. All Rights Reserved.

5. For both formatted and text reports, a Section drop down menu is provided next to the toggle button. All
reports are section specific reports. The drop-down menu allows you to select which section to display on
the Report page. There is also the option of showing all sections which will show each of the section reports
one after the other.

% HSS10-5_RuralTwolaneFacility.xhz - Highway Safety Software
= START GENERAL DETAILS REPORT

Highway Safety Software Rural Two Repol
Project Information
Analyst Date 9/26/2023
Jurisdiction Analysis Year 2023
Project Description HSM Chapter 10: Sample Section Number 1
Problem

Input Data
Length of Segment (mi) 1.500 AADT (veh/day) 10000
Lane Width (ft) 100 Grade (%) 20
Shoulder Type Gravel Shoulder Width (ft) 40

(Q Driveway Density (driveway/mi) 3 Roadside Hazard Rating 4

et Centerline Rumble Strips No Passing Lanes No Passing or Climbing Lanes
Two-Way Left Tum Lane No Segment Lighting No
Automated Speed Enforcement No Calibration Factor 110
Crash Modification Factors
Lane Width - CMF1 1234 Centerline Rumble Strips - CMF7 | 1.000
Shoulder Type/Width - CMF2 1126 Passing Lanes - CMF8 1.000
Horizontal Curve - CMF3 1.000 Two-Way Left Tum Lane - CMF9 1.000
Superelevation - CMF4 1.000 Roadside Design - CMF10 1.069
Grade - CMF5 1.000 Lighting - CMF11 1.000 1>
Driveway Density - CMF6 1012 Auto. Speed Enforcement - CMF12 | 1.000 2>
Combined CMF 1503 3>
All Sections

Switch to Text Report Section | 1> v

Copyright © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024 (USC)
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6. The magnification of the report currently being displayed can be changed using the zoom slider found at
the bottom right-hand corner of the screen.

% HSS10-5_RuralTwolaneFacility.xhz - Highway Safety Software - X
= START GENERAL DETAILS REPORT

Highway Safety Software Rural Two Lane Segment Report

Project Information
Analyst Date 9/26/2023
Jurisdiction Analysis Year 2023
Project Description HSM Chapter 10: Sample Section Number 1
Problem
Input Data
Length of Segment (mi) 1,500 AADT (veh/day) 10000
Lane Width () 100 Grade (%) 20
Shoulder Type Gravel Shoulder Width (ft) 40
@ Driveway Density (driveway/mi) 6 Roadside Hazard Rating 4
e Centerline Rumble Strips No Passing Lanes No Passing or Climbing Lanes
ac
Two-Way Left Turn Lane No Segment Lighting No
Automated Speed Enforcement No Calibration Factor 1.10
Crash Modification Factors
Lane Width - CMF1 1234 Centerline Rumble Strips - CMF7 1.000
Shoulder Type/Width - CMF2 1126 Passing Lanes - CMF8 1,000
Horizontal Curve - CMF3 1.000 Two-Way Left Turn Lane - CMF9 1.000
Superelevation - CMF4 1.000 Roadside Design - CMF10 1.069
Grade - CMFS 1.000 Lighting - CMF11 1.000
Driveway Density - CMF6 1012 Auto. Speed Enforcement - CMF12 | 1.000
Combined CMF 1503
= Switch to Text Report Section | 1> v & —8 &
Copyright © 2023 University of Florida. All Rights Reserved. HSS™ Version 2024 (USC)

a. Tozoom in, drag the slider to the right; to zoom out, drag the slider to the left
b. Clicking the plus (+) button will zoom in; clicking the minus (-) button will zoom out

c. Holding down “ctrl” on the keyboard and scrolling up on the mouse wheel will zoom in; holding
down “ctrl” on the keyboard and scrolling down on the mouse wheel will zoom out

Print a Report

1. There are four options for printing a report:

a. Selecting File > Print from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Print”

% HSS10-5_RuralTwolaneFacility.xhz - Highway Safety Software = X
= START GENERAL DETAILS REPORT
New Ctri+N »
Open LIl hway Safety Software Rural Two Lane Segment Report
Example Folder
Save Ctrl+S
Save As... F12 Date 9/26/2023
Close CuleW Analysis Year 203
HSM Chapter 10: Sample | Section Number 1
Units i Problem 5
Print cul+p__|
Print Preview Ctrl+F2
1.500 AADT (veh/day) 10000
View »
100 Grade (%) 20
,
Beport Gravel Shoulder Width (f) 40
Parameter Template » 6 Roadeide Hazard Rating 7
BpOEtoSY) No Passing Lanes No Passing or Climbing Lanes
Default Settings Alt+F % i 75
Help 4 No Calibration Factor 110
Exit Alt+F4  ore
Lane Width - CMF1 1234 Centerline Rumble Strips - CMF7 | 1.000
Shoulder Type/Width - CMF2 1126 Passing Lanes - CMF8 1000
Horizontal Curve - CMF3 1000 Two-Way Left Tum Lane - CMF9 | 1,000
Superelevation - CMF4 1000 Roadside Design - CMF10 1069
Grade - CMF5 1.000 Lighting - CMF11 1000
Driveway Density - CMF6 1012 Auto. Speed Enforcement - CMF12 | 1,000
Combined CMF 1503
@ Switch to Text Report Section | 1> v & —B +
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2. Print

Selecting File > Print Preview from the main menu; this can be found by selecting the three lines in
the top left-hand corner of the screen and then selecting “Print Preview”

% HSS10-5_RuralTwoLaneFacility.xhz - Highway Safety Software

=  START GENERAL DETAILS REPORT

New Ctri+N » ‘
Open SOl hway Safety Software Rural Two Lane Segment Report
Example Folder
Save Ctrl+S
Save As... F12 | Date 9/26/2023
Close Culew Analysis Vear 2023
HSM Chapter 10: Sample | Section Number 1
Units i Problem 5
Print Ctri+P
Print Preview ctisF2 ||
) ED AADT (veh/day) 10000
View ,
100 Grade (%) 20
,
Beport [ Joravel Shoulder Width (f) 40
Parameter Template , 5 TR 7
Epoitio GV [ I Passing Lanes No Passing or Climbing Lanes
Default Settings Alt+F = Segment ghtng 3
Help » [ v Calibration Factor 110
Exit Alt+FA  hors
Lane Width - CMFT 1234 Centerline Rumble Strips - CMF7 | 1.000
Shoulder Type/Width - CMF2 1126 Passing Lanes - CMF8 1000
Horizontal Curve - CMF3 1,000 Two-Way Left Turm Lane - CMF9. | 1.000
Superelevation - CMF4 1,000 Roadside Design - CMFI0 1,069
Grade - CMF5 1,000 Lighting - CMF11 1.000
Driveway Density - CMF6 1012 ‘Auto. Speed Enforcement - CMF12_| 1.000
Combined CMF 1503
@ Switch to Text Report Section | 1>

B -~

&
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Using the keyboard shortcut “Ctrl+P” for Print
Using the keyboard shortcut “Ctrl+F2” for Print Preview

HSS™ Version 2024 (USC)

Using Print will bring up a Print dialog box where you can select which printer to print to

m Print
General |

Select Printer

® Microsoft Print to PDF
™ Microsoft XPS Document Writer
™ OneNote for Windows 10

X

< >
Status: Ready Preferences
Location:

Comment: Find Printer...
- Page Range r

© Al Number of copies: |1 E
(e S Gt Page

& I 5

1 52 33
Bl (e =
Pit |  Cancel | |
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3. Print Preview

a. Using Print Preview will bring up a window where you can view how the report will look on paper
before sending it to the printer

% Print Preview

4| BHEBE

g 0 0 g po
Project Information
Analyst Date 9/26/2023
Jurisdiction Analysis Year 2023
Project Description HSM Chapter 10: Sample Section Number i

Problem
Input Data
Length of Segment (mi) 1500 AADT (veh/day) 10000
Lane Width (ft) 100 Grade (%) 20
Shoulder Type Gravel Shoulder Width () 40
Driveway Density (driveway/mi) 6 Roadside Hazard Rating 4
Centerline Rumble Strips No Passing Lanes No Passing or Climbing Lanes
Two-Way Left Tum Lane No Segment Lighting No
Automated Speed Enforcement No Calibration Factor 1.10
Crash Modification Factors
Lane Width - CMF1 1234 Centerline Rumble Strips - CMF7 | 1.000
Shoulder Type/Width - CMF2 1126 Passing Lanes - CMF8 1.000
Horizontal Curve - CMF3 1.000 Two-Way Left Turn Lane - CMF9 1.000
Superelevation - CMF4 1.000 Roadside Design - CMF10 1.069
Grade - CMF5 1.000 Lighting - CMF11 1.000
Driveway Density - CMF6 1012 Auto. Speed Enforcement - CMF12 | 1.000
Combined CMF 1,503

Type text to find... “r~

b. The print icon in the toolbar found in the top left-hand corner can then be selected

Predicted Roadway Section Crashes

BEO

E

c. A print dialog box will pop up where you can select which printer to print to

= Print
General |

 Select Printer

X

7® Microsoft Print to PDF

<

Status:
Location:

Ready

M Microsoft XPS Document Writer
™ OneNote for Windows 10
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Glossary of Terms

AADT

Annual average daily traffic; the counted (or estimated) total traffic volume in one year divided by 365 days/year.

Rural Two-Lane, Two-Way Roads (Chapter 10); Rural Multilane Highways (Chapter 11); Urban and Suburban
Arterials (Chapter 12)

For each roadway segment, the AADT is the average daily two-way, 24-hour traffic volume on that roadway segment
in each year of the evaluation period.

For each intersection, two values are required in each predictive model. These are the AADT of the major street,
AADT g, and the two-way AADT of the minor street, AADT pn.

In Chapter 10, AADT s and AADTqin are determined as follows: if the AADTs on the two major road legs of an
intersection differ, the larger of the two AADT values is used for the intersection. For a three-leg intersection, the
minor road AADT is the AADT of the single minor road leg. For a four-leg intersection, if the AADTs of the two minor
road legs differ, the larger of the two AADT values is used for that intersection. If AADTs are available for every
roadway segment along a facility, the major road AADTs for intersection legs can be determined without additional
data.

In Chapter 11, AADT s and AADTmin are determined as follows: if the AADTs on the two major-road legs of an
intersection differ, the larger of the two AADT values are used for AADT 5. For a three-leg intersection, the AADT
of the minor-road leg is used for AADTmin. For a four-leg intersection, the larger of the AADTs for the two minor-
road legs should be used for AADT . If a highway agency lacks data on the entering traffic volumes, but has two-
way AADT data for the major and minor-road legs of the intersection, these may be used as a substitute for the
entering volume data. Where needed, AADT .t can be estimated as the sum of AADT g and AADT min.

In Chapter 12, AADT ps; and AADT min are determined as follows: if the AADTSs on the two-major-road legs of a four-
leg intersection differ, the larger of the AADTSs for the two minor road legs is used. For a three-leg intersection, the
AADT of the single minor road leg is used. If AADTs are available for every roadway segment along a facility, the
major-road AADTSs for intersection legs can be determined without additional data.

Freeways (Chapter 18)
For each freeway segment, the following five AADT values are required:
(1) the AADT volume of the freeway segment (AADT¥),

(2) the AADT volume of the nearest entrance ramp upstream of the segment for the increasing milepost travel
direction (AADTp,ent),

(3) the AADT volume of the nearest entrance ramp upstream of the segment for the decreasing milepost travel
direction (AADTe,ent),

(4) the AADT volume of the nearest exit ramp downstream of the segment for the increasing milepost travel
direction (AADTs,ex), and
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(5) the AADT volume of the nearest exit ramp downstream of the segment for the decreasing milepost travel
direction (AADTp,ext).

For each ramp entrance speed-change lane, two values are required. They include the AADT volume of the freeway
segment and the AADT volume of the ramp.

For each ramp exit speed-change lane, only the AADT volume of the freeway segment is required. The AADT
volume of the ramp is not needed.

The AADT volumes are needed for each year of the evaluation period. The AADT volume for a given year represents
an annual average daily 24-hour traffic volume. The freeway segment AADT volume is a two-way volume (i.e., the
total of both travel directions). Each ramp AADT volume represents a one-way volume.

b,ext b,ent

_________i Primary e,
Direction
| Secondary |
Direction

Segment of Interest
eent e.ext

Ramps (Chapter 19)

The AADT volume of the ramp is needed for each ramp segment. The AADT volume of the C-D road is needed for
the evaluation of each C-D road segment.

For each crossroad ramp terminal, one AADT value is needed for each intersection leg. Thus, for a four-leg ramp
terminal, the following values are needed: AADT volume of the crossroad leg “inside” the interchange, AADT volume
of the crossroad leg “outside” of the interchange, AADT volume of the exit ramp, and AADT volume of the entrance
ramp. The inside crossroad leg is the leg that is on the side of the ramp terminal nearest to the freeway. The outside
crossroad leg is on the other side of the ramp terminal. The AADT of the loop ramp at a terminal with either an A4
or B4 configuration is not needed (or used in the calculations.

The AADT volumes are needed for each year of the evaluation period. The AADT volume for a given year represents
and annual average daily 24-hour traffic volume. The ramp and C-D road segment AADT volume is a one-way
volume. The crossroad segment AADT volume is a two-way volume (i.e., total of both travel directions).

AADT; is the AADT volume of the ramp segment in veh/day. AADT. is the AADT volume of the C-D road segment
in veh/day.

The AADT of the ramps are shown in the diagram below.

Add Horizontal Curve

For Freeway Segment, Ramp Segment, and Freeway Intersection analyses, a button for adding a horizontal curve
is available when ‘Include Horizontal Curves’ is checked.

For Freeway Segment and Speed Change Lanes analyses, clicking on the button ‘Add Horizontal Curve’ will add a
row of inputs which include the following: Primary Radius, Secondary Radius, and Length in Segment. Primary
Radius is measured for roadbed curves and Secondary Radius is measured to the inside edge of the traveled way.

For Ramp Segment and C-D Road Segment analyses, clicking on the button ‘Add Horizontal Curve’ will add a row
of inputs which include the following: Radius of Curve, Average Entry Speed, and Length in Segment.

The user can add an unlimited number of horizontal curves.
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Add Section

For facility analyses, a button for adding a section is available. Clicking on the button ‘Add Section’ will add a row
of inputs which include the following: Section Type, Facility Type, Model Type, Details, N(spf), and N(predicted).
Section Type can either be Segment or Intersection. Facility Type can either be Rural Two-Lane or Rural Multilane
in a Rural Facility analysis. Facility Type can only be Urban in an Urban Facility analysis. Section Type and Facility
Type cannot be changed within the rows. They must be specified before the new section is added. Model Type can
be changed within the rows and the choices available are dependent on Section Type and Facility Type
combinations. Clicking on Details within a row will bring the user to the Details page for that specific section. N(spf)
specifies the predicted average crash frequency for base conditions for that individual section. N(predicted)
specifies the predicted average crash frequency for that individual section, which is dependent on the inputs
specified on the Details page. The user can add an unlimited number of sections.

Agency

This field is provided to document the agency or company associated with this analysis or project.

Analysis Type

This specifies the type of analysis to be done. Choices include: Segment, Intersection, Rural Facility, Urban Facility,
Freeway Facility, and Ramp Facility.

Analysis Year

This field is provided to document the year for which the analysis is being performed.

Analyst

This field is provided to document the name of the analyst.

Angle

The angle to next leg is used to measure the relative intersection skew; it is measured in degrees. Angle is measured
for each leg of the roundabout.

Any Ramps within 0.5 mi

A checkbox is provided to indicate if there are any ramps within 0.5 miles (or 0.8 kilometers in metric). If ramps are
within 0.5 miles (or 0.8 kilometers in metric) of the end point of the segment, there is a potential for increased
crashes due to lane changing.

Approach

A lane or set of lanes at an intersection that accommodates all left-turn, through, and right-turn movements from a
given direction.

Approaches for which Right-Turn-on-Red is Prohibited

This is the number of signalized intersection approaches for which right-turn-on-red is prohibited. This affects the
CMF for right-turn-on-red operation (CMF4).
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Approaches for which U-Turn is Prohibited

This indicates the number of approaches from which U-turns are prohibited via “No U-turn” signs. It is used in the
calculation of the U-turn Prohibition CMF.

Approaches with Turn Lanes

The number of approaches with left-turn lanes and the number of approaches with right-turn lanes are necessary
for determining the effects of individual geometric design of intersections. Approaches include the major and minor
road approaches. Turn lanes include exclusive left-turn lanes and exclusive right-turn lanes. Stop-controlled
approaches are not considered in determining the number of approaches with right- or left-turn lanes.

Area Type
This specifies whether the area is rural or urban.

See also Rural Areas and Urban Environment.

Automated Speed Enforcement

Automated speed enforcement systems use video or photographic identification in conjunction with radar or lasers
to detect speeding drivers. The systems automatically record vehicle registrations without needing police officers
at the scene.

Average Entry Speed
The estimated speed of vehicles upon entering the curve.

The procedure for predicting the average curve entry speed for each curve on a ramp or C-D road is developed for
use with the horizontal curve CMF. It is not intended to be used with other applications, or to predict vehicle speed
at other points along a ramp or C-D road.

The speed prediction procedure consists of a sequence of steps that lead to a prediction of average entry speed
for each horizontal curve on the subject ramp or C-D road. Each curve is addressed by the procedure in the same
sequence as they are encountered when traveling along the ramp or C-D road. In this manner, the speed for all
previous curves encountered must be calculated first, before the speed on the subject curve can be calculated. The
steps used will vary depending on whether the segment is part of an entrance ramp, exit ramp, connector ramp, or
C-D road.

The horizontal curves are located along the ramp or C-D road using a linear referencing system. For exit ramps,
ramp-mile 0.0 (or ramp-kilometer 0.0 in metric) is located at the gore point. For entrance ramps that intersect the
crossroad, ramp-mile 0.0 (or ramp-kilometer 0.0 in metric) is located at the point where the ramp reference line
intersects with the near edge of traveled way of the crossroad. The location of ramp-mile 0.0 (or ramp-kilometer 0.0
in metric) is shown in the figure below for simple situations.
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Exit Ramp, C-D Road, Entrance Ramp with Speed-Change Lane

Gore point
Ramp-mile 0.0

________________ This barrier is on the

— J, —h freeway\and ramp.

<+«—— Reference line

This barrier is on the M

This barrier is on the ramp. B

Entrance Ramp with Intersection

Ramp-mile 0.0

<+«—— Reference line

Measure lane and shoulder widths in areas with
constant cross section. Measure along a line
such as line A or line B_ If necessary, move the
line off the subject segment to the nearest point
with constant cross section.

It is shown in the figure below for more complex ramp and C-D road combinations.

Ramp-mile 0.0
(both ramps)

Ramp 1 has the highest volume so its ramp-mile 0.0 is
used for the combined entrance ramp segments.

a. Exit Ramp b. Entrance Ramp

C-D road 1 has the highest volume so its ramp-mile 0.0 is used for the combined entrance ramp segments.

q__ =
T T el C—Drcad1'o" o ';. PP T
~ Ramp 3, jRamp 4 * -
Ramp-mile 0.0 #y,  tEmReg) IR '-’..*
(C-D road 1, Ramp 2, Ramp2s, “ems’ [[RrasiA Ramp 5
and Ramp 4) . *
". o “Ramp-mile 0.0

(Ramp 3)

S

«— Ramp-mile 0.0
(Ramp 5)

--.-""+-‘

c¢. Entrance and Exit Ramps with C-D Road
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When a specific entrance ramp or C-D road segment serves traffic from two or more sources combined, ramp-mile
0.0 (or ramp-kilometer 0.0 in metric) for this segment should be that of the one ramp that is the source of the highest
daily traffic volume.

The input data needed for this procedure are identified in the table below. The first three variables listed represent
required input data. Default values are provided for the remaining variables.

Variable Description Default Value Applicable Site Type

X Ramp-mile of the point of change None All

i

from tangent to curve (PC) for

curve 7 (mi)?

R, Radius of curve i (ft)? None All
LM Length of horizontal curve 7 (mi) None All
v, Average traffic speed on the Estimate as equal to the speed All

Sfwy
freeway during off-peak periods  limit

of the typical day (mi/h)

: Average speed at the point 15 — ramps with stop-, yield-. or  Entrance ramp, exit ramp.
wwoad £ 3
where the ramp connects to the signal-controlled crossroad ramp  connector ramp at service
crossroad (mih) terminals interchange

30 — all other ramps at service
interchanges

S Average speed on C-D road or 40 C-D road. connector ramp at
connector ramp (measured at system mterchange
the mid-point of the C-D road or

ramp) (mi'h)

* If the curve is preceded by a spiral transition, then X, is computed as equal to the average of the TS and 5C ramp-mile
locations, where TS is the point of change from tangent to spiral and SC is the point of change from spiral to curve.
" If the curve has spiral transitions, then R, is equal to the radius of the central circular portion of the curve.

Base Model

A regression model for predicting the expected average crash frequency in each HSM prediction procedure given
a set of site characteristics. The base model, like all regression models, predicts the value of a dependent variable
as a function of a set of independent variables. The expected average crash frequency is adjusted for changes to
set site characteristics with the use of a CMF.

Bicycle Crash Adjustment Factor

For roadway segments, fuiker is the bicycle crash adjustment factor. It is used in the determination of the number of
vehicle-bicycle collisions per year for a roadway segment. The values of fyier are likely to depend on the climate
and the bicycling environment in particular states or communities. The following tables show the bicycle crash
adjustment factors for roadway segments, but users are encouraged to replace the values in the table with suitable
values for their own state or community through the calibration process.
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Table 54. Bicycle crash adjustment factor for two-way roadway segments.

S Road Bicycle Crash Adjustment Factor (fhire)
Type Posted Speed 30 mph or Lower Posted Speed Greater Than 30 mph
. Total P Total
P e F 2 P bl L N g
Segments | Crashes S} Segments | Crashes S,\
Crashes” Crashes®

s 2U 0.018 0.004
FEER 0.027 0.007
C |4U 0.011 0.002
= |4D 0.013 0.005
oI 0.050 0.012
- 6U 22 7 249 0.013 72 9 1359 0.007
_Z, 6D 106 16 2377 0.007 1661 190 24720 0.008
5‘ iy 16 8 324 0.025 250 46 10016 0.001
= 8D 1 0 612 122 92 6623 0.014

Note: Shaded cell = data not available.
* Excludes pedestrian and bicycle crashes.

Table 74. Bicycle crash adjustment factor for one-way roadway segments.

Bicycle Crash Adjustment Factor (foiker)
Posted Speed 30 mph or Lower Posted Speed Greater Than 30 mph
Source 1;:13)(: Number Total \;[‘?tal d f Number Total “];l?tal 1 f
M of Bicycle | © e ped of Bicycle | & _ s pod
Segments Crashes s Segments | Crashes i
' Crashes® i Crashes”
z 20 174 29 2767 0.011 276 11 676 0.016
%; 30 395 24 2217 0.011 162 11 911 0.012
& 40 81 T 342 0.021 a7 3 405 0.007

#Excludes pedestrian and bicycle crashes.

For intersections, fyiei is the bicycle crash adjustment factor. It is used in the determination of the number of vehicle-
bicycle collisions per year for an intersection. The values of fyxe; are likely to depend on the climate and bicycling
environment in particular states or communities. The following table shows the bicycle crash adjustment factors for
intersections, but users are encouraged to replace the values in the table with suitable values for their own state or

community through the calibration process.
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Table 12-30. Bicycle Crash Adjustment Factors for Intersections

Intersection Category Intersection Type Bicycle Crash Adjustment Factor (fpie)
38T 0.016
35G 0.011
2x2 with five or fewer lanes
4ST 0.018
45G 0.015
38T 0.048
35G 0.029
2x2 with six or more lanes
4ST 0.039
456G 0.019
38T 0.018
el 35G 0.016
or
o 4ST 0.022
415G 0.012

Note: These factors apply to the methodology for predicting total crashes (all severity levels combined). All bicycle collisions resulting from this
adjustment factor are treated as FI crashes and none as PDO crashes.

Source: HSIS data from California (2002-2006) for 2x2 Intersections with five or fewer lanes; HSIS data from California and Illinois (2006-2010) and
state data from Texas (2008-2012) and Michigan (2008-2012) for other Intersection categories.

Calibration Factor

A factor to adjust crash frequency estimates produced from a safety prediction procedure to approximate local
conditions. The factor is computed by comparing existing crash data at the state, regional, or local level to estimates
obtained from predictive models.

California State

A checkbox is provided to indicate if the site under analysis is in California. If checked, the California state indicator
variable is 1.0. If not, it is 0.0. This indicator variable is used in the safety performance function calculations.

The project database was developed using data from five states: Texas, lllinois, California, Michigan, and Oregon.
These states were selected based on the state-owned mileage of the two street categories of interest and the
availability of crash data.

Crash and roadway data from California and lllinois were obtained from the Highway Safety Information System
(HSIS), while data from Texas, Michigan, and Oregon were obtained directly from the state highway agencies. Data
from Texas, lllinois, and California comprised the bulk of the project database. Data from Oregon were later added
to increase the mileage of one-way streets, and data from Michigan were added to increase the number of
intersections in the sample.

Data for the five states were combined for model calibration and the development of crash modification factors
(CMFs). These data were enriched through the inclusion of additional road inventory data extracted from Google
Earth and Google Street View. The enhanced database was then combined with the crash data to form the highway
safety database needed for model and CMF development and calibration.

Circulating AADT

Average annual daily traffic volume circulating the roundabout; measured in vehicles per day for each approach leg

Circulating Width

Circulating width is the width of the circulatory roadway within the roundabout. It is measured in feet and recorded
as the nearest integer foot (or nearest tenth of a meter in metric). Roundabouts in which the number of circulating
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lanes varies and/or roundabouts that are not circular (e.g., oblong shaped) may have circulating widths that vary.
In these instances, the aligned dimension will need to be used to measure the circulating width in front of the splitter
island on each leg.

Clear Zone

The total roadside border area, starting at the edge of the traveled way, available for use by errant vehicles.

Clear Zone Width

This width is measured from the edge of traveled way to typical limits of vertical obstruction (e.g., non-traversable
slope, fence line, utility poles) along the roadway. The clear zone width includes the outside shoulder. It is measured
for both travel directions. If this width varies along the segment, then use the estimated length-weighted average
clear zone width (excluding the portion of the segment with barrier). Do not consider roadside barrier when
determining the clear zone width for the predictive method. Barrier location and influence is addressed in other
CMFs. If the segment has roadside barrier on both sides for its entire length, then the clear zone width will not
influence the model prediction, and any value can be used as model input.

Crash

A set of events not under human control that results in injury or property damage due to the collision of at least one
motorized vehicle and may involve collision with another motorized vehicle, a bicyclist, a pedestrian, or an object.

Crash Distribution

Proportions to determine the distribution of crashes by collision type. Proportions can be edited, but defaults are
based off the following tables found in the Highway Safety Manual (HSM) and NCHRP reports:

e HSM Table 10-4. Default Distribution by Collision Type for Specific Crash Severity Levels on Rural Two-
Lane, Two-Way Roadway Segments

e HSM Table 10-6. Default Distribution for Collision Type and Manner of Collision at Rural Two-Way
Intersections

e HSM Table 11-4. Default Distribution of Crashes by Collision Type and Crash Severity Level for Undivided
Roadway Segments

e HSM Table 11-6. Default Distribution of Crashes by Collision Type and Crash Severity Level for Divided
Roadway Segments

e HSM Table 11-9. Default Distribution of Intersection Crashes by Collision Type and Crash Severity

e HSM Table 12.4. Distribution of Multiple-Vehicle Nondriveway Collisions for Roadway Segments by Manner
of Collision Type

e HSM Table 12-6. Distribution of Single-Vehicle Crashes for Roadway Segments by Collision Type
e HSM Table 12-11. Distribution of Multiple-Vehicle Collisions for Intersections by Collision Type
e HSM Table 12-13. Distribution of Single-Vehicle Crashes for Intersection by Collision Type

e NCHRP 17-58 Table 51. Distribution of multiple-vehicle collisions for roadway segments by manner of
collision type

e NCHRP 17-58 Table 52. Distribution of single-vehicle crashes for roadway segments by collision type for
arterials with six or more lanes

e NCHRP 17-58 Table 61. Distribution of total vehicle collisions for intersections with six or more lanes by
collision type

e NCHRP 17-58 Table 71. Distribution of multiple-vehicle collisions for roadway segments by manner of
collision type
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e NCHRP 17-58 Table 72. Distribution of single-vehicle crashes for roadway segments by collision type for
arterials with six or more lanes

e NCHRP 17-58 Table 79. Distribution of total vehicle collisions for 1x2 or 1x1 intersections by collision
o NCHRP 17-68 Table 10. Distributions for crash severity level at rural all-way stop-controlled intersections

e NCHRP 17-68 Table 11. Distributions for collision type and manner of collision and crash severity at rural
all-way stop-controlled intersections

e NCHRP 17-68 Table 13. Distributions for collision type and manner of collision and crash severity at urban
and suburban all-way stop-controlled intersections

e NCHRP 17-68 Table 26. Distributions for crash severity level at three-leg intersections with signal control
on rural two-lane highways

e NCHRP 17-68 Table 27. Distributions for collision type and manner of collision and crash severity at three-
leg intersections with signal control on rural two-lane highways

e NCHRP 17-68 Table 28. Distributions of intersection crashes by collision type and crash severity at three-
leg intersections with signal control on rural multilane highways

Crash Frequency

Number of crashes occurring at a particular site, facility, or network in a one-year period and is measured in number
of crashes per year.

Crash Modification Factor (CMF)

An index of how much crash experience is expected to change following a modification in design or traffic control.
CMF is the ratio between the number of crashes per unit of time expected after a modification or measure is
implemented and the number of crashes per unit of time estimated if the change does not take place.

Crash Prediction Algorithm

Procedure used to predict average crash frequency, consisting of three elements. It has two analytical components:
baseline models and crash modification factors, as well as a third component: crash histories.

Crash Rate

The number of crashes per unit of exposure. For an intersection, this is typically the number of crashes divided by
the total entering AADT; for road segments, this is typically the number of crashes per million vehicle-miles traveled
on the segment.

Crash Rate Method

A method that normalizes the frequency of crashes against exposure (i.e., traffic volume for the study period for
intersections, and traffic volume for the study period and segment length for roadway segments).

Crash Reduction Factor (CRF)

The percentage of crash reduction that might be expected after implementing a modification in design or traffic
control. The CRF is equivalent to (1 — CMF).

Crash Severity

The level of injury or property damage due to a crash, commonly divided into categories based on the KABCO
scale.
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Cross Section Lanes

The total number of through lanes in the segment. Rural Ramp Segments are limited to one lane. Urban ramp
segments are limited to two lanes. A segment with a lane-add or -drop taper is considered to have the same number
of through lanes as the roadway just downstream of the taper. If the segment ends at a ramp terminal, then the
number of through lanes is not based on the lane assignment, or lane markings, at the terminal.

Crossroad Median Width

This width is measured along a line perpendicular to the centerline of the crossroad in the vicinity of the intersection.
If no median exists, then a width of 0.0 ft (or 0.0 m in metric) is used in the predictive model. If a raised curb is
present, then the width is measured from face-of-curb to face-of-curb. If a raised curb is not present, then the width
is measured between the near edge of the traveled way for the two opposing travel directions. If a left turn bay is
present, then the median width includes the width of the left turn bay. It is measured from the lane line delineating
the bay to the face of curb adjacent to (or the near edge of the traveled way for) the opposing travel direction. If the
median width is different on the two crossroad legs, then use an average of the two widths.

Curb Length with On-Street Parking

This is the sum of curb length, in miles (or kilometers in metric), with on-street parking for both side of the road
combined. This can be determined from field measurements or video log review to verify parking regulations.
Estimates can be made by deducting from twice the roadway segment length allowances for intersections widths,
crosswalks, and driveway widths.

For one-way urban and suburban arterials, curb length with on-street parking is measured for the left side of the
road and the right side of the road separately.

Daily Pedestrian Volume

This is the sum of daily pedestrian volumes, in pedestrians/day, crossing all intersection legs.

Date

This field is provided to document the date when the analysis is performed.

Delete Horizontal Curve

For Freeway Segment, Ramp Segment, and Freeway Intersection analyses, a button for deleting a horizontal curve
is available when ‘Include Horizontal Curves’ is checked. Clicking on the button ‘Delete Horizontal Curve’ will delete
the row of inputs corresponding to the currently selected horizontal curve(s).

Delete Section

For facility analyses, a button for deleting a section is available. Clicking on the button ‘Delete Section’ will delete
the row of inputs corresponding to the currently selected section(s).

Distance from Inside Shoulder to Barrier

Measured from the nearest edge of traveled way to the barrier face. A barrier is associated with the freeway if the
offset from the near edge of traveled way is 30 feet of less. Barrier adjacent to a ramp, but also within 30 feet of the
freeway traveled way should also be associated with the freeway.
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Distance from Outside Shoulder to Barrier

Measured from the nearest edge of traveled way to the barrier face. A barrier is associated with the freeway if the
offset from the near edge of traveled way is 30 feet (or 9.1 meters in metric) or less. Barrier adjacent to a ramp, but
also within 30 feet (or 9.1 meters in metric) of the freeway traveled way should also be associated with the freeway.

Distance from Segment to Downstream Ramp

This is the distance from the segment endpoint to the next downstream exit ramp. If there is an exit ramp within the
segment, this value is equal to 0.

This value is computed separately for the increasing and decreasing milepost directions.

Downstream entrance ramps are not of direct interest, and data are not needed for them if they exist in the vicinity
of the segment.

b,ext b,ent

——————————_— Primary B o
Direction
| Secondary i
Direction

Segment of Interest

e,ent 2,ext

Distance from Segment to Upstream Ramp

This is the distance from the segment endpoint to the next upstream entrance ramp. If there is an entrance ramp
within the segment, this value is equal to 0.

This value is computed separately for the increasing and decreasing milepost directions.

Upstream exit ramps are not of direct interest, and data are not needed for them if they exist in the vicinity of the
segment.

b, ext bent

_________‘ Primary O, o
Direction
| Secondary {
Direction

Segment of Interest

e.ent e.ext

Distance to Adjacent Intersection

Distance to the next public street intersection on the outside crossroad leg. This data element represents the
distance between the subject ramp terminal and the nearest public street intersection located in a direction away
from the freeway (measured along the crossroad from the subject terminal center to the intersection center)
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Distance to Adjacent Ramp

This data element represents the distance between the subject ramp terminal and the adjacent ramp terminal
(measured along the crossroad from terminal center to terminal center). If there is no adjacent ramp terminal, then
use the distance to the next public street intersection (located in the direction opposite to the intersection described
by the distance to adjacent intersection data field).

Driveway Density

The number of driveways per mile (or per kilometers in metric) on both sides of the roadway combined.

Driveway Type
Seven specific driveway types have been considered in modeling. These are:
e Major commercial driveways
e Minor commercial driveways
e Major industrial/institutional driveways
e  Minor industrial/institutional driveways
e Maijor residential driveways
e Minor residential driveways
e Other driveways

Major driveways are those that serve sites with 50 or more parking spaces. Minor driveways are those that serve
sites with less than 50 parking spaces. It is not intended that an exact count of the number of parking spaces be
made for each site. Driveways can be readily classified as major or minor from a quick review of aerial photographs
that show parking areas or though user judgment based on the character of the establishment served by the
driveway. Commercial driveways provide access to establishments that serve retail customers. Residential
driveways serve single- and multiple-family dwellings. Industrial/institutional driveways serve factories, warehouses,
schools, hospitals, churches, offices, public facilities, and other places of employment. Commercial sites with no
restriction on access along an entire property frontage are generally counted as two driveways.
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The table below shows SPF coefficients for multiple-vehicle driveway related collisions:

Coefficients for Specific Roadway Types

Driveway Type (j) 2U 3T 4U 4D 5T

Number of Driveway-Related Collisions per Driveway per Year (N)

Major commereial 0.158 0.102 0.182 0.033 0.165
Minor commercial 0.050 0.032 0.058 0.011 0.053
Major industrial/institutional 0.172 0.110 0.198 0.036 0.181
Minor industrial/institutional 0.023 0.015 0.026 0.005 0.024
Major residential 0.083 0.053 0.096 0.018 0.087
Minor residential 0.016 0.010 0.018 0.003 0.016
Other 0.025 0.016 0.029 0.005 0.027

Regression Coefficient for AADT (t)

All driveways 1.000 1.000 1.172 1.106 1.172

Overdispersion Parameter (k)

All driveways 0.81 1.10 0.81 1.39 0.10

Proportion of Fatal-and-Injury Crashes (£, )

All driveways 0.323 0.243 0.342 0.284 0.269

Proportion of Property-Damage-Only Crashes

All driveways 0.677 0.757 0.658 0.716 0.731

Note: Includes only unsignalized driveways; signalized driveways are analyzed as signalized intersections. Major driveways serve 50 or more
parking spaces; minor driveways serve less than 50 parking spaces.

Economic Analysis

Societal Crash Costs:

The Federal Highway Administration (FHWA) has completed research that establishes a basis for quantifying, in
monetary terms, the human capital crash costs to society of fatalities and injuries from highway crashes. These
estimates include monetary losses associated with medical care, emergency services, property damage, lost
productivity, and the like, to society as a whole. They are not to be confused with damages that may be awarded to
a particular plaintiff in a personal injury or wrongful death lawsuit. Tort liability damages are based only on the
particularized loss to the individual plaintiff and are not allowed to include any societal costs of crashes, which can
be used if desired.

State and local jurisdictions often have accepted societal crash costs by crash severity and collision type. When
available, these locally-developed societal crash cost data are used with procedures in the HSM.

HSM Default Values:
e Fatal/Injury (K/A/B/C): $158,200
e PDO (O): $7,400

Because SPFs and CMFs do not always differentiate between fatal and injury crashes when estimating average
crash frequencies, many jurisdictions have established a societal cost that is representative of a combined
fatal/injury crash.

Empirical Bayes Analysis

Method used to combine observed crash frequency data for a given site with predicted crash frequency data from
many similar sites to estimate its expected crash frequency.

Entering AADT

Average annual daily traffic volume entering the intersection; measured in vehicles per day for each approach leg
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Entrance/Exit
Entrance ramps: Merge points
Exit ramps: Diverge points

Entry Width

The entry width should be measured per leg for each roundabout site. The entry width is measured at the entrance
line (i.e., the continuation of the inscribed circle diameter) and is the perpendicular width of the lane relative to a
vehicle entering the circulatory roadway. The width is measured from the splitter island curb to the curb face at the
outside edge of travel way. In the absence of a curb on the outside edge of travel way, the width is measured from
the splitter island curb face to the paved edge of travel way. Measurements should be entered in feet and rounded
to the nearest foot.

Exiting AADT

Average annual daily traffic volume exiting the intersection; measured in vehicles per day for each approach leg

Expected Average Crash Frequency

The estimate of long-term expected average crash frequency of a site, facility, or network under a given set of
geometric conditions and traffic volumes (AADT) in a given period of years. In the Empirical Bayes (EB)
methodology, this frequency is calculated from observed crash frequency at the site and predicted crash frequency
at the site based on crash frequency estimates at other similar sites.

Expected Average Crash Frequency, Change in

The difference between the expected average crash frequency in the absence of treatment and with treatment in
place.

Expected Crashes

As estimated of long-range average number of crashes per year for a particular type of roadway or intersection.

Facility

A length of highway that may consist of connected sections, segments, and intersections.

Facility Type
The facility types and facility site types in the HSM Part C are defined below.

e Chapter 10-Rural Two-Lane, Two-Way Roads—includes all rural highways with two-lanes and two-way
traffic operation. Chapter 10 also addresses two-lane two-way highways with center two-way left-turn lanes
and two-lane highways with added passing or climbing lanes or with short segments of four-lane cross-
sections (up to two miles in length) where the added lanes in each direction are provided specifically to
enhance passing opportunities. Short lengths of highway with four-lane cross-sections essentially function
as two-lane highways with side-by-side passing lanes, and therefore, are within the scope of the two-lane,
two-way highway methodology. Rural highways with longer sections of four-lane cross-sections can be
addressed with the rural multilane highway procedures in Chapter 11. Chapter 10 includes three- and four-
leg intersection with minor-road stop control and four-leg signalized intersections on all the roadway cross-
sections to which the chapter applies.
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Chapter 11-Rural Multilane Highways—includes rural multilane highways without full access control. This
includes all rural nonfreeways with four through travel lanes, except for two-lane highways with side-by-
side passing lanes, as described above. Chapter 11 includes three- and four-leg intersections with minor-
road stop control and four-leg signalized intersections on all the roadway cross-sections to which the
chapter applies.

e Chapter 12-Urban and Suburban Arterial Highways—includes arterials without full access control, other
than freeways, with two or four through lanes in urban and suburban areas. Chapter 12 includes three- and
four-leg intersections with minor-road stop control or traffic signal control and roundabouts on all of the
roadway cross-sections to which the chapter applies.

e Chapter 18-Freeways—have fully-restricted access control and grade separation with all intersecting
roadways. Freeways are accessed only through grade-separated interchanges. Roads having at-grade
access should be analyzed as rural highways or suburban arterials.

e Chapter 19—-Ramp/Ramp Terminals—applies to the following site types: entrance ramp segment with one
or two lanes, exit ramp segment with one or two lanes, C-D road segment with one or two lanes, and
crossroad ramp terminal. Connector ramp segments are represented using one of these site types.

Fixed-Object Density

In estimating the density of fixed objects, only point objects that are 4 inches (or 10.2 centimeters in metric) or more
in diameter and do not have breakaway design are considered. Point objects that are within 70 ft (or 21.3 meters in
metric) of one another longitudinally along the road are counted as a single object. Continuous objects that are not
behind point objects are counted as one point object for each 70 ft (or 21.3 meters in metric) of length.

The Fixed-Object Density is measured in fixed objects per mile (or per kilometer in metric), for both sides of the
road combined.

Fixed-Object Offset

The offset distance is an estimate of the average distance from the edge of the traveled way to roadside objects
over an extended roadway segment. If the average offset to fixed objects exceeds 30 ft (or 9.1 meters in metric),
use the value of offset for 30 ft (or 9.1 meters in metric). Only fixed objects on the roadside on the right side of the
roadway in each direction of travel are considered; fixed objects in the roadway median on divided arterials are not
considered.

Forward Direction

Setting the forward direction will indicate which approaches are on the major street and which approaches are on
the minor street.

Freeway Segment

When using the predictive method, the freeway within the defined project limits is divided into individual sites. A site
is either a homogenous freeway segment or a speed-change lane. A facility consists of a contiguous set of individual
sites. A roadway network consists of a number of contiguous facilities.

Three freeway segments are shown schematically in the figure below. They are labeled F; in the figure. The
presence of a speed-change lane adjacent to a freeway segment requires a reduction in the effective length of the
freeway segment. This reduction is used to account for the crashes assigned to the speed-change lanes. The
equation for computing the “effective” segment length is shown in the bottom of the figure for a freeway segment
with one ramp entrance and one ramp exit.
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Grade

The base condition for grade is a generally level roadway. The CMFs in the table below are applied to each
individual grade segment on the roadway being evaluated without respect to the sign of the grade. The sign of the
grade is irrelevant because each grade on a rural two-lane, two-way highway is an upgrade for one direction of
travel and a downgrade for the other. The grade factors are applied to the entire grade from one point of vertical
intersection (PVI) to the next (i.e., there is no special account taken of vertical curves). The CMFs in the following

table apply to total roadway segment crashes:

Approximate Grade (%)

Level Grade
(= 3%)

Moderate Terrain
(3%< grade = 6%)

Steep Terrain

(> 6%)

1.00

1.10

1.16
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Horizontal Curve

The presence or absence of horizontal curve (curve/tangent) is necessary to select a SPF and to determine whether
the site-specific conditions vary from the base conditions and, therefore, whether a CMF is applicable. If the
segment has one or more curve:

e Length of horizontal curve (miles, or kilometers in metric), (this represents the total length of the horizontal
curve and includes spiral transition curves, even if the curve extends beyond the limits of the roadway
segment being analyzed);

e Radius of horizontal curve (feet, or meters in metric);

e Presence or absence of spiral transition curve, even if the beginning and/or end of the horizontal curve are
beyond the limits of the segment being analyzed); and

e Superelevation of horizontal curve and the maximum superelevation (emax) used according to policy for the
jurisdiction, if available.

Horizontal Curve Length

Curve length is measured along the reference line from the point where the tangent ends and the curve begins (i.e.,
the PC) to the point where the curve ends, and the tangent begins (PT). If the curve PC and PT do not lie on the
reference line, then they must be projected onto this line and the curve length measured between these projected
points along the reference line.

If the curve has spiral transitions, then measure from the “effective” PC point to the “effective” PT point. The effective
PC point is located midway between the TS and SC, where the TS is the point of change from tangent to spiral and
the SC is the point of change from spiral to circular curve. The effective PT is located midway between the CS and
ST, where CS is the point of change from circular curve to spiral and ST is the point of change from spiral to tangent.

The length of curve in segment is the length of the curve within the boundaries of the segment (or speed-change
lane). This length cannot exceed the segment length or the curve length.

Horizontal Curve Radius

Radius is measured separately for each roadbed curve. The line used to define curve radius is the inside edge of
the traveled way. This line is established separately on each roadbed. If the curve has spiral transitions, then use
the radius of the central circular portion of the curve.

lllinois State

A checkbox is provided to indicate if the site under analysis is in lllinois. If checked, the lllinois state indicator variable
is 1.0. If not, it is 0.0. This indicator variable is used in the safety performance function calculations.

The project database was developed using data from five states: Texas, Illinois, California, Michigan, and Oregon.
These states were selected based on the state-owned mileage of the two street categories of interest and the
availability of crash data.

Crash and roadway data from California and lllinois were obtained from the Highway Safety Information System
(HSIS), while data from Texas, Michigan, and Oregon were obtained directly from the state highway agencies. Data
from Texas, lllinois, and California comprised the bulk of the project database. Data from Oregon were later added
to increase the mileage of one-way streets, and data from Michigan were added to increase the number of
intersections in the sample.

Data for the five states were combined for model calibration and the development of crash modification factors
(CMFs). These data were enriched through the inclusion of additional road inventory data extracted from Google
Earth and Google Street View. The enhanced database was then combined with the crash data to form the highway
safety database needed for model and CMF development and calibration.
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Include Horizontal Curves
If the segment includes 1 or more horizontal curves, select this box to input additional information about the curves.

For Rural Two-Lane Undivided Segments, segment endpoints should be located at the Point of Curvatures and the
Point of Tangency of each curve, limiting each segment to either no curves, or the entire segment is a curve. To
calculate values for multiple segments, use the Rural Facility Module.

Inscribed Circle Diameter

The inscribed circle diameter (ICD) is the parameter used to discuss the general size of a roundabout. It is the
diameter of the largest circle that can be inscribed within the outer edges of the circulatory roadway. The ICD serves
as the width of the roundabout. The measurement is taken in feet and rounded to the nearest integer (or meters
and rounded to the nearest tenth of a meter in metric).

Insert Horizontal Curve

For Freeway Segment, Ramp Segment, and Freeway Intersection analyses, a button for inserting a horizontal curve
is available when ‘Include Horizontal Curves’ is checked.

For Freeway Segment and Speed Change Lanes analyses, clicking on the button ‘Insert Horizontal Curve’ will add
a row of inputs before the selected row. The added row includes the following inputs: Primary Radius, Secondary
Radius, and Length in Segment. For Ramp Segment and C-D Road Segment analyses, clicking on the button ‘Insert
Horizontal Curve’ will add a row of inputs before the selected row. The added row includes the following inputs:
Radius of Curve, Average Entry Speed, and Length in Segment.

The user can insert an unlimited number of horizontal curves.

Insert Section

For facility analyses, a button for inserting a section is available. A row of inputs must be selected before inserting
a section. Clicking on the button ‘Insert Section’ will add a row of inputs before the selected row. The added row
includes the following inputs: Section Type, Facility Type, Model Type, Details, N(spf), and N(predicted). Section
Type can either be Segment or Intersection. Facility Type can either be Rural Two-Lane or Rural Multilane in a
Rural Facility analysis. Facility Type can only be Urban in an Urban Facility analysis. Section Type and Facility Type
cannot be changed within the rows. They must be specified before the new section is added. Model Type can be
changed within the rows and the choices available are dependent on Section Type and Facility Type combinations.
Clicking on Details within a row will bring the user to the Details page for that specific section. N(spf) specifies the
predicted average crash frequency for base conditions for that individual section. N(predicted) specifies the
predicted average crash frequency for that individual section, which is dependent on the inputs specified on the
Details page. The user can add an unlimited number of sections.

Inside Shoulder Width

Represents only the paved width, and is an average for both roadbeds. Should be measured where the cross
section is constant, and should not be measured where one or more edges are discontinuous or tapered. If a width
varies along the segment or speed change lane (but not enough to justify beginning a new segment), then compute
the length-weighted average widths. Rules for defining segment boundaries are provided in section 18.5.2.

Interchange

Intersections that consist of structures that provide for the cross-flow of traffic at different levels without interruption,
thus reducing delay, particularly when volumes are high.

Interchange Ramp Terminal

A junction with a surface street to serve vehicles entering or exiting a freeway.
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Intersection

General area where two or more roadways or highways meet, including the roadway, and roadside facilities for
pedestrian and bicycle movements within the area.

Intersection Related Crash

A crash that occurs at the intersection itself or a crash that occurs on an intersection approach within 250 ft (or 76.2
meters in metric) of the intersection and is related to the presence of the intersection.

Is Controlled Right Turn

This information is needed only for the exit ramp. It is focused on the right turn movement, which may have a
different control type than the left-turn movement. Control types considered include: free flow, merge, yield, stop,
and signal (where free-flow and merge operation are recognized to represent "no control").

Is Left Side Ramp

Ramp Entrance or Exit on left side of the roadbed.

Is Major Street One-Way

A checkbox is provided to indicate whether or not the major street is one-way. If checked, the method type used
will be One-Way.

Is Minor Street One-Way

A checkbox is provided to indicate whether or not the minor street is one-way. If checked, the one-way on minor
street indicator variable is 1.0. If not, it is 0.0. This indicator variable is used in the safety performance function
calculations.

Jurisdiction

This field is provided to document any jurisdiction convention or project related information.

KABCO

An injury scale developed by the National Safety Council to measure the observed injury severity for any person
involved as determined by law enforcement at the scene of the crash. The acronym is derived from (Fatal Injury
(K), Incapacitating Injury (A), Non-Incapacitating Injury (B), Possible Injury (C), and No Injury (O).) The scale can
also be applied to crashes, for example, a K crash would be a crash in which the most severe injury was a fatality,
and so forth.

Lane Width

The lateral distance, measured in feet (or meters in metric), between stripes for a given lane.

Lanes Added

Lane added to the ramp segment or C-D road, not as a result of a second merging ramp. If a lane is added, then
the length of the taper in the segment is needed.
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Lanes Dropped

Lane dropped from the ramp segment or C-D road, not as a result of a second diverging ramp. If a lane is dropped,
then the length of the taper in the segment is needed.

Lanes, Primary Direction

Number of through lanes in the increasing milepost direction. Rural Freeways are limited to eight lanes. Urban
Freeways are limited to ten lanes. A segment with a lane add or drop taper is considered to have the same number
of through lanes as the roadway just downstream of the taper.

Lanes, Secondary Direction

Number of through lanes in the decreasing milepost direction. Rural Freeways are limited to eight lanes. Urban
Freeways are limited to ten lanes. A segment with a lane add or drop taper is considered to have the same number
of through lanes as the roadway just downstream of the taper.

Left-Turn Lane Present on Crossroad Leg

The lane (or bay) can have one or two lanes. A lane (or bay) is considered to be present when it (a) is for the
exclusive use of a turn movement, (b) extends 100 ft or more back from the stop line, and (c) ends at the intersection
stop line.

Left-Turn Lane Width

This variable represents the total width of all lanes that exclusively serve turning vehicles on the subject approach.
It is measured from the near edge of the traveled way of the adjacent through lane to the near lane marking (or curb
face) that delineates the median.

Left-Turn Lanes

The lane (or bay) can have one or two lanes. A lane (or bay) is considered to be present when it (a) is for the
exclusive use of a turn movement, (b) extends 100 ft or more back from the stop line, and (c) ends at the intersection
stop line.

The base condition for intersection left-turn lanes is the absence of left-turn lanes on the intersection approaches.
CMFs apply to installation of left-turn lanes on any approach to a signalized intersection but only on uncontrolled
major-road approaches to stop-controlled intersections. The CMFs for installation of left-turn lanes on multiple
approaches to an intersection are equal to the corresponding CMF for installation of a left-turn on one approach
raised to a power equal to the number of approaches with left-turn lanes. There is no indication of any change in
crash frequency for providing a left-turn lane on an approach controlled by a stop sign, so the presence of a left-
turn lane on a stop-controlled approach is not considered in applying the table found below:

Number of Approaches with Left-Turn Lanes®

Intersection Type Intersection Traffic Control One Approach  Two Approaches Three Approaches Four Approaches
Three-leg intersection ~ Minor-road stop control® 0.67 0.45 = —

Traffic signal 0.93 0.86 0.80 —
Four-leg intersection Minor-road stop control® 0.73 0.53 — —

Traffic signal 0.90 0.81 0.73 0.66

* Stop-controlled approaches are not considered in determining the number of approaches with left-tumn lanes.
" Stop signs present on minor-road approaches only.

The CMFs in the table apply to total intersection crashes (not including vehicle-pedestrian and vehicle-bicycle
collisions). A CMF of 1.00 is always used when no left-turn lanes are present.
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Left-Turn Phasing

Types of left-turn signal phasing considered include permissive, protected, protected/permissive, and
permissive/protected. Protected/permissive operation is also referred to as a leading left-turn signal phase;
permissive/protected operation is also referred to as a lagging left-turn signal phase. The base condition for the
Intersection Left-Turn Signal Phasing CMF is permissive left-turn signal phasing. This CMF applies to total
intersection crashes (not including vehicle-pedestrian and vehicle-bicycle collisions) and is applicable only to
signalized intersections. A CMF value of 1.00 is always used for unsignalized intersections.

If several approaches to a signalized intersection have left-turn phasing, the values of CMF,; for each approach are
multiplied together.

Length

The distance, in miles (or kilometers in metric), from end to end of the segment.

Lighting

Artificial lighting is often provided on roadway segments in urban and suburban areas. Lighting is also often provided
at rural locations where road users may need to make a decision.

Maximum Lanes Crossed by Pedestrian

The values of nianesx in Equation 12-29 represents the maximum number of traffic lanes that a pedestrian must cross
in any crossing maneuver at the intersection. Both through and turning lanes that are crossed by a pedestrian along
the crossing path are considered. If the crossing path is broken by an island that provides a suitable refuge for the
pedestrian so that the crossing may be accomplished in two (or more) stages, then the number of lanes crossed in
each stage is considered separately. To be considered as a suitable refuge, an island must be raised or depressed;
a flush or painted island is not treated as a refuge for purposes of determining the values of Njanesx-

Median

The portion of a divided highway separating the traveled ways from traffic in opposite directions.

Median Barriers

Median barriers are devices used to prevent a vehicle from striking a more severe obstacle or feature located in the
median or to prevent crossover median crashes.

Median Width

The width, in feet (or meters in metric), of the median, which is the portion of a divided highway separating the
traveled ways from traffic in opposite directions.

Method Type

This indicates the method used for urban intersection calculations. The three method types include: General, Six or
More Lanes, and One-Way. The General methodology can be found in Chapter 12 of the Highway Safety Manual.
The Six or More Lanes methodology can be found in Chapter 6 of NCHRP 17-58. The One-Way methodology can
be found in Chapter 8 of NCHRP 17-58.

Michigan State

A checkbox is provided to indicate if the site under analysis is in Michigan. If checked, the Michigan state indicator
variable is 1.0. If not, it is 0.0. This indicator variable is used in the safety performance function calculations.
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The project database was developed using data from five states: Texas, Illinois, California, Michigan, and Oregon.
These states were selected based on the state-owned mileage of the two street categories of interest and the
availability of crash data.

Crash and roadway data from California and lllinois were obtained from the Highway Safety Information System
(HSIS), while data from Texas, Michigan, and Oregon were obtained directly from the state highway agencies. Data
from Texas, lllinois, and California comprised the bulk of the project database. Data from Oregon were later added
to increase the mileage of one-way streets, and data from Michigan were added to increase the number of
intersections in the sample.

Data for the five states were combined for model calibration and the development of crash modification factors
(CMFs). These data were enriched through the inclusion of additional road inventory data extracted from Google
Earth and Google Street View. The enhanced database was then combined with the crash data to form the highway
safety database needed for model and CMF development and calibration.

Minor Street

The lower volume street controlled by stop signs at a two-way or four-way stop-controlled intersection; also referred
to as a side street. The lower volume street at a signalized intersection.

Model Type
This specifies the Site Type for the combination of Facility Type and Section Type being analyzed.
See also Site Type.

Multilane Highway

A highway with at least two lanes for the exclusive use of traffic in each direction, with no control, partial control, or
full control of access, but that may have periodic interruptions to flow at signalized intersections.

Non-Ramp Public Street Leg

This situation occurs occasionally. When it does, the public street leg is opposite from one ramp, and the other
ramp either does not exist or is located at some distance from the subject ramp terminal such that it is not part of
the terminal. This information is needed only for signalized terminals.

Number of Access Points

An access point is a driveway (not a public roadway) located along one of the legs of the roundabout of interest.
The count of access points on a leg represents the number of driveways or unsignalized access points on the leg
(either side) within 250 feet (or 76.2 meters in metric) of the yield line.

Number of Alcohol Sales Establishments

The number of alcohol sales establishments within 1,000 ft (or 304.8 meters in metric) of the center of an
intersection. The base condition for alcohol sales establishments is the absence of alcohol sales establishments
near the intersection. Any alcohol sales establishments wholly or partly within 1,000 ft (or 304.8 meters in metric)
of the intersection may be counted.

The CMF for alcohol sales establishments indicates that an intersection with alcohol sales establishments nearby
is likely to experience more vehicle-pedestrian collisions than an intersection without alcohol sales establishments
even if the traffic and pedestrian volumes at the two intersections are identical. This indicates the likelihood of higher
risk behavior on the part of either pedestrians or drivers near alcohol sales establishments. The CMF includes any
alcohol sales establishment which may include liquor stores, bars, restaurants, convenience stores, or grocery
stores. Alcohol sales establishments are counted if they are on any intersection leg or even on another street, as
long as they are within 1,000 ft (or 304.8 meters in metric) of the intersection being evaluated.
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Number of Bus Stops

The number of bus stops within 1,000 ft (or 304.8 meters in metric) of the center of the intersection. The base
condition for bus stops is the absence of bus stops near the intersection.

Multiple bus stops at the same intersection (i.e., bus stops in different intersection quadrants or located some
distance apart along the same intersection leg) are counted separately. Bus stops located at adjacent intersections
would also be counted as long as any portion of the bus stop is located within 1,000 ft (or 304.8 meters in metric)
of the intersection being evaluated.

Number of Channelized Right-Turn Approaches

This indicates the number of approaches with channelized right-turn lanes. It is used in the calculation of the Right-
Turn Channelization CMF for intersections of six-or-more lane arterials.

Number of Circulating Lanes

The number of circulating lanes represents the count of circulating lanes immediately downstream of the entry that
forms the end of the segment under study.

Number of Crossroad Lanes

Lanes on the cross road. This value only include lanes that continue through the intersection. Count the lanes along
the crosswalk (or the logical location of the crosswalk if it is not marked).

Number of Driveways

The number of driveways of a specific type, nj, is the sum of the number of driveways of that type for both sides of
the road combined. The number of driveways is determined separately for each side of the road and then added
together.

See also Driveway Type.

Number of Entering Lanes

The number of entering lanes represents the count of lanes entering the roundabout for each leg. The number of
entering lanes per leg does not include right-turn bypass lanes on the leg.

Number of Exiting Lanes

The number of exiting lanes represents the count of lanes exiting the roundabout for each leg. The number of exit
lanes per leg does not include any lanes that may be formed from a bypass lane.

Number of Lanes Serving the Exit Ramp

Lanes can serve any movement. If right turn channelization is provided, then count the lanes at the last point where
all exiting movements are joined (i.e., count at the channelization gore point). All lanes counted must be fully
developed for at least 100 ft before intersecting the crossroad. If a lane's development length is less than 100 ft,
then it is not counted as a lane for this application. The lane (or lanes) associated with the loop exit ramp at a B4
terminal configuration are not included in this count.
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Number of Legs

A leg of a roundabout should be counted as such it is a public roadway (i.e., not a private driveway). A leg does not
need to accommodate two-way traffic. A leg can, but does not need to, separate opposing traffic with a physical or
painted splitter island. Options are provided for 4-leg and 3-leg roundabouts.

Number of Luminaires

A luminaire is a light fixture that appears to have been designed to illuminate the roadway right-of-way along the
legs of the roundabout and through a roundabout. Luminaires do not include adjacent lighting that is oriented to
illuminate roadside buildings or features like billboards or other advertising signs. The number of luminaires
represents the count of luminaires within 250 feet (or 76.2 meters in metric) of the roundabout entry point on each

leg.

Number of Railroad Crossings

This indicates the number of railroad-highway crossings within the limits of the roadway segment. It is used in the
calculation of the Railroad Crossing Presence CMF for six-or-more lane arterials.

Number of Through Lanes on Major Street

This indicates the number of through lanes on the major street. It is used in the calculation of the Number of Lanes
CMF.

If the number of lanes is 5 or less, the method type used will be General. If the number of lanes is 6 or more, the
method type used will be Six or More Lanes. If ‘Is Major Street One-Way?’ is checked, the method type used will
be One-Way and the number of through lanes on major street will have no influence on the method type used.

Number of Through Lanes on Minor Street

This indicates the number of through lanes on the minor street. It is used in the calculation of the Number of Lanes
CMF.

Number of Traffic Lanes that Oppose Left Turn

Number of lanes on the crossroad that conflict with left turn movements

Number of Unsignalized Driveways

This number represents the count of unsignalized driveways on the outside crossroad leg and within 250 feet (or
76.2 meters in metric) of the ramp terminal. The count is taken on both sides on the leg (two travel directions). The
count should only include "active" driveways (i.e., those driveways with an average daily volume of 10 veh/day or
more).

Number of Unsignalized Public Street Approaches

This number represents the count of unsignalized public street approaches on the outside crossroad leg and within
250 feet (or 76.2 meters in metric) of the ramp terminal. The count is taken on both sides on the leg (two travel
directions). If a public street is present at the terminal, then it is not counted for this entry.

See Non-Ramp Public Street Leg.

Number of Years of Observed Crashes

The Empirical Bayes analysis uses prior years of observed crash history to estimate the expected crash frequency.
This is the number of years of observed crashes used. The Highway Safety Manual recommends at least 2 years
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of observed crash history should be used. Each year of observed crash history used should have the same
geometric conditions as reported on the details page.

Observed Crashes

Observed crashes for this segment or intersection occurring during the years specified. Crashes should be assigned
to the appropriate segment or intersection depending on the appropriate criteria:

1. All crashes occurring within the curb-line limits of the intersection are assigned to the intersection

2. Other crashes are assigned to the segment or the intersection depending on their characteristics. Crashes
classified on the crash report as intersection-related or have characteristics consistent with an intersection
related crash are assigned to the intersection to which they are related; such crashes would include rear-
end collisions related to queues on an intersection approach. Crashes that occur between intersections and
are not related to an intersection, such as collisions related to turning maneuvers at driveways, are assigned
to the roadway segment on which they occur.

Outbound Leg associated with a Ramp Terminal

A roundabout is considered a ramp terminal intersection if one or more of the legs connected to the roundabout is
a ramp leading to a controlled access facility, such as a freeway. This adjustment only applies to one-way outbound-
legs (i.e. legs connected to an on-ramp that only serve exiting traffic from a roundabout). Checkboxes are provided
to indicate if the subject leg is an outbound leg associated with a ramp terminal.

Outside Shoulder Width

Represents only the paved width, and is an average for both roadbeds. Should be measured where the cross
section is constant, and should not be measured where one or more edges are discontinuous or tapered. If a width
varies along the segment or speed change lane (but not enough to justify beginning a new segment), then compute
the length-weighted average widths. Rules for defining segment boundaries are provided in section 18.5.2.

Parking

There are two broad types of parking facilities: at the curb or on-street parking, and off-street parking in lots or
parking structures. Parking safety is influenced by a complex set of driver and pedestrian attitudinal and behavioral
patterns.

Certain kinds of crashes may be caused by curb or on-street parking operations, these include:

e Sideswipe and rear-end crashes resulting from lane changes due to the presence of a parking vehicle or
contact with a parked car;

e Sideswipe and rear-end crashes resulting from vehicles stopping prior to entering the parking stall;

e Sideswipe and rear-end crashes resulting from vehicles exiting parking stalls and making lane changes;
and

e Pedestrian crashes resulting from passengers alighting from the street-side doors of parked vehicles, or
due to pedestrians obscured by parked vehicles.

Parking Type

There are three types of on-street parking. These include: No Parking, Parallel Parking, and Angle Parking. No
Parking is when parking is prohibited on the street. Parallel parking is when the vehicle parks aligned with the road.
Angle parking is when the vehicle parks on a specified angle to the curb.

Passing Lane

A lane added to improve passing opportunities in one or both directions of travel on a two-lane highway.
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The base condition for passing lanes is the absence of a lane (i.e., the normal two-lane cross section). The CMF
for a conventional passing or climbing lane added in one direction of travel on a rural two-lane, two-way highway is
0.75 for total crashed in both directions of travel over the length of the passing lane from the upstream end of the
lane addition taper to the downstream end of the lane drop taper. This value assumes that the passing lane is
operationally warranted, and that the length of the passing lane is appropriate for the operational conditions on the
roadway. There may also be some safety benefit on the roadway downstream of a passing lane, but this effect has
not been quantified.

Pedestrian

A person traveling on foot or in a wheelchair

Pedestrian Activity

Pedestrian crossing volumes are categorized into general levels of Pedestrian Activity. There are five level of
pedestrian activity. These include: High, Medium-high, Medium, Medium-low, and Low. The following table shows
estimates of pedestrian crossing volumes based on general level of pedestrian activity.

Estimate of Ped Vol (pedestrians/day)
for Use in Equation 12-29

General Level of Pedestrian Activity 3SG Intersections 4SG Intersections
High 1,700 3,200
Medium-high 750 1,500
Medium 400 700
Medium-low 120 240

Low 20 50

Pedestrian Crash Adjustment Factor

For roadway segments, fpeqr is the pedestrian crash adjustment factor. It is used in the determination of the number
of vehicle-pedestrian collisions per year for a roadway segment. The values of fpeqr are likely to depend on the
climate and the walking environment in particular states or communities. The following tables show the pedestrian
crash adjustment factors for roadway segments, but users are encouraged to replace the values in the table with
suitable values for their own state or community through the calibration process.
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Table 53. Pedestrian crash adjustment factor for two-way roadway segments.
A Road Pedestrian Crash Adjustment Factor (fped.)
Type Posted Speed 30 mph or Lower Posted Speed Greater Than 30 mph
. Total - Total

:\“1;1;)91 Pe(nlrec.::tf:‘lian MY ama Fpear _\m{?fbﬂ Pe;-ez'tt}:'lian MV amd Tpear

Segments Crashes S‘_‘ Segments Crashes . i }

Crashes® Crashes?

- 2U 0.036 0.005
u T 0.041 0.013
© |4 0.022 0.009
= |4D 0.067 0.019
= [sr 0.030 0.023
= 6U 22 10 549 0.018 72 18 1359 0.013
g 6D 106 69 2371 0.029 1661 369 24720 0.015
S 1t |16 11 324 0.034 | 250 138 10016 | 0.014
= [sp |1 I 612 122 150 6623 0.023

Note: Shaded cell = data not available.
2 Excludes pedestrian and bicycle crashes.

Table 73. Pedestrian crash adjustment factor for one-way roadway segments.
Pedestrian Crash Adjustment Factor (fpedr)
Posted Speed 30 mph or Lower Posted Speed Greater Than 30 mph
. Road " Total . Total
Source Number Total PR Number Total E
Lype of Pedestrian }I\S‘:!nd Tped of Pedestrian Z\I‘\S‘:}nd Tpea
Segments Crashes Cibishia Segments Crashes Crashes®
2 20 774 48 2767 0.017 276 12 676 0.018
§ 30 395 52 2217 0.024 162 15 911 0.017
~ 40 81 7 342 0.021 57 12 405 0.030

* Excludes pedestrian and bicycle crashes.

For intersections, fu.qi is the pedestrian crash adjustment factor. It is used in the determination of the number of
vehicle-pedestrian collisions per year for a stop-controlled intersection. The values of fqi are likely to depend on
the climate and walking environment in particular states or communities. The following table shows the pedestrian
crash adjustment factors for stop-controlled intersections, but users are encouraged to replace the values in the
table with suitable values for their own state or community through the calibration process.

Table 12-29. Pedestrian Crash Adjustment Factors for Stop-Controlled Intersections

Intersection Category Intersection Type Pedestrian Crash Adjustment Factor (fpeas)

35T 0.021
2x2 with five or fewer lanes ;

4ST 0.022

38T 0.051
2x2 with six or more lanes

4ST 0.049
152 or 1x1 35T 0.015
R AST 0.020

Note: These factors apply to the methodology for predicting total crashes (all severity levels combined). All pedestrian collisions resulting from this
adjustment factor are treated as FI crashes and none as PDO crashes.

Source: HSIS data from California (2002-2006) for 2x2 intersections with five or fewer lanes; HSIS data from California and Illinois (2006-2010) and
state data from Texas (2008-2012) and Michigan (2008-2012) for other intersection categories.
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Pedestrian Crosswalk

Pedestrian roadway crossing facility that represents a legal crosswalk at a particular location.

Pedestrian Refuge

An at-grade opening within a median island that allows pedestrians to wait for an acceptable gap in traffic.

Posted Speed

This is the speed limit, in mi/h (or km/h in metric), that is posted for the roadway.

Predicted Average Crash Frequency

The estimate of long-term average crash frequency which is forecast to occur at a site using a predictive model
found in Part C of the HSM.

Predictive Method

The methodology in Part C of the HSM used to estimate the ‘expected average crash frequency’ of a site, facility,
or roadway under given geometric conditions, traffic volumes, and period of time.

Presence of School

The base condition for schools is the absence of a school near the intersection. The CMF for schools within 1,000
ft (or 304.8 meters in metric) of the center of the intersection is presented in the following table:

Presence of Schools within 1,000 ft of the Intersection (‘MF:‘,
No school present 1.00
School present 1.35

A school may be counted if any portion of the school grounds is within 1,000 ft (or 304.8 meters in metric) of the
intersection. Where one or more schools are located near the intersection, the value of the CMF is independent of
the number of schools present. This CMF applies to total vehicle-pedestrian collisions.

This CMF indicates that an intersection with a school nearby is likely to experience more vehicle-pedestrian
collisions than an intersection without schools even if the traffic and pedestrian volumes at the two intersections are
identical. Such increased crash frequencies indicate that school children are at higher risk than other pedestrians.

Project Description

This field is provided for the user to document the analysis with any information for identification purposes.

Project-Level Parameters

A checkbox is provided on the General page of a facility analysis for the user to indicate if parameters should be
applied on a level that is project wide or if separate section-level parameters should be provided on the Details page
of each section. Checking the box will indicate the project-level parameters will be applied to all the corresponding
sections. Leaving the checkbox unchecked will indicate each section will apply its own parameters.
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Proportion of AADT during High Volume Hours

Proportion of freeway AADT volume that occurs during hours where the lane volume exceeds 1,000 vehicles per
hour per lane. If local data is not available, a default value can be computed as 1.0 — exp(1.45 — 0.000124 x AADT
/ n), where n is the number of lanes in both directions, and AADT is total AADT for both directions.

Proportion of Barrier on Outside Shoulder

Length of barrier present divided by length of segment

Proportion of Crashes that Occur at Night

For segments, this is the proportion of total crashes for unlighted roadway segments that occur at night. It is denoted
by pn~. The tables below show the nighttime crash proportions for unlighted roadway segments based on roadway

type.
Rural Two-Lane, Two-Way Roads (Chapter 10)

Proportion of Total Nighttime Crashes by Severity Level Proportion of Crashes that Occur at Night
Roadway Tvpe Fatal and Injury p, PDO B o P,
2U 0.382 0.618 0.370

Note: Based on HSIS data for Washington (2002-2006)

Rural Multilane Highways (Chapter 11)

Proportion of Crashes that

Roadway Type Proportion of Total Night-Time Crashes by Severity Level Occur at Night
Fatal and Injury p, PDO Py Py
4U 0.361 0.639 0.255

Proportion of Crashes that

Proportion of Total Nighttime Crashes|by Severity Level Occur at Night
Roadway Type Fatality and Injury p_ PDO D P,
4D 0.323 0.677 0.426

Urban and Suburban Arterials (Chapter 12)

Proportion of Total Nighttime Crashes by Severity Level Proportion of Crashes that Occur at Night

Roadway Segment Type Fatal and Injury p, PDO Dy P

20 0424 0.576 0316
3T 0.429 0.571 0.304
4U 0.517 0483 0.365
4D 0.364 0.636 0410
5T 0432 0.568 0.274

For intersections, this is the proportion of total crashes for unlighted intersections that occur at night. It is denoted
by pni. The tables below show the nighttime crash proportions for unlighted intersections.
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Rural Two-Lane, Two-Way Roads (Chapter 10)

Proportion of Crashes that Occur at Night

Intersection Type P,

38T 0.2-60
48T 0.244
4SG 0.286

Note: Based on HSIS data for California (2002-2006)

Rural Multilane Highways (Chapter 11)

Intersection Type Proportion of Crashes that Occur at Night, p .
3ST 0.276
4ST 0.273

Urban and Suburban Arterials (Chapter 12)

Proportion of Crashes that Occur at ?‘iight|

Intersection Type Py

3ST 0.238
45T 0.229
35G and 45G 0:235

Proportion of Fatal-and-Injury Crashes for Combined Sites

Since there are no models for fatal-and-injury crashes at three- and four-leg stop-controlled urban intersections
(3ST and 4ST) in HSM Table 12-12, HSM Equation 12-25 is replaced with the following equation in these cases:

Nhisviryy = Nbisvtotaly % Toisv
where:
frisv = proportion of fatal-and-injury crashes for combined sites.

The default value of fyisy is 0.31 for 3ST and 0.28 for 4ST intersections. It is recommended that these default values
be updated based on locally available data.

Proportion of Length Adjacent to Speed Change Lane

If there is a speed change area due to a second merging or diverging ramp, this is the length of that speed change
area divided by the length of the segment.

Proportion of Length Adjacent to Taper
This is the length of the taper within the segment divided by the segment length.

Proportion of Length within a Type B Weaving Section

This weaving section has the following characteristics: (a) one of the two weaving movements can be made without
making any lane changes, (b) the other weaving movement requires at most one lane change, and (c) the ramp
entrance and ramp exit associated with the weaving section are located on the right side of the freeway.

86 - Glossary of Terms Highway Safety Software User Guide



Typical Type B weaving sections are shown in the figure below.

a. Major Weave with Lane Balance
at Exit Gore

b. Major Weave with Merge
at Entry Gore

c. Major Weave with Merge at Entry
Gore and Lane Balance at Exit Gore

Other weaving section types are addressed directly by the predictive method.

The proportion is the length of the weaving section located in the segment divided by the length of the segment.
This value is computed separately for the increasing and decreasing milepost directions.

Proportion of Length within a Weaving Segment

Computed as the ratio of the length of the weaving section in the segment to the length of the segment. If the
segment is wholly located in the weaving section, then this variable is equal to 1.0.

Proportion of Median Barrier Length

Length of barrier present divided by the length of segment. A barrier is associated with the freeway if the offset from
the near edge of traveled way is 30 feet (or 9.1 meters in metric) or less. Barrier adjacent to a ramp, but also within
30 feet (or 9.1 meters in metric) of the freeway traveled way should also be associated with the freeway.

Proportion of Multiple-Vehicle Crashes Represented by Rear-End Collisions

This is the proportion of crashes that are multiple-vehicle, rear-end collisions and it is denoted by pr. The proportion
of multiple-vehicle fatal-and-injury crashes represented by rear-end collisions is denoted by premvry. The proportion
of multiple-vehicle property-damage-only crashes represented by rear-end collisions is denoted by premvirpoy).

These proportions are used in the calculation of the Red Light Cameras CMF, rather than the proportions provided
in the crash distributions tables. The defaults between the two are the same, but they can all be edited.

Proportion of Multiple-Vehicle Crashes Represented by Right-Angle
Collisions

This is the proportion of crashes that are multiple-vehicle, right-angle collisions and it is denoted by pr. The
proportion of multiple-vehicle fatal-and-injury crashes represented by right-angle collisions is denoted by pramv(F).
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The proportion of multiple-vehicle property-damage-only crashes represented by right-angle collisions is denoted
by Pramv(PDO).

These proportions are used in the calculation of the Red Light Cameras CMF, rather than the proportions provided
in the crash distributions tables. The defaults between the two are the same, but they can all be edited.

Proportion of Nighttime Crashes that Involve a Fatality

This is the proportion of total nighttime crashes for unlighted roadway segments that involve a fatality or injury. It is
denoted by pin-. The tables below show the nighttime crash proportions for unlighted roadway segments based on
roadway type.

Rural Two-Lane, Two-Way Roads (Chapter 10)

Proportion of Total Nighttime Crashes by Severity Level Proportion of Crashes that Occur at Night
Roadway Tvpe Fatal and Injury p, PDO B o P,
2U 0.382 0.618 0.370

Note: Based on HSIS data for Washington (2002-2006)

Rural Multilane Highways (Chapter 11)

Proportion of Crashes that

Roadway Type Proportion of Total Night-Time Crashes by Severity Level Occur at Night
Fatal and Injury p, PDO Py P,
4U 0.361 0.639 0.255

Proportion of Crashes that

Proportion of Total Nighttime Crashes|by Severity Level Occur at Night
Roadway Type Fatality and Injury p_ PDO D P,
4D 0.323 0.677 0.426

Urban and Suburban Arterials (Chapter 12)

Proportion of Total Nighttime Crashes by Severity Level Proportion of Crashes that Occur at Night

Roadway Segment Type Fatal and Injury p, PDO P P,

20 0424 0.576 0316
3T 0.429 0.571 0.304
4U 0.517 0483 0.365
4D 0.364 0.636 0410
5T 0432 0.568 0.274

Proportion of Nighttime Crashes that Involve Property Damage

This is the proportion of total nighttime crashes for unlighted roadway segments that involve property damage only.
It is denoted by ppn. The tables below show the nighttime crash proportions for unlighted roadway segments based
on roadway type.
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Rural Two-Lane, Two-Way Roads (Chapter 10)

Proportion of Total Nighttime Crashes by Severity Level Proportion of Crashes that Occur at Night
Roadway Tvpe Fatal and Injury p, PDO . P,
2U 0.382 0.618 0.370

Note: Based on HSIS data for Washington (2002-2006)

Rural Multilane Highways (Chapter 11)

Proportion of Crashes that

Roadway Type Proportion of Total Night-Time Crashes by Severity Level Occur at Night
Fatal and Injury p, PDO . P,
4U 0361 0.639 0.255

Proportion of Crashes that

Proportion of Total Nighttime Crashes|by Severity Level Occur at Night
Roadway Type Fatality and Injury p_ PDO D P,
4D 0.323 0.677 0.426

Urban and Suburban Arterials (Chapter 12)

Proportion of Total Nighttime Crashes by Severity Level Proportion of Crashes that Occur at Night

Roadway Segment Type Fatal and Injury p, PDO Dy P

20 0424 0.576 0316
3T 0.429 0.571 0.304
4U 0.517 0483 0.365
4D 0.364 0.636 0410
5T 0432 0.568 0.274

Proportion of Related Crashes

This is the proportion of total crashes constituted by related crashes. It is denoted by pya.

Proportion of Rumble Strips on Inside Shoulders

Length of rumble strips divided by the length of the roadway. Rumble strips are devices designed to give strong

auditory and tactile feedback to errant vehicles leaving the travel way.

Proportion of Rumble Strips on Outside Shoulders

Length of rumble strips divided by the length of the roadway. Rumble strips are devices designed to give strong

auditory and tactile feedback to errant vehicles leaving the travel way.

Protected Left-Turn

This information is needed for each crossroad left-turn movement that exists at the terminal. An affirmative response
is indicated if the left-turn operates as protected only. If it operates as permissive or protected-permissive, then the

response is negative.
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Ramp Length

Length of entrance or exit ramp. Measured from the gore point to the taper point.

Ramp Terminal Type

There are many different configurations of crossroad ramp terminal used at interchanges. The more common
configurations include D3ex, D3en, D4, A4, B4, and B2. They are identified below:

Exit Ramp Entrance Ramp

Freeway

-— '..l I'.
| | i Crossroad A = & |
I I
Type: D3ex ! : Type: D3en
1 |

3. Three-Leg Ramp Terminal with Diagonal Exit or Entrance Ramp (D3ex and D3en)

Exit Ramp | Enirance Ramp
|
I -
I % I
I - .
-1 o | L 1 -
| |
| | 4
| i P Crossroad A _t |
_l_-. i ',. —_—
= = e - -
=, d | 1 R #
\ " ___.a" | ] -"-._ 3 '-I ‘__.«"-
o S I By | | Pl NI
Type: D4 : : Type: D4
| 1
Entrance Ramp Exit Ramp
b. Four-Leg Ramp Terminal with Diagonal Ramps {D4)
Exit Ramp : Entrance Ramp
I
1 &l
= 1 .
Ertrance Ramp : % i Type: A4
1 L 1 - .
| ! /'.- L-.\\
v, ] ] - 8
o A
! | | Crossmoad | |
— f T
_./f | | \ ‘—I r
g | ! : e
= i . R X ; \l -
Type: A4 ! )
P : : Entrance Ramp
Entrance Ramp Exit Ramp

c. Four-Leg Ramp Terminal at Four-Quadrant Partial Cloverleaf A (A4)
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Exit Ramp Entrance Ramp

|
: & !
/Type: B4 : % : Exit Ramp "
J I I f ;
E— ; _~" Crossmad o _t |
. &7 IR RINERD " |"
i i N
Exit Ramp | | Type: B4
| !
Entrance Ramp Exit Ramp

d. Four-Leg Ramp Terminal at Four-Quadrant Partial Cloverleaf B (B4)

Exit Ramp

Entrance Ramp

Type: A2

F reeway

Crossroad

Type: A2

Entrance Ramp -

Exit Ramp

e. Three-Leg Ramp Terminal at Two-Quadrant Partial Cloverleaf A (A2)

Entrance Ramp

Exit R amp"i.

Fraaway

" Crossroad -

—~Exit Ramp

Entrance Ramp

f. Three-Leg Ramp Terminal at Two-Quadrant Partial Cloverleaf B (B2)

Differences among the terminals shown above reflect the number of ramp legs, number of left-turn movements,
and location of crossroad left-turn storage (i.e., inside or outside of the interchange). Although not shown, control
type (i.e., signalized or stop controlled) is also an important factor in characterizing a crossroad ramp terminal).
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Ramp Type

There are two types of ramps: entrance ramp and exit ramp. An entrance ramp is a ramp from a cross road to a
freeway. An exit ramp is a ramp from a freeway to a cross road.

Red Light Cameras
These are cameras installed for enforcement of red signal violations at a signalized intersection.

The base condition for red light cameras is their absence. A study indicates a CMF for red light camera installation
of 0.74 for right-angle conditions and a CMF of 1.18 for rear-end collisions. In other words, red light cameras would
typically be expected to reduce right-angle collisions and increase rear-end collisions. There is no evidence that red
light camera installation affects other collision types.

Right Shoulder Width

For one-way arterials, the right shoulder width is measured at successive points along the roadway. An average
shoulder width is computed for each point and this average is rounded to the nearest 1.0 ft. A new segment is
started if the rounded value for the current point changes from that of the previous point (e.g., from 6 to 7 ft). Right
shoulder width is measured in feet (or meters in metric) and is used in the calculation of the Right Shoulder Width
CMF.

Right-Turn Bypass Lane

A right-turn bypass lane is a lane, typically for right turns but sometimes for through movements at T-intersections,
that is separated from the adjacent entry lane either by a channelized island or pavement markings used to create
physical, horizontal separation between the bypass lane and the adjacent roundabout entry lanes. Right-turn bypass
lanes should not be included in the count of number of entering lanes on a leg.

Right-Turn Channelization

This channelization creates a turning roadway that serves right-turn vehicles. It is separated from the intersection
by a triangular channelizing island (delineated by markings or raised curb). The gore point at the upstream end of
the island must be within 200 ft (or 61.0 meters in metric) of the downstream stop line for the right turn channelization
to be considered "present". If this distance exceeds 200 ft (or 61.0 meters in metric), then the right-turn movement
can be free-flow, stop, or yield controlled.

Right-Turn Lane Present on Crossroad Leg

The lane (or bay) can have one or two lanes. A lane (or bay is considered to be present when it (a) is for the
exclusive use of a turn movement, (b) extends 100 ft (or 30.5 meters in metric) or more back from the stop line, and
(c) satisfies one of the following rules:

e |If the bay or turn lane does not have island channelization at the intersection, then it must end at the
intersection stop line.

o If the bay or turn lane has island channelization at the intersection, then the bay or turn lane must have (a)
stop, yield, or signal control at its downstream end, and (b) an exit gore point that is within 200 ft (or 61.0
meters in metric) of the intersection.

Right-Turn Lanes

The lane (or bay) can have one or two lanes. A lane (or bay is considered to be present when it (a) is for the
exclusive use of a turn movement, (b) extends 100 ft (or 30.5 meters in metric) or more back from the stop line, and
(c) satisfies one of the following rules:
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e |If the bay or turn lane does not have island channelization at the intersection, then it must end at the
intersection stop line.

e |If the bay or turn lane has island channelization at the intersection, then the bay or turn lane must have (a)
stop, yield, or signal control at its downstream end, and (b) an exit gore point that is within 200 ft (or 61.0
meters in metric) of the intersection.

The base condition for intersection right-turn lanes is the absence of right-turn lanes on the intersection approaches.
CMFs apply to installation of right-turn lanes on any approach to a signalized intersection, but only on uncontrolled
major road approaches to stop-controlled intersections. The CMFs for installation of right-turn lanes on multiple
approaches to an intersection are equal to the corresponding CMF for installation of a right-turn lane on one
approach raised to a power equal to the number of approaches with right-turn lanes. There is no indication of any
safety effect for providing a right-turn lane on an approach controlled by a stop sign, so the presence of a right-turn
lane on a stop-controlled approach is not considered in applying the table found below:

Number of Approaches with Right-Turn Lanes®

Intersection Type Intersection Traffic Control One Approach  Two Approaches  Three Approaches  Four Approaches
Three-Leg Intersection Minor road stop control® 0.86 0.74 — —
Minor road stop control® 0.86 0.74 — —

Four-Leg Intersection
Traffic signal 0.96 0.92 0.88 0.85

2 Stop-controlled approaches are not considered in determining the number of approaches with right-turn lanes.
b Stop signs present on minor road approaches only.

The CMFs in the table apply to total intersection crashes. A CMF values of 1.00 is always used when no right-turn
lanes are present. This CMF applies only to right-turn lanes that are identified by marking or signing. The CMF is
not applicable to long tapers, flares, or paved shoulders that may be used informally by right-turn traffic.

Road Type

Road Type refers to the land use. There are two categories of Road Type. These include: Residential/Other and
Commercial or Industrial/Institutional.

Roadside

The area between the outside shoulder edge and the right-of-way limits. The area between roadways of a divided
highway may also be considered roadside.

Roadside geometry refers to the physical layout of the roadside, such as curbs, foreslopes, backslopes, and
transverse slopes.

Designing a roadside environment to be clear of fixed objects with stable flattened slopes is intended to increase
the opportunity for errant vehicles to regain the roadway safely or to come to a stop on the roadside. This type of
roadside environment, called a “forgiving roadside,” is also designed to reduce the chance of serious consequences
if a vehicle leaves the roadway.

Roadside features include signs, signals, luminaire supports, utility poles, trees, driver-aid call boxes, railroad
crossing warning devices, fire hydrants, mailboxes, bus shelters, and other similar roadside features.

Roadside Barrier

A longitudinal device used to shield drivers from natural or man-made objects located along either side of a traveled
way. It may also be used to protect bystanders, pedestrians, and cyclists from vehicular traffic under special
conditions.

Roadside Fixed Objects

These are objects fixed on the side of the roadway.
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The base condition is the absence of roadside fixed objects on a roadway segment.

Roadside Hazard Rating

Considers the clear zone in conjunction with the roadside slope, roadside surface roughness, recoverability of the
roadside, and other elements beyond the clear zone such as barriers or trees. As the RHR increases from 1 to 7,
the crash risk for frequency and/or severity increases.

Roadway

The portion of a highway, including shoulders, for vehicular use.

Roadway Segment

A portion of a road that has a consistent roadway cross-section and is defined by two endpoints.

Rumble Strips
Devices designed to give strong auditory and tactile feedback to errant vehicles leaving the travel way.

Centerline rumble strips are installed on undivided highways along the centerline of the roadway which divides
opposing directions of traffic flow. Centerline rumble strips are incorporated in the roadway surface to alert drivers
who unintentionally cross, or begin to cross, the roadway centerline. The base condition for centerline rumble strips
is the absence of rumble strips.

Rural Areas

Places outside the boundaries of urban growth boundary where the population is less than 5,000 inhabitants.

Safety

The number of crashes, by severity, expected to occur on the entity per unit of time. An entity may be a signalized
intersection, a road segment, a driver, a fleet of trucks, etc.

Safety Performance Function (SPF)

An equation used to estimate or predict the expected average crash frequency per year at a location as a function
of traffic volume and in some cases roadway or intersection characteristics (e.g., number of lanes, traffic control, or
type of median).

Section

The sections of a facility are numbered in a natural order (1, 2, 3, etc.). A drop-down menu is provided to select
which section details to show.

Section Name

This field is provided for each section to identify the section or specify the start point and end point of the section
under analysis.

Section Type

This specifies whether the section being analyzed is a Segment or an Intersection.
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Segment
A portion of a facility on which a crash analysis is performed. A segment is defined by two endpoints.

See also Roadway Segment.

Shoulder

A portion of the roadway contiguous with the traveled way for accommodation of pedestrians, bicycles, stopped
vehicles, emergency use, as well as lateral support of the subbase, base, and surface courses.

Shoulder Type

There exists four shoulder types: paved, gravel, composite, and turf.

Shoulder Width

The width of the shoulder, in feet (or meters in metric).

Sideslope

A sideslope is a roadway cross-section element. It is the slope of the cut or fill expressed as a ratio of vertical
distance to horizontal distance. The CMF for the sideslope for undivided roadway segments of rural multilane
highways is presented in the following table:

1:6 1:7 or Flatter

h

1:2 or Steeper 123 1:4 1:

—
(=
o

1.18 1.15 1.12 1.05 1.00

The base conditions are for a sideslope of 1:7 or flatter.

Site

Project location consisting of, but not limited to, intersections, ramps, interchanges, at-grade rail crossings, roadway
segments, etc.

Site Type

The following table identifies the site types on rural two-lane, two-way roads for which SPFs have been developed
from predicting average crash frequency, severity, and collision type.

Site Type Site Types with SPFs in Chapter 10

Roadway Segments Undivided rural two-lane, two-way roadway segments (2U)

Unsignalized three-leg (stop control on minor-road approaches) (3ST)

Intersections Unsignalized four-leg (stop control on minor-road approaches) (4ST)

Signalized four-leg (4SG)
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These specific site types are defined as follows:

Undivided roadway segment (2U)—a roadway consisting of two lanes with a continuous cross-section
providing two directions of travel in which the lanes are not physically separated by either distance or a
barrier. In addition, the definition includes a section with three lanes where the center lane is a two-way left-
turn lane (TWLTL) or a section with added lanes in one or both directions of travel to provide increased
passing opportunities (e.g., passing lanes, climbing lanes, and short four-lane sections).

Three-leg intersection with stop control (3ST)—an intersection of a rural two-lane, two-way road and a minor
road. A stop sign is provided on the minor road approach to the intersection only.

Four-leg intersection with stop control (4ST)—an intersection of a rural two-lane, two-way road and two
minor roads. A stop sign is provided on both minor road approaches to the intersection.

Four-leg signalized intersection (4SG)—an intersection of a rural two-lane, two-way road and two other rural
two-lane, two-way roads. Signalized control is provided at the intersection by traffic lights.

The following table identifies the site types on rural multilane highways for which predictive models have been
developed for estimating expected average crash frequency, severity, and collision type. The four-leg signalized
intersection models do not have base conditions and, therefore, can be used only for generalized predictions of
crash frequencies.

Site Type Site Types with SPFs in Chapter 11

Roadway Segments Rural four-lane undivided segments (4U)

Rural four-lane divided segments (4D)

Intersections Unsignalized three-leg (Stop control on minor-road approaches) (3ST)

Unsignalized four-leg (Stop control on minor-road approaches) (45T)

Signalized four-leg (45G)*

These specific site types are defined as follows:

Undivided four-lane roadway segment (4U)—a roadway consisting of four lanes with a continuous cross-
section which provides two directions of travel in which the lanes are not physically separated by either
distance or a barrier. When multilane roadways whose opposing lanes are separated by a flush median
(i.e., a painted median) are considered undivided facilities, not divided facilities, the predictive models in
Chapter 11 do not address rural multilane highways with flush separators.

Divided four-lane roadway segment (4D)-Divided highways are non-freeway facilities (i.e., facilities without
full control of access) that have the lanes in the two directions of travel separated by a raised, depressed,
or flush median which is not designed to be traversed by a vehicle; this may include raised or depressed
medians with or without a physical median barrier, or flush medians with physical median barriers.

Three-leg intersection with stop control (3ST)—an intersection of a rural multilane highway (i.e., four lane
divided or undivided roadway) and a minor road. A stop sign is provided on the minor-road approach to the
intersection only.

Four-leg intersection with stop control (4ST)—an intersection of a rural multilane highway (i.e., four lane
divided or undivided roadway) and two minor roads. A stop sign is provided on both minor-road approaches
to the intersection.

Four-leg signalized intersection (4SG)—an intersection of a rural multilane highway (i.e., four lane divided
or undivided roadway) and two other rural roads which may be two lane or four land rural highways.
Signalized control is provided at the intersection by traffic lights.

The following table identifies the specific site types on urban and suburban arterial highways that have predictive
models. Separate SPFs are used for each individual site to predict multiple-vehicle nondriveway collisions, single-
vehicle collisions, driveway-related collisions, vehicle-pedestrian collisions, and vehicle-bicycle collisions for both
roadway segments and intersections. These are combined to predict the total average crash frequency at an
individual site.
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Site Tyvpe Site Types with SPFs in Chapier 12

Roadway Segments Two-lane undivided arterials (2U)

Three-lane arterfals including a center TWLTL (3T)

Four-lane undivided arterials (410

Four-lane divided arierlals (including a ralsed or depressed median) (4D)
Five-lane arterials including a center TWLTL (5T)

Six-lane undivided arterials (61)

Six-lane divided arterials (Including a ralsed or depressed median) (6D)
Seven-lane arterials including a center TWLTL (7T)

Eighi-lane divided arierlals {including a raised or depressed median) (8D)
Two-lane one-way arterials (20J)

Three-lane one-way arterials (30)

Four-lane one-way arerials (40)

Intersectlons Unsignalized three-leg intersectlon (stop control on minor-road approaches) (35T)

Signalized three-leg intersection (35G)
Unsignalized four-leg intersection (stop conirol on minor-road approaches) (45T)
Signalized four-leg intersection (45G)

These specific site types are defined as follows:

Two-lane undivided arterial (2U)—a roadway consisting of two lanes with a continuous cross-section
providing two directions of travel in which the lanes are not physically separated by either distance or barrier.

Three-lane arterials including a center TWLTL (3T)—a roadway consisting of three lanes with a continuous
cross-section providing two directions of travel in which center lane is a two-way left-turn lane (TWLTL).

Four-lane undivided arterials (4U)—a roadway consisting of four lanes with a continuous cross-section
providing two directions of travel in which the lanes are not physically separated by either distance or a
barrier.

Four-lane divided arterials (including a raised or depressed median) (4D)—a roadway consisting of four
lanes with a continuous cross-section providing two directions of travel in which the lanes are physically
separated by either distance or a barrier.

Five-lane arterials including a center TWLTL (5T)—a roadway consisting of five lanes with a continuous
cross-section providing two directions of travel in which the center lane is a two-way left-turn lane (TWLTL).

Six-lane undivided arterial (6U)—a roadway consisting of six lanes with a continuous cross-section
providing two directions of travel in which the lanes are not physically separated by either distance or a
barrier.

Six-lane divided arterials (including a raised or depressed median) (6D)—a roadway consisting of six lanes
with a continuous cross-section providing two directions of travel in which the lanes are physically separated
by either distance or a barrier.

Seven-lane arterials including a center TWLTL (7T)—a roadway consisting of seven lanes with a continuous
cross-section providing two directions of travel in which the center lane is a TWLTL.

Eight-lane divided arterials (including a raised or depressed median) (8D)—a roadway consisting of right
lanes with a continuous cross-section providing two directions of travel in which the lanes are physically
separated by either distance or a barrier.

Two-lane one-way arterial (20)—a roadway consisting of two lanes with a continuous cross-section
providing one direction of travel in which the lanes are not physically separated by either distance or a
barrier.
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e Three-lane one-way arterial (30)—a roadway consisting of three lanes with a continuous cross-section
providing one direction of travel in which the lanes are not physically separated by either distance or a
barrier.

e Four-lane one-way arterial (40)—a roadway consisting of four lanes with a continuous cross-section
providing one direction of travel in which the lanes are not physically separated by either distance or a
barrier.

e Three-leg intersection with stop control (3ST)—an intersection of an urban or suburban arterial and a minor
road. A stop sign is provided on the minor road approach to the intersection only.

e Three-leg signalized intersection (3SG)—an intersection of an urban or suburban arterial and one minor
road. Signalized control is provided at the intersection by traffic signals.

e Four-leg intersection with stop control (4ST)—an intersection of an urban or suburban arterial and two minor
roads. A stop sign is provided on both the minor road approaches to the intersection.

e Four-leg signalized intersection (4SG)—an intersection of an urban or suburban arterial and two minor
roads. Signalized control is provided at the intersection by traffic signals.

Skew Angle, Exit Ramp

Skew angle equals 90 minus the intersection angle, in degrees. The intersection angle is the acute angle between
the crossroad centerline and a line along the center of an imaginary vehicle stopped at the end of the ramp (i.e.,
where it joins the crossroad). The vehicle is centered in the traveled way and behind the stop line. If vehicles can
exit the ramp as left- or right-turn movements, then use a left-turning vehicle as the vehicle of reference. This
information is needed only for terminals with one-way stop control. At a B4 terminal configuration, the skew angle
represents that for the diagonal exit ramp (not the loop exit ramp). The following figure shows the exit ramp skew
angle (one-way stop control):

Skew angle

Intersection

angle Inside approach \ Qutside approach

Crossroad \

- »

1 \
A—- &
Outside approach Inside approach | ! : Intersection
! ! angle
1 \
1 |
If a left-turn movement is not served : :
by the ramp, then reference angles to ' |
a right-turn vehicle at the stop line. Reference angles to a left-turn vehicle at the stop line.

Skew Angle, Intersection

The skew angle for an intersection is defined as the absolute value of the deviation from an intersection angle of 90
degrees. The absolute value is used in the definition of skew angle because positive and negative skew angles are
considered to have similar detrimental effect. The base condition of intersection skew angle is zero degrees of skew
(i.e., an intersection angle of 90 degrees).

If the skew angle differs for the two minor road legs at a four-leg stop-controlled intersection, values of CMFy; is
computed separately for each minor road leg and then averaged.
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Since the traffic signal separates most movements from conflicting approaches, the risk of collisions related to skew
angle between the intersecting approaches is limited at a signalized intersection. Therefore, the CMF for skew angle
at four-leg signalized intersections is 1.00 for all cases.

Speed-Change Lane

When using the predictive method, the freeway within the defined project limits is divided into individual sites. A site
is either a homogenous freeway segment or a speed-change lane. A facility consists of a contiguous set of individual
sites. A roadway network consists of a number of contiguous facilities.

A speed-change land site is defined as the section of the roadway area located (a) between the marked gore and
taper points of a ramp merge or diverge area, and (b) on the same side of the freeway as the merge or diverge
area. The location of the gore and taper points is defined in the figure below.

Entrance Ramp with Parallel Design
| Ramp Entrance Length |

...................................................... SE—
- /7: '\Taper point

Exit Ramp with Taper Design
I Ramp Exit Length |

Taper point / \

* Point where marked gore is 2 ft wide (gore point)
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Two speed-change lanes are shown schematically in the figure below. The speed-change lane associated with an
entrance ramp is labeled SCs, and that associated with an exit ramp is labeled SCex.

PLAN VIEW

Ramp Entrance Ramp Exit Length,

La
_ Length, Lgp | Cross ‘ = .
™ i Ramp -road Ramp
4 SCen FCey
Y — 7|7/ 7 "Freel®y  ~_ ~— — /70 T 7 7
b e B o e o o o ol o GRRE o o o s o e oo o R o
Ly o Lesa o Less
COMPOMENT PARTS
Speed-Change Lane Speed-Change Lane
Type: ramp entrance Type: ramp exit
Seg. length =L, Seg. length =L,
Freeway Segment
Effective segment length, L' = le —Lep/2 — Lgy!2
ERSECR e - o e e S N o - . e R o L - L ot T - - B R 2 1|

Mate: Freeway segment length does nat include the length of speed-change lanes if these lanes are adjacent to the segment

Spiral Transition

A spiral transition provides a gradual transition from moving in a straight line to moving in a curve around a point,
and vice versa. Spiral transitions are considered part of the horizontal curve they adjoin.

When a horizontal curve is present, it is necessary to specify the presence or absence of a spiral transition curve
at the beginning and end of the horizontal curve, even if the beginning and/or end of the horizontal curve are beyond
the limits of the segment being analyzed.

Superelevation

The banking of a roadway in a curve to counteract lateral acceleration.
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Superelevation Variance

This represents the superelevation rate contained in the AASHTO Green Book minus the actual superelevation of
the curve. This is denoted by SV and is measured in ft/ft (or m/m in metric).

Taper Area

An area characterized by a reduction or increase in pavement width, typically located between mainline and ramp
or areas with lane reductions.

Traffic Barrier

A device used to prevent a vehicle from striking a more severe obstacle or feature located on the roadside or in the
median or to prevent crossover median crashes. There are four classes of traffic barriers, namely, roadside barriers,
median barriers, bridge railings, and crash cushions.

Traveled Way

Lanes, excluding the shoulders.

Turn Bay

The lane (or bay) can have one or two lanes. A lane (or bay) is considered to be present when it (a) is for the
exclusive use of a turn movement, (b) extends 100 ft (or 30.5 m in metric) or more back from the stop line, and (c)
ends at the intersection stop line.

Two-Way Left-Turn Lanes

The installation of a center two-way left-turn lane (TWLTL) on a rural two-lane, two-way highway to create a three-
lane cross-section can reduce crashes related to turning maneuvers at driveways. The base condition for two-way
left-turn lanes is the absence of a TWLTL.

The CMF for TWLTL installation is not applied unless the driveway density is greater than or equal to five driveways
per mile. If the driveway density is less than five driveways per mile, the CMF for TWLTL installation is 1.00

Urban Environment

An area typified by high densities of development or concentrations of population, drawing people from several
areas within a region.

Volume

The number of persons or vehicles passing a point on a lane, roadway, or other traffic-way during some time interval,
often one hour, expressed in vehicles, bicycles, or persons per hour.

Weaving Section Length

This is the total length of the Type B weaving section length. This length is measured along the edge of the freeway
traveled way from the gore point of the ramp entrance to the gore point of the next ramp exit, as shown in the figure
below.
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L wey = weaving section length

The gore point is located where the pair of solid white pavement edge markings that separate the ramp from the
freeway main lanes are 2.0 ft (or 0.61 m in metric) apart. If the markings do not extend to a point where they are
2.0 ft (or 0.61 m in metric) apart, then the gore point is found by extrapolating both markings until the extrapolated
portion is 2.0 ft (or 0.61 m in metric) apart. If the measured gore-to-gore distance exceeds 0.85 miles, or 1.368
kilometers in metric (4,500 ft, or 1371.6 m in metric), then a weaving section is not considered to exist. Rather, the
entrance ramp is a “lane add” and the exit ramp is a “lane drop”.

This value is computed separately for the increasing and decreasing milepost directions.
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